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IInnttrroodduuccttiioonn
Thank you for purchasing a copy of the ImageBase 2.0 image database software by DDiiggiittaall IIDD. This user
guide will provide a guide to getting started with the software and provide a handy day-to-day reference
for the user or administrator.

ImageBase is a flexible piece of software which allows the user to create a searchable database that 
contains images as well as the more familiar textual information usually found in standard databases.

Whilst the primary use for ImageBase is intended to be the creation and issue of ID cards for staff or 
visitors within a corporation, it is flexible enough to be used for many other applications involving the
storage of images and information within a database.

TThhiiss MMaannuuaall
Many users of software like to ‘jump in’ to a program before reading it’s associated documentation.
However, because of the size and information covered in this manual it is recommended that you start at
the section entitled “Getting Started” in order to gain a grounding in the set-up and use of ImageBase.
It should not take longer than an hour to do, will introduce some of the main features of the program and
could save more than an hour’s time when using the program later.
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IInnssttaallllaattiioonn
ImageBase is very easy to install. Simply insert the ImageBase CD into the CD-ROM drive on the PC and
follow the on-screen instructions. 

If nothing happens after the CD has been inserted into the drive, this may be because the PC is not c
onfigured to automatically run programs from the CD. If this is the case, the instructions below should be
followed for manual program installation:

First ensure that the ImageBase CD-ROM is correctly inserted into the CDROM drive.
Double-click on the “My Computer” icon from the desktop, then double-click on the icon for the CDROM
drive that contains ImageBase (this is usually drive ‘D:’). If the “My Computer” icon is not available, you
may use the Windows Explorer program to perform this step.
Double-click on the Setup or Setup.exe file icon.

The setup program will now run and begin the installation in exactly the same way as if the automatic
start-up had commenced. 

WWeellccoommee
The Wizard begins by showing the ImageBase welcome screen.  At this stage nothing is required to be
entered so click the next button to progress onto the next step in the installation process.

LLiicceennssee AAggrreeeemmeenntt
The License agreement outlines the terms and conditions for use of the ImageBase software.  To accept
this and move to the next step in the installation, click on the circle next to the I accept the terms in the
license agreement.
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Click the next button to continue.

CCuussttoommeerr IInnffoorrmmaattiioonn
You can now specify some basic program information.  Enter a user name and Organisation that will be
associated to this program.  This information can be anything but typically is just your name and company
name.

Click the next button to continue.

DDeessttiinnaattiioonn FFoollddeerr
The wizard will now present a dialog which allows customisation of the intended location of
ImageBase on the PC.
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It is recommended that the default location for the installation is used, however the option is
provided to select a custom location by clicking on the “Change…” button.  

Click the next button to continue.

RReeaaddyy ttoo IInnssttaallll
The installation is now ready to proceed and install ImageBase 2.0 onto the computer.  To begin the
installation click the Install button.

The install process will now commence.  Please wait until this completes.  When the installation is 
complete the following dialog will appear.
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Click the finish button to close the installation Wizard and start using ImageBase.

In the unlikely event that the installation fails to complete, the  user should make a note of exactly what
happened and of any error codes that were generated by the program if possible. This will allow DDiiggiittaall
IIDD to identify the difficulty more quickly.
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GGeettttiinngg ssttaarrtteedd__RRuunnnniinngg IImmaaggeeBBaassee ffoorr tthhee ffiirrsstt ttiimmee
Once installed, the ImageBase program may be run from the Windows “Start” menu in the “Programs”
section under “ImageBase”.

When first run you will be presented with the ImageBase welcome screen.  This screen provides access to
recently created ImageBase databases as well as giving you the ability to create new or browse for 
existing databases.

You should see the following screen when you first run ImageBase.  For now, click the X button shown in
the top right corner of the image below.

RReeggiisstteerriinngg IImmaaggeeBBaassee
To Register the software for full use click the HHeellpp-->>RReeggiisstteerr…… menu option.  This is shown next to the
WWiinnddooww menu option above.

The RReeggiisstteerr…… dialog will now appear.  You will have been 
provided a ‘Registered Name’ and ‘Authorisation Code’ with
your ImageBase CD package.  Enter these details in the 
associated text boxes as shown opposite.

In this example the details entered were (you will have your own
Registered Name and Code):

Registered Name = AAnnddrree
Authorisation Code = 1111111111111111

If you do not have your required licence information please 
consult your supplier for the necessary details.
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CCrreeaattiinngg aa ddaattaabbaassee ttoo uussee
The first step in configuring ImageBase will be to create a database where your information can be
stored. The types of information to be stored in the database will vary depending on your requirements,
so for now we will concentrate on creating a standard employee database introducing you to the basics of
ImageBase.

There are a number of available information fields that we will not use in the creation on this new 
database.  However descriptions of these and their expected uses are included in the Reference section
of this manual under the heading DDaattaabbaassee FFiieelldd TTyyppeess on page 150.

DDeeffiinniinngg wwhhaatt iinnffoorrmmaattiioonn iiss ttoo bbee ssttoorreedd
The first step in configuring a database is deciding what information you want to keep a record of.  We
do this in ImageBase by using the Database Definition tool available via Menu options.

Select the DDaattaabbaassee DDeeffiinniittiioonn option from the AAddmmiinn menu (or press the F12 key).  This will bring up the
Database Wizard, showing a number of template options.  For the purposes of this example, select the
BBllaannkk DDaattaabbaassee option and click the next button (for more information on using the Database Wizard,
read Database Definition -> Database Wizard on page 145).

You must now determine what kind of database to create.  There are a variety of options, but for now
select the Microsoft Access Database as shown 
opposite and click the Ok button.

A screen will appear asking you where you wish to
save the new database.  We can use this screen to
navigate around and choose a file location to save to.
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TIP: You can ignore the Auxiliary Code. 
Only the Registered Name and Authorisation Code provided with your ImageBase CD is required for successful activation.

To select a Database Type click required option in
the list and click the ok button.  

Dependant on the option selected a dialog will
appear that will prompt you for the required
details in order to create your database. more
information on different Database types can be
found in Appendix B on  page 174.



Navigate to the location where you wish to save the new database.  A good location for now might be
“c:\Temp”.  Type in the name ssaammppllee into the File name field as shown above.  This will be the name of
your database and what will be used to reference when opening it.

SSaavvee LLooccaattiioonnss
ImageBase (Microsoft Access) databases can be stored in any file location that you can navigate to.  This
can be on your local machine or somewhere on your network. It is important to note however that network
speed and connectivity can affect the performance of ImageBase.  If you are unsure where to save the
database consult with your local IT department.

CCrreeaattiinngg yyoouurr ffiieellddss ttoo hhoolldd iinnffoorrmmaattiioonn
Your database will be no good to you until you have created all the fields to contain your employee 
information. A field is a ‘place’ in the database where data can be stored.  Typically, fields hold different
‘types’ of information such as text, numbers or even images.
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To add a new field to the database click on the Add button which is identified by the         icon.  A new field
will appear under the existing ID field with the type defaulted to TTeexxtt and a ssiizzee==8800. You will also notice
the information in the bottom window pane has changed.  Each field has user configurable options and
are explained in DDaattaabbaassee ffiieelldd CCoonnffiigguurraattiioonn ooppttiioonnss on page 150.

Edit the field by typing in ‘Surname’ as shown below.

Once entered click on the ID field.  This will remove focus from your newly created field, locking it into
place.  You can see this by the cursor being removed from the newly created field (note the field is not
saved at this point).

More fields need to be added to our sample database to complete it.  The next step in the creation of our
employee database is to create all of the fields that we will need to record staff details.  In our example
this will include fields such as where in the company they work, whether they have had a card issued yet,
how many cards they have had in total and their image.

Because some fields cannot be changed from one type to another i.e. Image to Date field, particular care
should be taken to enter the correct TTyyppee and associated configurable options.

To add each field, hit the add button and then enter the field name as indicated below.  You will also
need to select the field type by clicking in the next column and selecting a value from the dropdown list.

14

Note: Available options can vary between field types. 
If the option is not available for a particular selected field type, it will not appear in the bottom window pane.

Select the type by clicking on
the type field and selecting a
dropdown item



Enter the following fields:

FFiieelldd TTyyppee SSiizzee//FFoorrmmaatt AAddddiittiioonnaall NNootteess aanndd IInnssttrruuccttiioonnss
Surname Text 80 <- This field should already exist (see previous)
Forename Text 80
Dept Text 80
Title Report Title n/a
Count Card Print Count n/a 
To Print To Print Flag n/a
Card Type Card Designation n/a
Last Modified Last Modified n/a
Image Image Square(1:1)

The DDaattaabbaassee DDeeffiinniittiioonn should now appear as shown below: 

Once all the fields in the above table have been created, a check should be made to see that no errors or
extra fields have been entered by mistake.

The information that was entered for each field can be reviewed by left-clicking with the mouse on the
grey part next to the field name (where the blue arrow covers).  In the image below the current item
selected is Dept.
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Field Configuration options
for an Image

Left click on the grey part
to select a record



If necessary you can modify field details by clicking on the name of the field which should place a 
flashing cursor inside the box (as shown when first creating a field).  For example, above, if you clicked on
the letter ‘p’ in Dept then this field would become editable allow you to change its details. This will also
have the effect of changing the configuration options in the bottom window pane, making them available
for editing.

If there are any fields that do not match those listed in the table above, they should be removed by
left-clicking on the offending field with the mouse to select it, then clicking the DDeelleettee button.

LLiimmiittiinngg ffiieellddss ttoo cceerrttaaiinn ddaattaa
For some types of text field, it is desirable to pre-define a set of entries that are often used within that
field.  For instance, the DDeepptt field of the sample database is likely to have a fixed set of entries that are
used over and over again.  These fields might represent the current list of departments within the 
company.

To define these values in the sample database, select the DDeepptt field in our list.  In the field configuration
options there will be an item called Values.  Click on the [[NNoonnee]] next to this field.  This will display a
button towards the far right of the field.

Clicking the            button loads the Field Values dialog from which you can add entries by clicking on the
add button and then typing in the appropriate value.

For this example enter these 5 values:

Personnel
Sales
Marketing
Corporate Management
Security

When the list of departments is complete, click the OK 
button to return to the DDaattaabbaassee DDeeffiinniittiioonn dialog.

You will notice that the [None] value previously existing in the Values field has now changed.  It should
reflect the number of items in the Field list.  In this case it will be showing as [[55 iinn lliisstt]].
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To have the list of field values sorted
alphabetically select the check box at the
bottom of the dialog.



SSaavviinngg tthhee cchhaannggeess
The database should now be saved again.

Click on the Save changes to Database button which is just under the menus at the top of
the application.

SSeettttiinngg uupp tthhee sseeaarrcchh ffiieellddss
One of the most useful functions of a database is the ability to search through the entire set of records
to find the people or information that is needed.

With this aim in mind, the next step in configuring the sample database is to define which of the fields in
the database are going to be used for such searches.  

To define a field as searchable requires altering the Indexed option located in the fields bottom window
pane.  An example of this is shown in the Image below.

Although most fields have this option available, it is not always practical to assign this feature.  For the
purposes of this sample database, the fields that are most useful in terms of performing searches are
SSuurrnnaammee, FFoorreennaammee and DDeepptt. Ensure the Indexed value for each field is set to yes by changing its value
as shown below.

Once all fields have had their Indexed values changed ensure you save the database once more.

AAddddiinngg ccaarrdd ddeessiiggnnss ttoo tthhee ddaattaabbaassee
Card designs should be added to a database to make it easier to print cards and associate records to
designs.  Although you can easily create your own custom designs, at this stage there are some 
pre-constructed ones that we will use in order to get started.

The  DDaattaabbaassee DDeeffiinniittiioonn should be visible with the nine fields added plus the ID field.  Three of these
fields should have their indexed value set to yes.
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To add card designs or design from scratch now, click on the CCaarrddss tab. 

This will change the Database Definition view to that shown below.  From here you will see three sections.
Before we start adding cards to the database a brief description of the sections should be covered first.

Viewable from the Cards tab should be 3 identifiable sections.

Cards Stored on Disk
Card Designs in database
Cards Available to print

CCaarrddss SSttoorreedd oonn DDiisskk
If you have card designs located on disk, you can use this section to browse for them.  This is done by
clicking on the folder icon located to the right of the textbox.

From there cards can be dragged into the Card Designs view if you wish to store them in the database
permanently or they can be dragged directly into
the Cards Available for print if you wish to leave
their contents on disk. 

In the image to the right, you can see three cards
of type .cdl stored in the c:\Program
Files\ImageBase32\Demonstration Data\ folder.
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The Cards Tab.

Card Designs

Cards stored on disk

Cards Available to Print



CCaarrdd DDeessiiggnnss
If you have card designs already stored in the database, these will appear in this section.  From here you
can choose to Add , Edit or Delete stored designs.  This is done by clicking the buttons located below the
CCaarrdd DDeessiiggnnss heading..

From the example above you will see the database has one card design stored within the database, 
namely Hospital Front.cdl.

CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt
Because printing cards is an important part of ImageBase it is important that the card design used to
print is easily accessible from within the application.   This is made possible by providing the Card
Designs tab where you can select and associate card designs for use within ImageBase. 

If Cards are not attached to the database, then every time a card is to be printed, you would need to
browse for that card design, either on disk, or by selecting from a list in the database.  However, by
attaching these designs, printing cards can become as easy as a one click operation.

In a real database, there may be several different styles of printed ID cards used for visitors, staff, 
security etc.  For the purposes of this sample database we will convert an existing design on disk into one
stored in the database and then reference that file in the CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt section

AAddddiinngg aa ccaarrdd ddeessiiggnn ttoo tthhee ddaattaabbaassee
First we need to browse for the existing card design.  To do this, click on the folder icon located to the
right of the textbox in the CCaarrddss SSttoorreedd oonn DDiisskk section.  

This will display a browse dialog.  Browse to the folder as shown
in the right hand dialog and click the ok button. 

Once you click ok, the Cards Stored on Disk should be populated
with all the .cdl files located in this folder.
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New Card Design 
using Card Designer

Delete an existing
Card Designer

Edit an existing design
using Card Designer

This folder should be located in the installed directory for
Imagebase, typically c:\Program Files\Imagebase\Demonstration
Data.



To convert a card design from being stored on disk to being stored in the database is as simple as 
dragging the design you wish to use to the CCaarrdd DDeessiiggnnss section.

This card design is now stored in two locations.  Within the ImageBase database and also on the File 
system.  It is important to note that changes made to the Card design located in the Demonstration Data
folder will not alter that stored in the database and vice versa.

We now need to add this design to the CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt section to ensure the ImageBase printing
process knows about it.  

Using the same drag and drop method used above, select the Your Company.cdl file from the CCaarrdd
DDeessiiggnnss section and move it to the CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt section.  This will add a new entry into the list,
with the Design Name set to Your Company.cdl.

At this point a ‘Description’ and ‘Field Value’ can be specified for this card design template.

DDeessccrriippttiioonn:: Is used to identify this card design within the ImageBase application.  For ease of use
purposes keep this as short as possible to describe the intended use of the card design.

FFiieelldd VVaalluuee:: Is a four character code which provides a way of referencing this card template in the
database via a field.  Field Values are only used in specialised situations where card types differ between
groups of people within a corporation. We will not set a value for now.

For this example set the Description value as ‘MMyy CCoommppaannyy’ and leave the field value blank.  To change
the description click in the empty square box next to the Design name labelled ‘Your Company.cdl’.
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Select the Your Company.cdl file from the Cards Stored on Disk
section and holding the mouse down move it into the Cards
stored in the database list.

Click Here



FFiinniisshheedd

Click on the button to save the changes made. 

The database is now fully configured.  All that remains is to open it and start adding data.
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EEnntteerriinngg ddaattaa iinnttoo tthhee ddaattaabbaassee__OOppeenniinngg tthhee ddaattaabbaassee
You can now open your database directly from the Database Definition window.  To do this
click on the Open Database icon which will close the database definition and load the Main
View for ImageBase.

The Main Record View of ImageBase should now be visible and ready to use for printing record details as
required.

AA bbrriieeff iinnttrroodduuccttiioonn ttoo tthhee MMaaiinn RReeccoorrdd VViieeww
The Main Record View (MRV) is the heart of the ImageBase program and so it makes sense to introduce
some of its main features at this point.  A more complete reference to the MRV pane can be found in the
PPrrooggrraamm FFeeaattuurreess section on page 32.

The MRV can be split into five main areas of interest

The toolbar
The current record pane
The record list
The image box
The quick search tool

We will look at each of these elements in a little more detail:
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TThhee TToooollbbaarr

This is the control centre for the MRV.  The tools it holds allow the user to create, change and remove
records from the database as well as control common functions such as capturing or scanning images
and printing cards.

TThhee CCuurrrreenntt RReeccoorrdd PPaannee

The current record pane is the main interface through which you enter information into the database.
Each of the fields (Surname, Forename, Dept etc) that were entered during the configuration stages can
be seen in the column on the left hand side of the pane.  Information for each field may be entered in the
blank cells to the right,  with the currently selected field having a coloured highlight to show exactly
where the user’s information is to be entered.

TThhee RReeccoorrdd LLiisstt

The record list will ultimately show a portion of the database as a list of records.  Currently, the list will
appear empty as shown above because no records have been added yet.  However, even with no data, the
field names still appear as column headers.

As records are added to the database each one will appear in the record list with the relevant data for
each record appearing under the appropriate columns.  The widths of these columns may be adjusted by
dragging on the vertical divider lines between them and moving them left or right to suit.
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The record list is primarily used to allow records to be found quickly and to be selected for display
and/or editing in the ccuurrrreenntt rreeccoorrdd ppaannee.

TThhee IImmaaggee BBooxx 
This is the container that will show the image stored in the 
database for the currently selected record.  A pop-up menu to 
help with acquiring images is shown if the user right clicks on 
this box with the mouse.

Further information on the image box menu may be found in the
PPrrooggrraamm FFeeaattuurreess section on page 36

TThhee QQuuiicckk SSeeaarrcchh TTooooll

The quick search tool provides a means by which records can be found quickly without the need for 
navigating the record list line by line.  You can search by any field that has had its indexed field set to
yes in the DDaattaabbaassee DDeeffiinniittiioonn. In our example this would be the FFoorreennaammee, SSuurrnnaammee and DDeepptt fields.

For instance, selecting the Surname field, then typing the surname of a person into the 
QuickSearch box will move the current record pointer down through the list of records to 
the first closest record match.  More information can be found in the PPrrooggrraamm FFeeaattuurreess
section on page 32.

In the previous steps, the different fields within the sample database were defined.  The next step is to
enter some data to produce complete records within the database.

The first thing to do to create a new record within the database is to click on the AAdddd RReeccoorrdd
button on the toolbar of the main record view pane.
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TIP: Not all of the word needs to be entered into the QuickSearch box to perform a search
partial words (such as ‘Smi’ instead of ‘Smith’) can be entered, however the resulting record position may not be as well targeted
as would be the case if the full name was entered.

TIP: Records can be thought of as being similar to the old-fashioned record cards in
a card filing system  Fields are simply the lines of information that are written on to
each card.  In this way, a whole database could be thought of as a very large Rolodex-
style information  system.



When this is done, the top line (not including the ID field so the SSuurrnnaammee field in this case) of the current
record pane will be highlighted in pale yellow and the cursor will be seen flashing within the field waiting
for text to be added.

Enter the surname as SSmmiitthh and press the ‘enter’ key on the keyboard to move down to the next field.

The next field is the FFoorreennaammee field.  Enter the name PPeetteerr and again press the ‘enter’ key to move fields.

When DDeepptt is highlighted, a small drop-down button will be seen on the right of the text entry box.
Clicking on this button allows the user to select one of the pre-defined values for the different company
departments that were set up previously in the database definition stage.  One of those drop-down 
values may be used or, alternatively, a different DDeepptt value may be typed using the same method as that
for the FFoorreennaammee and SSuurrnnaammee fields above.For the purposes of the sample database, select the value
‘Sales’ from the drop-down box as shown above.

The rest of the fields are not directly changeable by the user.  Click on the grey Add button located to the
left of the QQuuiicckkSSeeaarrcchh box to enter the completed record into the database.

Next, we need a few more people added to the database by repeating the steps taken previously.  As a
reminder, the steps to be taken are:

1. Click the AAdddd RReeccoorrdd button (the one with the blank person image and green ‘+’ sign)
2. Enter the Surname, Forename and Dept values into the field edit boxes
3. Click on the grey AAdddd button.

Add the following new records to the database:

SSuurrnnaammee FFoorreennaammee DDeepptt
Davis Sarah Corporate Management
Dowey Mike Marketing
Hussain Abed Security
Johnson David Personal
Jones Robert Marketing
Waters Nikki Sales 
Meads Michael Security
Peters Sue Sales
Stevens Anna Personal
Wilburn Pat Sales
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Once all the records have been added, the ImageBase record list should look something like this (only a
portion of the records are shown here).
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TIP: The currently selected record in the Record List pane has a triangular arrow
shown to the left of it.  In the image above, the record for Peter Smith is the currently
selected one. Because it is selected, the contents of Peter’s record will automatically be
displayed in the Current Record pane.



AAddddiinngg tthhee IImmaaggeess
There are several different ways that an image can be added to record:

Video capture from a camera
Input from a scanner
From an image file on disk
Copied from the windows clipboard

For simplicity and to ensure that this example can be followed by all users regardless of the equipment
connected to their PC, only images supplied by the ImageBase installation will be used.  

During the next section of this example, those users who already have a camera or scanner installed on
their PC will find that they are able to acquire images from that source without too much difficulty (if they
wish to experiment).  You can read more about this in the CCoonnffiigguurriinngg CCaammeerraass aanndd SSccaannnneerrss section on
page 40

Select Sarah Davis’s record from the record list by clicking on her record once.  An image can now be
added to her record.

To do this click with the mouse on the empty image box to the right of the Main Record view.  A pop-up
menu will appear from which we can select options relating to record images.

Select LLooaadd IImmaaggee…… from the menu and a dialog will appear allowing selection of an image file from disk.
Locate the ImageBase installation directory (often c:\Program Files\ImageBase32) and select the 
samplec.bmp image. The selected image should load into the picture frame and will now appear whenever
this record is selected.
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TIP: Users with a camera attached to their PC may at this point alternatively try clicking on Grab Image…
to see if their camera can be used as an image source, whilst users with scanners attached may try Scan Image…

If nothing happens or a warning or error message is displayed it is likely that the camera or scanner needs to be
configured.  Please refer to the Program Reference section under the Configuring Cameras and Scanners
heading and try again.



In the installation directory there is another image called SSaammpplleeFFrreeee..jjppgg. Load this image into Peter
Smith’s record to further practice this process.

SSeeaarrcchhiinngg tthhee DDaattaabbaassee
ImageBase has some very powerful search facilities that allow the user to perform complex searches for
particular records.  Most of the time however, the user will simply wish to find a particular person or
group of people that are associated together.  

For this reason, the Quick Search facility is available to do just that.

The Quick Search tool allows the user to perform
searches on fields that were earlier specified in
the DDaattaabbaassee DDeeffiinniittiioonn.

The tool is fundamentally a box, into which the user types a string of text to be compared to the contents
of one of the database fields.  Once the user presses the enter key, the current record indicator will jump
down through the record list to the first occurrence of the text string.

The search only occurs on the currently selected field.  This is shown by being in brackets after the
“Quick Search” title (for example, the currently selected field in the image above is the IIdd field).

To change the current search field, click on the Quick
Search dropdown button (the small black triangle) and
select the appropriate field name.  Alternatively you
can select the field column header to set the search
field.  

For the purposes of this example, ensure that the SSuurrnnaammee field is the one selected.

Once the Surname field is selected the title will change from QQuuiicckk SSeeaarrcchh ((IIdd)) to QQuuiicckk SSeeaarrcchh ((SSuurrnnaammee)).
The records will now also be ordered in ascending order as determined by your selection.  You can now
search the Surname fields of your record list. 

Type into the Quick Search box the letter ‘j’ and hit the ‘enter’ key on the keyboard.  The current record
indicator (the blue triangle) will move through the list to the JJoohhnnssoonn record.
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You will notice a value in this list called Search For…  This provides the ability to search
multiple fields for a piece of text and is explained below in Searching multiple fields.



Now add the letter ‘o’ to the Quick Search box so that it reads ‘jo’.  Hit the ‘enter’ key again and you will
see that the current record pointer stays on the JJoohhnnssoonn record..

Finally, add a ‘n’ to the ‘jo’ in the Quick Search box so that ‘jon’ is displayed, then press ‘enter’.

The current record indicated will now be pointing to the Jones record as shown above.  Of course, you
could have typed ‘Jones’ into the search box, pressed enter and gone straight to the record.  However,
using this partial approach to finding records can be very handy in the case of misspelled names, or
names where you are unsure of the spelling.

You will also notice that the record for Robert Jones will be displayed in the Current Record pane and any
associated Image shown accordingly.

Another useful search would be to find all of the people within a given department of the company.  To
perform this search, click on the Quick Search drop-down button and select the DDeepptt field as the default
search field.

Now type in the word ‘sales’ into the QuickSearch box and press the ‘enter’ key.  As before, the Quick
Search moves the pointer to a record which has the search text in the appropriate search field.  This time
the pointer will be showing the first found member of the sales department.

SSeeaarrcchhiinngg mmuullttiippllee ffiieellddss
There may be occasions when you wish to search for a record but you are unsure what field to search on.
An example of this might be when you have been given only one name but can’t determine if it relates to
the person’s FFoorreennaammee or SSuurrnnaammee..
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TIP: When selecting a field to search on, the fields are grouped alphabetically allowing for more efficient results.

Searching a record is not case-sensitive so searching for SALES and sales will return the equivalent results.



In this case you can search for the name in two different fields at once.  Click on the black triangle next to
the Quick Search box to display the list of search fields again.

Before we selected SSuurrnnaammee that allowed us to search on only one field i.e. SSuurrnnaammee.  This time however,
select the SSeeaarrcchh FFoorr…… option.

A dialog will appear as shown opposite.  You will
notice all the fields down the left with square
boxes next to them.

To search on more than one field click on a
square box next to the field name.  This will
place a tick inside the box meaning that the
field will be included in the search. 

In this case select the SSuurrnnaammee and FFoorreennaammee
fields.

In the box below the SSeeaarrcchh FFoorr:: text enter in
‘peter’.

To perform a test search click on the grey Test button.  Two records should appear as shown below.  One
of these is Sue Peters and one should be Peter Smith.

Now click on the Search button located at the bottom right.  This will close the dialog and display only the
records shown when the Test button was pressed.
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Grey Test Button

Two records found
when clicking the Test
Button.

TIP: To return the record list to how it was click in the Quick Search box and press the Esc Key.



SSuummmmaarryy
During the GGeettttiinngg SSttaarrtteedd section, many useful operations were covered.  These operations form the
core of any ImageBase database setup and hopefully will have provided the foundation to now move on to
creating a custom database.  The operations and techniques covered were:

Running the program
Familiarity with the main controls
Defining database fields
Setting-up search fields
Adding card templates to the database
Entering data into the database
Adding images to the database
Using the QuickSearch facility

As a next step, it is recommended that you read about how to configure any image capture devices that
may be available on their system.  Full instruction on how to do this can be found at 
PPrrooggrraamm RReeffeerreennccee -->> CCoonnffiigguurriinngg ccaammeerraass aanndd ssccaannnneerrss on page 44.

If image capturing is not required, the section on PPrriinnttiinngg CCaarrddss on page 49 would be a good alternative
starting point.
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PPrrooggrraamm FFeeaattuurreess__MMaaiinn RReeccoorrdd VViieeww PPaannee
When a database is created or opened, the Main Record View (MMRRVV) window is displayed within
the ImageBase program window.

IInnttrroodduuccttiioonn ttoo tthhee MMaaiinn RReeccoorrdd VViieeww
The MRV is the principal user interface for performing data entry and record modification,
image capture and searches. The purpose of this introduction is to familiarise the user with
the names and functionality of the various parts of the MRV.

For the purposes of describing the MRV, it can be considered as being made up from several
distinct functional parts, although the functionality of each element is closely bound to the
others. The distinct parts are:

CCuurrrreenntt RReeccoorrdd PPaannee
RReeccoorrdd LLiisstt PPaannee 
QQuuiicckkSSeeaarrcchh TTooooll
TToooollbbaarr 
IImmaaggee BBooxx

There now follows a description of the function and features of each section of the MRV:

TThhee CCuurrrreenntt RReeccoorrdd PPaannee
When records are being viewed, the
CCuurrrreenntt RReeccoorrdd PPaannee displays the 
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information belonging to the currently selected record in the Record List. The title of each
field in the database is listed down the left-hand side and the contents of those fields for the
current record are displayed to the right of each one in the field data boxes.

Additionally, the Current Record Pane is the section of the MRV that is normally used to enter
data into the database. When a record is being added, all of the editable fields are blank and
the user clicks on each in turn to enter data into it (unless a default entry has been setup in
which case the field will start out with a value). 

Where pre-defined data values have been configured for particular fields, a drop-down box is
accessible via a small button at the right-hand end
of the field data box. 

Empty Date fields have a question mark button at the end of the data
entry box which pops-up a calendar dialog so that the user may select
the date required. 

The month and year may be selected by clicking the buttons at the top
of the dialog with the left and right arrows on them. The day itself is
selected by clicking on the desired day of the month with the mouse.

TThhee RReeccoorrdd LLiisstt PPaannee

The RReeccoorrdd LLiisstt PPaannee lists all of the records in the database in a tabular format. Each record is
listed on a single row of the list with each field of the database having its own column in the
list. The user may scroll up and down through the record list at will and scroll left and right to
view all of the fields (except image fields) in each record.

The Record List Pane can show either the entire database or a subset of the database records
at any one time.  This is determined either by the Record Count setting accessible through the
Database Definition (see page 158), or by any query you may do that returns a subset of data.

The order in which the records are listed is dependant upon which field has been selected as
the Quick Search field. If no Quick Search field has been set, the default listing order is in
ascending numerical order of the ID field which also happens to be the order in which the
records were entered. The example Record List Pane shown above has the Surname field
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selected as the Quick Search field and so the records are listed in ascending alphabetical
order according to the surname in each record.

You order in which the data is listed can be shown by the small grey arrow in the record 
header.  In the Image above, you will notice that the data has been ordered by Surname, so the
small grey arrow has appeared next to the Surname field.                           .  Clicking on the field
again changes the order.

The ccuurrrreennttllyy sseelleecctteedd ffiieelldd is the one that has the triangular pointer activated to the left
of the record. This is the record that is displayed in the Current Record View.

LLoocckk//UUnnlloocckk RReeccoorrdd LLiisstt - The Record List Pane may be used to edit records only if 
this button is set to ‘unlocked’ with the open padlock showing. Clicking on the 
button toggles the setting.

TThhee QQuuiicckk SSeeaarrcchh TTooooll
This tool uses the Searchable Fields which are
created as part of the DDaattaabbaassee DDeeffiinniittiioonn
process (see page 136 for a full description of
setting up Searchable Fields). 

Quick Search uses these searchable fields
to perform simple searches of the database.
The required field can be selected from the
Quick Search tool by clicking on the black
drop-down button and selecting the
required field from the list that appears. 

This currently selected field will now be displayed in the Quick Search Tool’s title and from that
point onwards the record list will be listed in ascending alphabetic or numeric order of the
contents of the field. Also, any values entered into the Quick Search box will be compared to
the data in that field and the currently selected record will point to the first occurrence of that
value.

As an example, if the QuickSearch Default 
Field is set to the Surname field, typing a 
surname into the QuickSearch box will 
instantly cause the record list to move to the
first matching record with that surname.

34

TIP: Not all of the word needs to be entered into the
QuickSearch box to perform a search – partial words (such as
‘Smi’ instead of ‘Smith’) can be entered, however the returned
search results may not be as well targeted as would be the
case if the full name was entered.



TThhee TToooollbbaarr

The toolbar consists of a row of buttons across the top of the Main Record View.

AAdddd RReeccoorrdd
This button clears the contents of the Current Record Pane and the Image Box and waits for
the user to enter data and create a new record. Once the data for the record has been fully
entered, the grey Add button (located to the left of the Quick Search tool and not to be 
confused with the Add Record button) should be clicked to enter the new record into the 
database. 

If the Cancel button is clicked instead, the record is not added to the database and the data
entered is discarded. 

Clicking the black arrow brings up a menu with two options. 

BBllaannkk RReeccoorrdd: Does the same as clicking the Add Record icon,
where a new blank record will be created.
DDuupplliiccaattee RReeccoorrdd: Creates a new record based on the 
information present in the currently selected record.

EEddiitt RReeccoorrdd

The Edit Record button allows the currently selected record to be edited in the Current Record
Pane. All data pertaining to the current record is displayed ready for changes to be made. 

Once the modification has been completed, the user should click the UUppddaattee button (located to
the left of the Quick Search tool) to commit the changes to the database. Again, clicking on 
cancel discards the modifications, this time leaving the original data for that record intact.
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NOTE: It is possible to not find a record if there the records found for the search term are greater than the number of records
shown in the record view.  If this is the case, try doing a search using the Query Builder, or look at increasing your Local Records
Count.

NOTE: It should be noted that images may not be grabbed or scanned while a record is in the process of being entered.



DDeelleettee RReeccoorrdd

Delete Record will completely remove the currently selected record from the database. The
deletion only occurs if the user responds in the affirmative to the prompt that appears asking
if the record should be deleted. AA rreeccoorrdd ccaannnnoott bbee rreettrriieevveedd iiff iitt hhaass bbeeeenn ddeelleetteedd, so care
must be taken when using this function.

GGrraabb IImmaaggee

Provided that a camera-based image capture system
is configured in ImageBase (see CCoonnffiigguurriinngg
CCaammeerraass aanndd SSccaannnneerrss on page 44 for details) the
GGrraabb IImmaaggee button will cause the Image Capture 
dialog to appear showing a ‘live’ view from the 
camera.

On the Grab Image dialog, clicking the GGrraabb button
will capture a still image from the capture source.
The blue lines above and below the video image
show where the image will be cropped to fit the
selected camera aspect ratio which is set via the
OOppttiioonnss button as explained on the following page.

Select Cancel to leave the Image Capture dialog without taking a new picture.

TThhee IImmaaggee CCaappttuurree ‘‘OOppttiioonnss’’ bbuuttttoonn

Clicking the OOppttiioonnss button on the
Image Capture dialog causes an
extra section of the dialog to
appear below the image.

The options allow the user to dic-
tate which device is to be selected
as the video source (assuming that
more than one capture device is present) and the horizontal and vertical dimensions of the
captured video images.

For convenience, the current Video Capture Device selection can be carried out on the OOppttiioonnss
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dialog via a drop-down box.

The Capture Aspect Ratio of the acquired images is set by highlighting the appropriate setting
of SSqquuaarree, PPoorrttrraaiitt or IIrrrreegguullaarr. As each setting is selected, the blue bands above and below
the image show the width of image that will be captured with that aspect ratio setting. SSqquuaarree
sets the width equal to the image height, PPoorrttrraaiitt sets the image height to 1.25 times the width
and IIrrrreegguullaarr captures the image at the current resolution setting.

The three buttons, SSoouurrccee, FFoorrmmaatt and DDiissppllaayy are used to launch features present within the
software for the capture device being used on the user’s PC. Any functions that are not 
supported by that software will not be accessible. It will be noted that the DDiissppllaayy button in the
above dialog is greyed out because the Video Blaster Webcam software being used in this
example does not support the DDiissppllaayy feature.

The SSoouurrccee button causes a dialog to appear. The contents of this dialog will, to a great extent,
depend upon the software supplied by the manufacturer of the video capture hardware being
used on the system. The following dialogs are for the Creative Labs WebCam Plus camera, but
may not be representative of                         other devices:

The dialog has two tabs, both of which are shown above. The first tab allows the user to
change the camera properties such as brightness, contrast and colour settings, whilst the 
second tab allows the video source itself to be selected.  As mentioned before, these dialogs
will vary according to which brand of video capture hardware is being used. Please refer to
your capture system’s documentation for an explanation of the functionality.

The FFoorrmmaatt button  shows the VViiddeeoo FFoorrmmaatt dialog in which the user may select
the image resolution and pixel depth (and hence the overall image file size which
is a multiple of the two settings) from two drop-down boxes.
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The range of resolutions available
will again depend upon the capture
system available. Unless there is a
real need for detailed images, it is
advisable to keep the resolution and
Pixel Depth to low-to-medium 
settings to avoid the database 
becoming very large.
As a reference, the size of the file is
shown for each combination of the
two settings so that the user may
make an informed choice of resolution and pixel depth.

SSccaann IImmaaggee

This toolbar button activates the software interfaces of the default Twain source that is
installed on the PC system and configured within the ImageBase software. Typical devices that
use the TWAIN standard to transfer images are scanners and certain types of cameras. 

The software that runs when the button has been clicked will be specific to the scanner or 
camera that is being used on the PC. This type of software is normally supplied with its own
user manual and this should be referenced if the interface is unfamiliar to the user.

PPrriinntt CCaarrdd

This button will print the default card for the record currently being viewed. If the option to
view a preview of the card being printed was selected in the ImageBase Options section (see
below) then an image of the card as it will be printed will appear before the user decides
whether to print it or cancel the print job. Otherwise, the card will be printed via the default
printer.

The Print Card button has a drop-down arrow next to it which, when clicked, shows a small
menu from which the user may select from card templates that are referred to in the current
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database or browse the PC’s hard disk for alternative Card Layout files.

Holding down the CTRL key whilst initiating a card print will cause a preview to be displayed,
overriding the program options setting.

NNootteess ffoorr DDaattaabbaassee

This button displays a freeform text
entry window which can be used to
keep any kind of textual notes within
the database. A typical use of this
function may be to log when major
changes are made to the content of
the database or to log dates when
batches of cards have been printed. 

MMiisscc OOppttiioonnss

This button provides quick access to a
number of commonly used features within
ImageBase.  To access the options list
click on the Misc Options icon.  A menu list
will appear much like that below 
indicating the various options available.

Using the mouse, highlight an option to
select it and then click the left mouse 
button to initiate the action.

LLooaadd IImmaaggee: Opens up the load Image dialog for the particular selected record.  No action
is taken if no record is selected.

SSaavvee IImmaaggee: Opens up the Save Image dialog so that you can save the selected records
image to file.  No action is taken if no record is selected.

QQuueerryy BBuuiillddeerr:  Allows you to create queries on the database, providing enhanced 
searching capabilities.  For further information consult the section RReeppoorrtt -->> QQuueerryy BBuuiillddeerr on
page 114.
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AAdddd CCuurrrreenntt RReeccoorrdd ttoo PPeeooppllee PPiicckkeerr FF22:  Adds the currently selected record to the
People Picker control.  For further information consult the section VViieeww -->> PPeeooppllee PPiicckkeerr on
page 125

AAdddd RReeccoorrddss ttoo PPeeooppllee PPiicckkeerr……: This option allows you to select a range of records
that would be added to the People Picker list.  Selecting this option brings up the screen below
from where you can determine what records you wish to add to the people picker.

AAdddd FFrroomm::
Determines where the first record to be added starts.
TToopp ooff LLiisstt: Means the first record is at the top of the record list.
CCuurrrreenntt RReeccoorrdd: Adds records from the currently selected record.

HHooww MMaannyy::
Determines how many records to add.  The start of the records to add is determined by the
Add From option described above.

1100: Adds ten records
2200:: Adds twenty records
TToo EEnndd:: Adds to the end of the record list
NNuummbbeerr:: You can specify any number of records the box below Number.

AAdddd AAllll RReeccoorrddss ttoo PPeeooppllee PPiicckkeerr:: This option adds all the records from the current view

to the people picker list.

DDeelleettee RReeccoorrddss ffrroomm DDaattaabbaassee:: This option deletes all the records in the current view from
the database.
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NOTE: You cannot delete all records from the Main record view.  If you wish to delete all database records from your database,
you will need to run a query first that retrieves all database records, and then delete from that view.



AArrcchhiivvee CCuurrrreenntt RReeccoorrdd:: Selecting this option archives the currently selected record in the
MRV.

RReeffrreesshh RReeccoorrdd LLiisstt

Occasionally when adding or deleting records, the contents of the Record List Pane may need
to be refreshed to re-sort and display the records in the correct order. This button performs
that function when clicked.

AAdddd ttoo PPeeooppllee PPiicckkeerr

When this button is clicked, the currently selected record is added to the People Picker. If the
record is already stored in the People Picker, a message is displayed informing the user that
the record was not added because it is already in it.

SShhooww PPeeooppllee PPiicckkeerr

This button causes the People Picker window to be displayed within the ImageBase program
window.  Full details of the operation of the People Picker can be found on page 125 of this
manual.

TThhee IImmaaggee BBooxx
This is a container in which database images are displayed. If an
image is being displayed, it is that of the ‘currently displayed record’. 

A pop-up menu to help with a
cquiring images is shown if the user
clicks on this box with the mouse. 

If more than one image field is speci-
fied in a database, all of the images
will be available from the Image Box
with each image field having its own
tab beneath the box. In the 
example on the right, the tab has Image written in it which is
the name given to the image field in the sample database.
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The GGrraabb IImmaaggee…… and SSccaann IImmaaggee…… options perform the same functions as the Main Record
View toolbar buttons of the same name (see previous pages for details). 

SSaavvee IImmaaggee…… allows the user to save a copy of the file to disk.

LLooaadd IImmaaggee…… allows the user to load an image from a file on the users computer into the 
current record in the database.

CCooppyy ttoo CClliippbbooaarrdd allows the user to place a copy of the image into the Windows clipboard. The
image may then be ‘pasted’ into another Windows application.

PPaassttee ffrroomm CClliippbbooaarrdd enables the user to paste an image into the current record from the
Windows clipboard.

BBllaannkk IImmaaggee removes all image data from the current record and the Image Box becomes
empty.

CCaappttuurree PPrrooppeerrttiieess opens a dialog which is for selecting the video source and the capture
aspect ratio. The facility has been provided here so that it is not necessary to perform an
image ‘grab’ before setting the video source. This dialog is detailed in CCoonnffiigguurriinngg CCaammeerraass
aanndd SSccaannnneerrss on page 44.

EEnnhhaannccee IImmaaggee…… is a very useful tool. It provides a way for the user to alter the lighting and
colour of an image and to crop the image to 
eliminate any unwanted features from it. 

At any time before the AAppppllyy button is clicked to make
the changes, the DDeeffaauullttss button may be used to
revert the picture back to its original state.

The Mono tab

This slider controls the bbrriigghhttnneessss of the
image.

This slider controls the ccoonnttrraasstt of the
image.

This slider controls the amount of 
GGaammmmaa CCoorrrreeccttiioonn applied to the image. 
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The RGB tab

Here the user can change the colour balance of the image.
This is particularly useful for correcting colour tints in images
that have been supplied.

This slider changes the tint from CCyyaann
through to RReedd.

This slider changes the tint from
MMaaggeennttaa4through to GGrreeeenn.

This slider changes the tint from YYeellllooww
through to BBlluuee.

The Extras tab

The Extras tab holds sliders that allow the image to be
sharpened or blurred and cropped.

This slider makes the image sharper or more
blurred as the setting is changed.

This slider sets the size of a dotted rectangle on the
image (see image to right). The rectangle is always
in the selected aspect ratio of the image and is 

positioned on the image by means of clicking the mouse at
the position of the top left corner of the rectangle. When
the Apply button is selected, the image will be cropped to the area of the rectangle. Please
note that the rectangle will not be visible until the size has been set to smaller than the 
current image.

The MMiirrrroorr checkbox provides a left-to-right mirror image of the picture when it is checked.
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NOTE: Gamma Correction controls the overall brightness of an image. Images which are not properly corrected can look either
bleached out, or too dark. Trying to reproduce colours accurately also requires some use of gamma. Varying the amount of
gamma correction changes not only the brightness, but also the ratios of red to green to blue.



CCoonnffiigguurriinngg ccaammeerraass aanndd ssccaannnneerrss
ImageBase has the ability to grab images from a variety of sources including most scanners,
video capture boards and webcams. From a technical viewpoint, ImageBase can capture from
any camera or device that supports the standard capture driver model and any scanner/
camera with a TWAIN interface

WWhhaatt hhaarrddwwaarree iiss aavvaaiillaabbllee??
There are two distinct types of imaging hardware that need to be set up if they are present in 
the PC that is running ImageBase. 

TTWWAAIINN SSoouurrcceess 
This group of devices covers items of hardware such as scanners and certain cameras. The
TWAIN sources are set up via the  File > Select TWAIN Source…  menu entry.

‘TWAIN’ is a standard for reading image data from scanning or image capture equipment. If
the PC which ImageBase is installed on has a scanner or image capture device that is TWAIN
compatible, it can be set as the default TWAIN source allowing ImageBase to capture images
directly from it.

Selecting this function results in the following dialog. Note that the dialog contents will likely
vary depending upon what items of equipment are available on the ImageBase PC:

In the above instance, a standard Epson scanner is installed and two different TWAIN 
interfaces are available for using it. To select a specific source, simply click on the desired one
and click on the SSeelleecctt button.

If no suitable TWAIN sources are available on the ImageBase PC, the SSoouurrcceess list-box will be
empty. Only one TWAIN source may be selected at any one time. 
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NOTE: To configure camera devices, you must have at least one field of type Image defined in your database.



NNoonn--TTWWAAIINN ssoouurrcceess
This group of devices covers items of 
hardware such as webcams and video 
capture boards with cameras attached.

These devices can only be set up only when
after a database has been opened. 

To set up a non-TWAIN source, click on the
Image Box in the Main Record View and
select CCaappttuurree PPrrooppeerrttiieess… from the pop-up
menu. 

The dialog shown to the right will appear, though the list of devices will vary from PC to PC. If
any non-TWAIN devices are present and correctly installed on the PC, they will be listed in the
Device box. The user should select the device that is to be used for image acquisition. 

The user should also select a Capture Aspect Ratio that suits the style of ID cards that are
eventually to be printed. 

CCaannoonn CCaammeerraass
ImageBase works with a number of
Canon cameras that provide an 
programmable interface to a standard
Windows your PC (To see if your Canon
camera is compatible contact Digital ID
support at support@digitalid.co.uk.

Click AAddmmiinn-->>OOppttiioonnss and select the
CCaappttuurree pprrooppeerrttiieess tab, or alternatively
click in the Image box in the Main
Record View and select CCaappttuurree
PPrrooppeerrttiieess ……

The dialog opposite shows the Capture
properties when accessed via the AAddmmiinn-->>OOppttiioonnss menu.

You will notice the Image fields box with the text IImmaaggee in it.

Because you can configure different camera devices for different image fields, this field 
identifies what image field the settings relate to.
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In this case there is only one image field in the database called Image.

To select the Canon camera as the image device, click on the circle located next to the text Use
Canon Camera.

DDoo IImmmmeeddiiaattee GGrraabb: Selecting this option means that any image captured using a Canon 
camera is done so immediately upon selecting the records Grab Image option. *  If you wish to
preview the image first and ensure it is in the correct place ensure there is no tick inside this
square box.

* Selecting this option will still give you the chance to re-take the picture manually once the 
initial image is captured.

CCaannoonn DDeevviiccee SSeettttiinnggss
To access and change the device settings when taking
a photo you must first access the Image Capture
screen.  This can be done from the Capture properties
dialog shown above opposite by clicking on the Test…
button.

If the Camera is installed, turned on, and in play
mode, a dialog like the one below should appear (your
camera view will be different dependant on what your
camera is pointing at).

There are a number of
tabs shown that allows you to adjust settings relating
to the functioning of the Canon camera.  These tabs
are indicated at the bottom of the Image Capture
screen by:

Grab Area
Device

Canon Camera controls (May be specific to your Canon Camera model)
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Cameraview

Canon Device Settings

TIP: Because battery life is limited, it is recommended that all Canon Cameras are connected to a power adapter rather
than running on battery life.



GGrraabb AArreeaa
Provides the ability to configure the cropping area size that is used when selecting the portion of the
Image to save to record.
These settings can only be adjusted once the Freeze button has been pressed and the Image is captured
is returned.  You will know this by the Freeze button changing to show Live.The freeze button changes to
Live to reflect this.

CCaalliibbrraattee MMooddee: By selecting this option after
taking a photo, you can adjust the size of the Image
to save to disk by moving the Capture Size scroll bar
left and right.  When doing this you will notice the
transparent part of the screen growing/shrinking in
size.

Remember to uncheck this option after calibration is
complete.

FFiixxeedd AArreeaa: Indicates that the capture area is
fixed and you cannot dynamically select a region to
crop..

DDeevviiccee
Shows what camera is currently selected for taking photos.

CCaannoonn CCaammeerraa ccoonnttrroollss
Depending on your camera model, the text entered for this control may vary.  For example if
you had the A60 Canon camera, the text might say Canon A60 Camera Controls.

ZZoooomm: To zoom the camera in and out, click on the zoom button and move it left and right.
Depending on the camera version, different zoom capabilities will be available.

EExxppoossuurree: You can change the exposure of the camera by clicking the down arrow and
selecting a new value.
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DDeevviiccee: Click the device button brings up the following dialog.

FFllaasshh SSeettttiinnggss: Determines whether the camera will use
the flash when taking the picture or not.

UUssee RReedd EEyyee RReedduuccttiioonn: Specific camera specific 
functionality that reduces the amount of red eye when
taking a picture.

PPoowweerrssaavvee: This determines when the camera goes into
sleep mode.
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TIP: If you are not taking a lot of pictures at once, or if the camera is 
running on batteries then it is suggested that you set this to Immediate.



PPrriinnttiinngg CCaarrddss
Printing cards using ImageBase is simple and pain free as long as you have a design and record 
information available.  If you do not have these details set-up, it would be a good idea to read through
the GGeettttiinngg SSttaarrtteedd section on page 11 prior to attempting any card printing.

PPrriinnttiinngg aa ssiinnggllee ccaarrdd
First, select the record you wish to print by clicking selecting it in the Main Record View list.  Once 
selected the details for that record will appear in the Main Record View pane showing in the top half of
the screen.

SSeelleeccttiinngg tthhee pprriinntteerr
To print a card you must ensure the Card printer is 
selected as the print output. This is easily done by 
selecting the printer via menu options FFiillee -->> SSeelleecctt
PPrriinntteerr. Alternatively you can click the printer name shown
on the main screen status bar.

There may be more than one printer shown in the list box,
however you just need to select the card printer installed
with your system.

In the case shown opposite, the card printer selected is the
SmartDriver SP55.

PPrriinnttiinngg tthhee ccaarrdd
To print the card design you need to select the design from the Card design dropdown.

Select the card design you wish to print.  If you have the Produce Card previews option available the 
preview window will be displayed.  If so you can preview what the card will look like before initiating the
print process.   Once happy with the result click the PPrriinntt button to send the design to the printer.
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TIP: Ensure the appropriate Ribbons and cards are loaded into the printer before attempting to print and that the printer is
turned on.

This will help to avoid reprints.



The card should now be printed and appear in the output hopper of the card printer.

PPrriinnttiinngg ccaarrddss ffoorr mmuullttiippllee rreeccoorrddss
You can print cards for multiple records by using the People Picker list to queue up the records, and
then selecting the Print button..  For more information read the VViieeww -->> PPeeooppllee PPiicckkeerr section on page
125.

SSeelleeccttiinngg tthhee rreeccoorrddss ttoo pprriinntt
First, you must determine what records you wish to add to the people picker.  Records can be added in a
number of ways.

Producing a query to determine the record list and then adding all the queried records.  Consult the
QQuueerryy bbuuiillddeerr section on page 133
Using the Misc Options to select a portion of the record list.  Consult the MMiisscc OOppttiioonnss section on page 39
Importing the data from a file which can automatically place the records into the people picker. Consult
FFiillee -->> IImmppoorrtt DDaattaa section on page 113

SSeelleeccttiinngg tthhee ccaarrdd ddeessiiggnn
Once records have been added to the people picker, you must select the card design you wish to print.
This is done by selecting the design via the drop down box towards the bottom left of the screen.

In the case below, the Your Company.cdl design has been selected to print.

PPrriinnttiinngg tthhee ccaarrddss
Once a card design is selected, press the Print Cards button.  This will spool the designs to the card
printer, freeing you up to use other parts of the software as required.

PPrriinnttiinngg mmuullttiippllee ssttaattiicc ddeessiiggnnss
Multiple cards can be printed via Card Designer if there is no information on the card that requires
record information.  This process is typically used to print the backs reverse of cards.
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Workflow
ImageBase has a set of features that allow you to work with records as a batch. These features are:

PPeeooppllee PPiicckkeerr
A window that allows ad-hoc records to be chosen and built into a list.  From here operations such as
printing cards or image enhancement can be applied to the records.

SSccaann aanndd SSlliiccee
A window that can take a People Picker list and a large scanned image containing many images. This
allows you to place a number of photographs on the bed of a scanner; make one scan and then chop up
the resulting image.

BBaattcchh IImmaaggee EEnnhhaannccee
Once sliced with the Scan and Slice tool, the images can be adjusted for brightness and contrast with the
Batch Image Enhancer.

PPrriinntt SSttaattiioonn
After the images have been made ready for printing the print station can manage the printing of cards.

The four parts of the workflow are all performed in individual windows all of which can be accessed via
the ‘View’ menu. If you have enough licensed copies of ImageBase you could have a PC for each part of
the workflow, allowing the process to be scaled effectively.

UUssiinngg SSccaann aanndd SSlliiccee

Scanning individual images is a time consuming and awkward process. The concept behind Scan and Slice
is that you scan a large image, possibly generally a sheet of A4 with multiple photographs placed on 
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it attached. Once scanned you then slice it up using a movable ‘slice’. Each image that gets sliced is 
automatically passed to the Batch Image Enhancer so that you can adjust each image’s brightness or
colour.

The basic process for performing scan and slice is:

1.Produce a list of the records into which you are going to put the images 
you have to scan and load them into the People Picker

2.In the People Picker press ‘Scan and Slice’
3.Scan the A4 sheet containing the images
4.Slice up the sheet into images using the movable slice.

CChhoooossiinngg tthhee rreeccoorrddss
You should use the People Picker to select the records for which you have photographs. It is probably a
good idea to select them in the order they appear on the scanned page because the Scan and Slice tool
automatically moves to the next record after each a slice. Once the scan is loaded into the People Picker,
press the ‘Scan and Slice’ button. The Scan and Slice window will show the records in the top right. The
list is automatically saved and you can re-load a set by pressing the ‘Read…’ button. You can delete old
sets by pressing the ‘Manage…’ button.

LLooaaddiinngg tthhee AA44 IImmaaggee
There are two ways to load the A4 scanned image into the Scan and Slice tool:

SSccaannnneerr:: Pressing the ‘Scanner’ button will allow you to directly scan in the A4 page

OOppeenn EExxiissttiinngg SSccaann:: Pressing the ‘Open’ button allows you to read a pre-existing scan 
image file. This is useful if you do not normally scan images using ImageBase.

Whether you scan the image or load from disk you should ensure the image has enough resolution to
produce a good scan. Scanning at near 300DPI is probably a good resolution to start experimenting
at.for printing quality images.

SSlliicciinngg
Slicing involves pointing at the image and clicking the mouse button. You will see on the scanned image a

purple outline. This is the slice tool and is automatically shaped to
the image field in your database. 

To change the purple slice selection area, move the mouse by 
holding hold down the <Shift> key. The purple slice will follow the
mouse cursor, making it easy to position over a photograph on the
scan. You can change the size of the slice area by pressing the ‘+’
and ‘-‘ keys. Once you have adjusted the size of the slice to one
image it will probably be good for most of them.

Purple outline defines the slice area to be captured



As you move the purple slice across the image you will see a magnified version of the area shown next to
the record’s details in the bottom right. As you move this image is shown as deliberately pixelated low 
quality (for speed). If you pause for a few seconds
the enlarged image will sharpen. When you have the
image as required click the mouse in the slice area
and the image will be stored in the database. The
record will have a tick mark placed against it and
the record marker will automatically move to the
next record. This allows the process to be: ‘move’,
‘click’, ‘move’, ‘click’... Using this process, whole
sheets of images can be scanned very quickly. If you
miss-scan slice an image (i.e. click at the wrong
time), just click the record again in the list and 
continue the process.

Each image that you slice and store in the database will automatically be placed in the batch image
enhance queue.

BBaattcchh IImmaaggee EEnnhhaannccee

The Batch Image Enhance tool allows you to quickly adjust a series of images and send them for printing.
The current queue of images that require enhancing is shown in the ‘Queue’ list with the next image to be
processed highlighted and shown in the middle of the window.
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QQuueeuuee
There are two ways for an image to get into the Batch Image Enhance queue:

By using the ‘Scan and Slice’ tool
By loading the records into the People Picker and choosing ‘Extra Utilities’ – 
‘Add List to Batch Enhance Queue’.

MMaakkiinngg AAddjjuussttmmeennttss ttoo IImmaaggeess
To make adjustments to the current image you should press the action buttons to the right. These make
small adjustments to the image. As you press a button a list of the actions you perform is shown in the
action list in the top right. If you perform an adjustment that you do not want you can either press
‘<Backspace>’ or click the Undo button above the list of actions. Once the image is shown
adjusted/processed as required, press ‘Save’. The next record will then be loaded. If the image does not
require any adjustment then press the ‘Save’ button without pressing any adjustment buttons.

PPrriinnttiinngg IImmaaggeess
You can queue cards to be printed by checking the card designs listed in the bottom left. One card will be
printed per record for every design checked. These prints will be queued in the print station.

MMaaccrrooss
The buttons in the Actions section can be configured to do any sequence of adjustments required. As you
press buttons, a list of the actions is built -up in the action list. You may find that on average each image
requires the same set of button presses. If you hold down the <Shift> key and then press ‘Quick Keep’,
the button will be assigned that set of adjustments. Pressing the button (without <Shift>) will replay the
adjustments. 

The ‘Quick Keep’ button acts as
a quick way of storing the most
used set of button presses. You
can reassign any of the adjust-
ment buttons by pressing
<Shift> followed by the button
itself. More control is available
by using the ‘Button Editor’. If
you press the black right trian-
gle next to the action list there
is an additional list of com-
mands that can be issued. At
the top of the menu is ‘Button
Editor’ where you can refine
the effects performed.
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From here you can refine the macro that is performed when the button is pressed. When closed the
macros are saved to the database. The ‘Use Current’ button copies the current action list into the ‘Macro:’
edit area.

The macros themselves are stored as a sequence of text commands and you can issue them yourself by
typing+ing into the Director Command text box just below the action list in the Batch Enhance Window.

The following is a list of the valid macro commands:

BBrriigghhttnneessss ppcctt
Changes the brightness by pct percent.
Example: Brightness -10

CCoonnttrraasstt ppcctt
Changes the contrast by pct percent.
Example: Contrast 5

GGaammmmaa gg
Changes the image gamma to be g.
Example: Gamma 0.9

RReedd ppcctt
Changes the amount of red in the image by pct percent. Reducing the red is the same an increasing the
cyan.
Example: Red 7

GGrreeeenn ppcctt
Changes the amount of green in the image by pct percent. Reducing the green is the same an increasing
the magenta.
Example: Green 15

BBlluuee ppcctt
Changes the amount of blue in the image by pct percent. Reducing the blue is the same an increasing the
yellow.
Example: Blue -15

RRGGBB rrppcctt ggppcctt bbppcctt
Changes the red, green and blue components of the image at the same time. Has the same effect as 
typing individual Red, Green and Blue commands.
Example: RGB 10 10 5

HHuuee ppcctt
Changes the hue of an image by pct percent. Hue is a measure of the actual colour, so changing the hue
will change the colour of the image but not the brightness or the amount of colour.
Example: Hue 5

SSaattuurraattiioonn ppcctt
Changes the saturation of an image by pct percent. Saturation is the amount of colour in an image and
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behaves in a similar way to the ‘Colour’ control on a television.
Example (convert to black and white): Saturation -100 

LLuummiinnaannccee ppcctt
Changes the luminance of an image by pct percent. Luminance is the amount of light in an image and is
similar to brightness.
Example: Luminance -20

BBlluurr
Blurs the image

SShhaarrppeenn
Sharpens the image

MMiirrrroorr
Makes the image into its mirror image

FFlliipp
Turns the image upside down

RRoottaattee ddeegg
Rotates an image through deg degrees anti-clockwise.
Example: Rotate 90

AAuuttooccoonnttrraasstt
Applies autocontrast to the image

EEqquuaalliissee
Applies equalise to the image.

PPrriinntt SSttaattiioonn

The Print Station is a mechanism for reducing the amount of time it takes to print a card. Normally when
you print a card, a lot of work is done to create the print job. This can be mitigated by using a printer on a
network. The Print Station is part of the workflow process that starts at Scan and Slice and moves to
Batch Image Enhance. When Batch Image Enhance is used you can send jobs to the Print Station by
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pressing Save with card designs checked in the bottom left corner.

You can see the current print queue in this window. It can be refreshed by pressing the refresh button –
although it will automatically refresh. Pressing ‘Process Next’ will cause the next job in the list to be
processed. If you check the ‘Process’ checkbox then print jobs will be run automatically (i.e. you do not
have to press ‘Process Next’ every time). 

As jobs print, some may not succeed.  For example the  The printer foil may run out for example. These
jobs have failed and will be marked as such. The ‘Recover Failed Jobs’ will set each failed job to a state
where they can be reprinted. You can remove completed jobs from the queue by pressing ‘Delete
Completed’.

If you select print jobs and press the right mouse button then you will have the following options:

RReesseett JJoobbss ssoo tthheeyy wwiillll PPrriinntt
This set the jobs ready to print. A paused job will be un-paused, a failed job will move to ‘ready’. 
If a job requires a reprint you can use this menu item.

PPaauussee PPrriinnttiinngg oonn tthheessee JJoobbss
Any jobs selected will move to ‘Paused’ and will not print.

DDeelleettee JJoobbss
The selected jobs will be deleted from the queue.
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–– DDeessiiggnniinngg CCaarrdd LLaayyoouuttss

TThhee CCaarrdd DDeessiiggnneerr PPrrooggrraamm WWiinnddooww
To start editing card designs, select it from the VViieeww-->>CCaarrdd DDeessiiggnneerr menu option.  A new tab
will appear with the screen below shown. 

The window comprises of a number of different elements:-

MMeennuu BBaarr This list of functions is shown at the top of the screen. Clicking
on the words FFiillee, EEddiitt, VViieeww, TToooollss or HHeellpp causes the appropri-
ate menu of commands to drop down below the menu bar.

MMaaiinn TToooollbbaarr This horizontal row of buttons, located just below the menu bar,
has pictures representing many of the file and editing functions
that the user may select. Any functions that are not currently
available will be ‘greyed out’ to stop them being selected. 

DDeessiiggnn TToooollbbaarr This vertical row of buttons has pictures representing all of the
types of graphical objects that may be added to a card design.
These objects are things like barcodes, pictures or text. It is
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located down the left hand side of the program window.

RRuulleerrss There are two rulers, one horizontal just under the Main Toolbar
and one vertical, just to the right of the Design Toolbar. These
rulers are provided to allow exact placement of objects onto the
card design.

CCaarrdd DDeessiiggnn The main bulk of the CardDesigner program window is taken up
with the ‘blank sheet’ of card onto which the user’s design is
placed. This is the white area seen in the centre of the program
window. All text, images and other design objects are placed in
position on this card until the design is complete.

SSttaattuuss BBaarr At the very bottom of the CardDesigner program window, there is
a bar that is used to display useful information to the user. On
the image above, the status bar is blank as the program has just
been started.

TThhee MMaaiinn TToooollbbaarr

The toolbar consists of a row of buttons across the top of the tab window. These buttons pro-
vide quick and easy access to the most commonly used functions in the program. To select a
particular function, the user should simply move the cursor over the appropriate button and
click the left hand mouse button once. 

Each button has two states – active and inactive. Any inactive buttons may be identified by
their being ‘greyed-out’. In the toolbar above, there are two buttons that are greyed-out in this
way (the PPaassttee tool and the RReeddoo tool, seventh and tenth buttons from the left). All the other
buttons are fully coloured and therefore available to be selected.

NNeeww DDeessiiggnn

This button initiates a new card design.
If an unsaved card design is already in
progress, the user is offered the possi-
bility of saving the ongoing work. This
button causes the New Card Design dia-
log to appear as shown below:
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This dialog allows the user to select from pre-defined card templates that take into account
the style of card to be printed on.

Choices shown in the dialog on the right include a single-sided plain plastic card, a two-sided
design on a card with a magnetic stripe, a two-sided design with a smart-card chip on and a
combined magnetic stripe and smart card design. 

To aid in selection of the correct card template, the dialog shows the dimensions, the 
orientation of the card and whether it is double-sided or not. Any additional notes that were
added when the template was created are also displayed. 

When the desired template has been highlighted in the left-hand list box, the user should 
simply click on the OOKK button.

It is important that the user should select the correct card type that matches the one to be
printed on. This is because all magnetic stripes or smart card chips present in the template will

be shown on the card design in the correct positions allowing the user to avoid positioning
printable items over these sensitive areas. 

CCrreeaattiinngg aa nneeww TTeemmppllaattee
Creating a new template is easy – all that needs to be done is to create a card design file as
normal, then save it into the template directory. Setting the location of the template directory
is performed by using the Tools > Options menu and is described in detail on page 61.

OOppeenn DDeessiiggnn FFiillee

When this button is clicked, the file 
selection dialog opens to allow the user to
select the card design file that they wish to
load into CardDesigner.
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NOTE: The smart-card chip:  This small patch of metal pads hides a miniature computer which stores
important information about the owner of the card securely. It is essential that the metal pads are not
printed upon as the smart chip may not function if this happens.
To help the user to avoid printing on this sensitive area, CardDesigner has templates which show exactly
where the smart-chip is located for the ISO-7816 standard card format.  Similar positioning markers are
also supplied for cardswith magnetic stripes as well as combinations of the two technologies.

If the option to save designs to the database is 
selected, a different dialog will appear from where
you can select the design to open.



The exact appearance of the Open dialog will to some extent depend upon the 
version of Windows that is running on the PC. The basic elements of the dialog will be available
however.

To locate a previously-saved card design, the user should use the drop-down box at the top of
the dialog to select the correct location in which the file was saved. In the image on the right,
this drop-down box contains a small yellow folder icon and the text “CardDesigner Files”.

Once the correct directory has been located, a list of ImageBase compatible card design files
will be shown in the main list box on the dialog. To load a particular file, the user should select
it by clicking on it once in the main list box, then click on the OOppeenn button.

Note that only the newer version card
design files (with names ending in .cdl or
.cdt) are shown by default. To display any
older card design files from earlier versions of Card Designer, the user should click on the
”Files of Type” drop-down box at the bottom of the dialog and select the option “Old Style Card
Designer Files (*.ccl)”. These older files will then be visible in the main list box.

SSaavvee DDeessiiggnn FFiillee

This button is used whenever the user wishes to save their work-in-progress to a file on one of
the computer’s disk drives. It is only active if there are some new changes to the card design
that require saving. 

If a loaded card design has not been modified since the last time it was saved, then the
SSaavvee button will appear in its ‘greyed-out’ state as shown on the left

This button performs two slightly different functions depending on whether the design has
already been saved or not:

If the card design has already been saved and the SSaavvee button is clicked, the current work is
saved to the same file name without any further 6user intervention. The user will know that
the work has been saved successfully as the SSaavvee button will become greyed-out immediately
after the save operation.

If the card design is new and has not previously been saved, then the button will act as though
the user had selected the “FFiillee >> SSaavvee AAss……” menu function and a “Save As…” dialog will appear.
This dialog is almost identical to the OOppeenn dialog mentioned above, except that the user should
enter a new file name into the “File name” box once the correct directory has been selected. To
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save the file, the user should then click on the dialog’s SSaavvee button.

PPrriinntt CCaarrdd

This button is used to initiate the printing of the card currently being displayed in the Card
Design area. It causes the Print Card dialog to appear as shown below:

All printers installed on the PC on which
ImageBase is running are displayed in this 
dialog in the Printer list on the right hand side.

The printer that is currently selected to be the
Windows default printer will automatically be
highlighted at the top of the list. This will be the
case until a new default card printer is selected
from the FFiillee>>SSeelleecctt PPrriinntteerr...... menu option (see page 95 for details). 

The user should select the appropriate printer on which the card should be printed by clicking
the required one once in the printer list. The desired printer will more often than not be a
plastic card printer of some sort, but the ability to print to standard inkjet or laser printers is
built-in and could be used to make prints of cards onto standard paper for testing or 
administrative purposes.

The SSaammppllee MMooddee checkbox has been provided to allow users to print copies of card designs
without incrementing the built-in serial number if one is included on the card design. See page
107 for details on including automatic serial numbers on cards.

Multiple copies of a card may be created by selecting the desired number of copies using the
CCooppiieess drop-down box. Up to 150 copies of a card may be printed in any one batch.

For card designs that are two-sided, the option to print both sides of the card is provided by
the PPrriinntt BBootthh SSiiddeess checkbox. This checkbox is only selectable if the design being printed is a
double-sided one. 

EEddiittiinngg bbuuttttoonnss CCuutt,, CCooppyy,, PPaassttee aanndd DDeelleettee

A set of four commonly-used editing buttons has been provided for convenience on the main
toolbar. These buttons allow the user to perform common editing operation on the graphical
and textual objects that have been added to the card design.

Typically, before being able to use these buttons, an object such as an image, barcode or text
must have been selected on the Card Design area by being clicked on using the mouse. 
As soon as an object has been selected the object will appear highlighted around its edge,
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resizing and movement ‘bubbles’ will have appeared on the object and the editing buttons on
the toolbar (with the possible exception of the Paste button) will become active.

CCuutt This button will remove the selected object or objects from the design and place a copy on the 
computer’s clipboard.

CCooppyy This button makes a duplicate of the currently selected object(s) and places the copy on the 
clipboard without affecting the original object.

PPaassttee This button copies the contents of the Windows clipboard onto the current card design as a 
graphical or textual object.

DDeelleettee This button deletes the currently selected object(s) from the card design. Any object that has 
been deleted by mistake may be recovered by using the Undo button (described on the next 
page) provided the design has not been saved since the deletion occurred.

Full details on how to select and manipulate objects may be found on page 70.

UUnnddoo

This button is a powerful tool that can be used to rectify mistakes that have been made when
designing a card. If the user modifies a card design and wishes to backtrack to an earlier
stage, then the UUnnddoo button may be used to remove recent changes one at a time. Changes may
only be removed back to the point at which the card design was last saved – any modifications
that were made and then subsequently saved cannot be undone.

RReeddoo

The RReeddoo button works in the reverse way to the UUnnddoo button. If a recent change was removed
by using the UUnnddoo button by mistake or too many times, then the user may re-implement the
last change that was undone by clicking on the RReeddoo button.

PPiicckk CCoolloouurr

This button activates the colour picking tool. This tool allows the user to click on any object or
pixel (graphic point) on the card design and set the current colour value to that of the object
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TIP: Here is one simple example of the use of the Undo and Redo buttons:- A user places five objects onto a card design then
decides that only the first three are required. The user then clicks the Undo button to remove the last two placements, however
the button is clicked three times by mistake removing one of the required objects. The Redo button may then be used to place the
‘undone’ object back onto the card.  In fact, if the user wished, they could click on the Redo button two more times after that to
restore all five objects.



that was ‘picked’. The colour value that was picked is displayed on the CardDesigner program
status bar.

Also, holding down <CCttrrll> and clicking on the PPiicckk CCoolloouurr button will change the SSeett CCoolloouurr
button to the colour of the selected object. For instance, with a yellow box selected, holding
down the <CCttrrll> key and clicking the PPiicckk CCoolloouurr button will change the SSeett CCoolloouurr button to
yellow. 

SSeett CCoolloouurr

This button is slightly different in operation to the others on the toolbar. This button has two
elements – the main SSeett CCoolloouurr button (shown by the red square on the image above) and the
drop-down selection menu indicated by the downward-pointing black triangle.

The main SSeett CCoolloouurr button can be used to quickly set the colour of an object currently on the
card design. The colour that the object is set to is indicated directly on the button. The image
shown above has a red square and so any object that is selected will have its colour changed to
red if this button is clicked. For instance, if a ‘Box’ object is selected on a card design, clicking
the SSeett CCoolloouurr button will change the colour of that box to the colour that
is currently indicated on the button.

The drop-down selector causes a menu to appear that has a mini palette of
commonly-used colours that the user may select from. Each colour is indi-
cated by a coloured square which, when clicked, sets that colour as the cur-
rent one.

At the foot of the mini colour palette is a button labelled “More…”  This
button takes the user to a more powerful colour selection dialog which allows the user to fine-
tune the colour to exactly the hue required.

CCoolloouurr SSeelleeccttiioonn
Clicking on the MMoorree…… button on the pop-up mini palette displays the CCoolloouurr SSeelleeccttiioonn dialog.
This dialog has four tabs at the top. Clicking on each one of these tabs allows the user to

select from a huge range of colours as follows:
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TThhee ““NNaammeedd”” ttaabb
Clicking the Named tab displays a list box that
shows all of the named colours that the computer
has available for selection. 
This list is very extensive and the use of a named
colour ensures that the user can easily recall and
duplicate any colour that was used in a card
design.Clicking on a name in the list box causes the 
selected colour to be displayed in the Sample box
on the right of the dialog. The Original box above it
shows the colour that the Set Colour button is 
currently set to. This allows the user to compare
new colours with existing ones on the card design.

TThhee ““PPaalleettttee”” ttaabb
Clicking the Palette tab shows a ‘rainbow’ palette
of colours within a large box. This palette allows
direct selection of over 64,000 different colours. 

To select a colour, the user simply has to click on
the palette with the mouse and the colour 
underneath the mouse pointer will be selected 
and displayed in the Sample box. 

TThhee ““RRGGBB”” ttaabb
Colours may be defined by the amounts of Red,
Green and Blue light that each contains. This RGB
way of defining colours is often used to accurately
determine colours on computers and so the RGB
tab has been provided to allow users to select
colours using this method.
Each of the component colours (red, green and
blue) has a slider with a numerical reading 
alongside it. Moving each slider changes the
amount of that colour that is present in the Sample
displayed on the right. 

A value of zero for a colour signifies that there is none of that colour present in the sample. A
value of 255 indicates that the maximum amount of that colour has been added to the sample.

65



TThhee ““CCMMYY”” ttaabb
In a similar way to the RGB tab, the CCMMYY ttaabb allows
the user to select colours by means of their Cyan,
Magenta and Yellow components. This method of
colour definition is often used within the printing
profession and so has been included for those who
are familiar with it.
Each Cyan, Magenta or Yellow component, has its
intensity set by the appropriate slider bar. The
colour-coded numerical readout to the right of
each slider indicates the exact value that the 
particular component has been set to. Changes to
the CMY components are reflected in the Sample colour box as soon as they are set. A value of
zero for a colour component signifies that there is none of that colour present in the sample. A
value of 255 indicates that the maximum amount of that colour has been added to the sample.

AAlliiggnnmmeenntt TToooollss

The Alignment tools are provided to easily line-up multiple objects on the card design. This is
often useful when objects on multiple layers need to be overlaid precisely. Clicking on the AAlliiggnn
TToooollss drop-down button (the downward-pointing arrow to the right of the alignment button)
causes an extra toolbar to appear as shown below:

Moving the mouse cursor over this mini
toolbar highlights each alignment 
button and a pop-up description of each
one will appear if the cursor is allowed to hover over it for a moment.

It should be noted that the alignment tools will only be available on the toolbar if at least one
object is currently selected on the card design.  

Another important thing to note is that the ffiirrsstt oobbjjeecctt ttoo bbee sseelleecctteedd is always the one to
which the others are aligned and can be identified by it having a thicker border around its
bubbles than the other selected objects. This ‘key’ object may be changed by pressing the ‘NN’
(for Next) and ‘PP’ (for Previous) keys on the keyboard to cycle between the selected objects.

For more information on selecting objects, refer to page 67. In all the alignment icons shown
below, the first-selected object is assumed to be the larger of the two boxes.
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The different alignment buttons are:

AAlliiggnn ttoo lleefftt--mmoosstt eeddggee..
Moves all other objects to line up with the left-most edge of the first-selected object.

AAlliiggnn ttoo rriigghhtt--mmoosstt eeddggee..
Moves all other objects to line up with the right-most edge of the first-selected 
object.

AAlliiggnn ttoo ttoopp--mmoosstt eeddggee..
Moves all other objects to line up with the top-most edge of the first-selected object.

AAlliiggnn ttoo bboottttoomm--mmoosstt eeddggee..
Moves all other objects to line up with the bottom-most edge of the first-selected 
object.

AAlliiggnn ttoo hhoorriizzoonnttaall cceennttrree ooff oobbjjeecctt..
Moves all other objects to line up with the centre of the first-selected object in the 
horizontal direction only.

AAlliiggnn ttoo vveerrttiiccaall cceennttrree ooff oobbjjeecctt..
Moves all other objects to line up with the centre of the first-selected object in the 
vertical direction only.

AAlliiggnn ttoo cceennttrree ooff oobbjjeecctt..
Moves all other objects to line up with the centre of the first-selected object in both 
the horizontal and vertical directions.

AAlliiggnn ttoo hhoorriizzoonnttaall cceennttrree ooff ccaarrdd..
Moves all objects to line up with the centre of the card design in the horizontal 
direction only.

AAlliiggnn ttoo vveerrttiiccaall cceennttrree ooff ccaarrdd..
Moves all objects to line up with the centre of the card design in the vertical 
direction only.

67



NNootteess

Clicking this button displays the Notes dialog. The Notes dialog is simply a free-form text entry
box which allows the user to enter any textual notes that need to be associated with the 
current card design. This allows the designer of a card to inform other users of pertinent
information that could be useful if the card is ever re-worked or modified.

In the example on the right, notes have been entered to describe the differences between the
current card design and another standard one that is used within the company concerned.

After typing, clicking on the OK button commits the notes to the design. Subsequently saving
the design using the SSaavvee button will store the notes along with the card design file.

SSnnaapp TToo GGrriidd

To aid in positioning objects on the card design, the SSnnaapp TToo GGrriidd function has been provided.
When this button is selected, all objects placed onto the design will automatically have their
centres  aligned to a 1mm increment grid. All previously-positioned objects will remain in their
previous alignments unless they are moved or resized after the SSnnaapp TToo GGrriidd has been 
selected.

RReeffrreesshh

Sometimes, items displayed on the Card Design area may have been modified outside of the
ImageBase program – for example an image or company logo may have been changed by an
image editing program while ImageBase was running with the card design loaded and visible
on screen. If that has happened, the image or logo shown on the card design will be the older,
unmodified one. The RReeffrreesshh button has been provided to ‘refresh’ the content of the card
design and display any changes made to the objects on it. Clicking it will ensure that all 
displayed objects are representative of the current versions.

68



TThhee DDeessiiggnn TToooollbbaarr

The design toolbar consists of a row of buttons stacked vertically down the left side of
the program window tab. These buttons provide quick and easy access to graphical and
textual objects that may be placed on the card designs. They give the user a full set of
building blocks that may be used to create any number of card designs suitable for
many different purposes.

Each button has two states – ‘available’ and ‘selected’. All buttons are always available
for use (unlike the main toolbar which sometimes has buttons disabled) with the 
currently selected tool having a darker background to indicate that the button has
been ‘pressed’. 

In the image to the left of the design toolbar, the top-most button – the Select Mode tool – is
currently in use and is shown as ‘selected’.

SSeelleecctt MMooddee

The Select Mode tool is the default tool that is active whenever the Card Designer utility is
started. This tool does not place an object onto the card design – rather it is a general 
purpose manipulation tool that may be used to change the positions and dimensions of objects
on the design as well as selecting objects for subsequent modification or editing.

To use the Select Mode tool, the tool must first be chosen by clicking on the button. Also, there
must be some objects already on the card design for the tool to be used with. Here are some
examples of the use of the Select Mode tool. In each case, the tool is assumed to have already
been clicked and appropriate objects have already been placed on the card design:

SSeelleeccttiinngg oobbjjeeccttss
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AAnn oobbjjeecctt iiss oonn tthhee ccaarrdd aanndd tthhee SSeelleecctt MMooddee ttooooll iiss
cchhoosseenn..

TThhee mmoouussee ccuurrssoorr iiss mmoovveedd oovveerr tthhee oobbjjeecctt aanndd tthhee
lleefftt bbuuttttoonn iiss cclliicckkeedd.. TThhee oobbjjeecctt iiss nnooww sseelleecctteedd
aanndd hhaass ccoolloouurreedd ‘‘bbuubbbblleess’’ aarroouunndd iittss eeddggeess aanndd
iinn iittss cceennttrree.. TThhee bblluuee bbuubbbblleess aarree uusseedd ttoo rree--ssiizzee
tthhee oobbjjeecctt,, tthhee ggrreeeenn oonnee iiss uusseedd ttoo mmoovvee iitt..



MMuullttiippllee oobbjjeeccttss may be selected by clicking and dragging the mouse cursor to form a dotted
box around all of the desired objects. Alternatively, holding down the <Ctrl> button on the 
keyboard while clicking on successive objects will select each one cumulatively. Clicking again
on a selected object when holding <<CCttrrll>> down will de-select the object. In this way, multiple
objects can be selected accurately.
When multiple objects are ssttaacckkeedd on top of each other, they may each be selected in turn by
hovering the mouse cursor over them all where they overlap and then holding the <SShhiifftt> key
down on the keyboard whilst clicking to select successive objects in the stack.

CCooppyyiinngg oobbjjeeccttss

With the object selected, the CCooppyy and the PPaassttee buttons on the main toolbar may be clicked in
succession to create a duplicate of the purple box. This new box will be superimposed exactly
over the top of the other box, ready to be positioned.  

The main indication that a new box has been created
is to be found on the status bar at the bottom of the
application window:

MMoovviinngg oobbjjeeccttss
The green bubble allows the selected object to be moved around
the Card Design area. 

When the mouse pointer is placed over the green ‘move’ bubble, the cursor changes 
to a four-pointed cross. 

There are two ways of using a move bubble:

Left-click the bubble and then hold the left mouse button down while dragging the object 
around the screen 
Left-click and release the button, move the object, then left-click and release again to drop the
object.

The green bubble on the duplicate purple box was clicked and the box
was moved alongside the original one.

It is noticeable that the box which was moved is still selected after the
move is completed (the bubbles are still visible).

When an object is being moved, the cursor position is indicated

70



on the horizontal and vertical rulers by a moving line. This feature allows the object to be 
positioned accurately on the card design.

It is also possible to move an object by holding down the <<SShhiifftt>> key on the keyboard and
clicking aannyy of an object’s bubbles. This is useful for positioning objects by means of their
edges rather than their centres as the moving marker on the rulers represents the bubble
position.

When multiple objects are selected, they may all be moved together using the same methods.

MMoovviinngg oobbjjeeccttss uussiinngg tthhee kkeeyybbooaarrdd
The keyboard may be used to move items around the card design area. Using the cursor keys
(up, down, left and right) on the keyboard will move a selected object (or objects) around the
screen in small increments. For precise control, the <<CCttrrll>> key may be held down whilst using
the cursor keys to perform finer movement.

RRee--ssiizziinngg
The blue bubbles on the selected object allow the user to re-size the object in different direc-
tions. The bubbles that are available on the corners of a selected object allow size to be
changed in diagonal directions. Certain objects - images for example -  can be set to always
keep the same aspect ratio and so the relative size of the height to the width remains the same
for those objects. 

The bubbles attached to the middles of the horizontal and vertical faces of the object are used
to change the width or height of the object individually. This changes the aspect ratio of the
object when changes are made. These bubbles are not present on any fixed-aspect ratio
objects.

The cursor style will change depending on which bubble is selected on the object:

The top-left and bottom-right bubbles get a top-left to bottom-right diagonal
cursor.
The top and bottom bubbles on the horizontal edges get a cursor that points
up and down.

The bottom-left and top-right bubbles get a bottom-left to top-right diagonal
cursor.

The left and right bubbles on the vertical edges get a cursor that points left
and right.
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The colour-coding above shows the styles
of cursor that appear for each bubble.



The box on the right of the pair of purple boxes is here shown having been
resized to be larger. This was done by clicking on the bottom-right button
and dragging the edge of the box to the desired size. 

During the dragging operation, the new edge positions of the box were 
visible and markers were seen on both rulers to aid accurate placement.
After the resizing operation, the object remains selected and ready for
more changes.

CChhaannggiinngg aann oobbjjeecctt’’ss PPrrooppeerrttiieess
For all objects that have been placed onto the card design, extra settings are available and
may be changed by the user. For example, once a text object has been positioned, the text itself
may be changed. This is done by selecting PPrrooppeerrttiieess for the text object. 

All objects have this ability to be changed. There follows a step-by-step example of a text object
being edited. Note that the “properties”  dialogs for the various types of object are all 
different and will be described in detail in the subsequent sections – this example is simply to
show the procedure used to display the properties dialogs.
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Here, a text object has been placed on a card
design.

The text object has now been selected by
clicking on it with the mouse cursor

The user then moves the mouse over the
selected object and clicks the right mouse
button to display a pop-up menu. The
PPrrooppeerrttiieess function is then selected on this
menu.

The Text Object Properties dialog then appears
and allows access to a whole range of settings
that can change the appearance of the text.



The Properties dialog for any object may also be accessed by selecting the object and then
pressing the EE key on the keyboard.

LLoocckkiinngg aann oobbjjeecctt

Selecting the LLoocckk function from the pop-up
“Properties” menu disables the movement and
resizing bubbles for the selected object. 
The bubbles will subsequently appear grey if the
object is selected while the LLoocckk is on and the
object will not be able to be moved, resized or 
edited while it is locked. 

The image on the right shows the greyed 
bubbles, the disabled Properties function on the
pop-up menu and the check-mark next to the LLoocckk menu item that indicates the object’s
“locked” status.

To remove the lock, simply re-select the pop-up “Properties” menu and re-select the LLoocckk
function to remove the lock. 

Selecting an object and pressing the LL key on the keyboard toggles the lock status of that
object.

LLaayyeerrss
One problem when laying-out different kinds of objects onto a card design is determining what
is printed on the card if objects overlap.

Overlapping objects may be desirable – for instance, a background image may be wanted for
the whole card with other objects appearing overlaid on it. The computer does not ‘instinctively’
know that the background image is meant to be ‘behind’ the other objects, so the other objects
may be obscured by it.

One way of making sure that all objects are correctly positioned in the foreground or 
background is to think of a design in terms of being made up of different ‘layers’ like different
sheets of clear acetate being overlaid – each with different images on – to create a design
based on the superimposed images.
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An example of layers in action

Four box objects have been placed on a card
design, each of a different colour and each set to
be on a different layer of the design. The layers
used are 1, 2, 3 and four.

The Yellow box is then right-clicked to show the
pop-up Edit menu and the Layer option is selected.
This in turn displays the available layer numbers
for the design.

Layers are numbered from 1 to 10. The lowest 
positioned printable layer is layer 1, the uppermost
is layer 10.  

On the left, the current layer (3) of the yellow box is marked by a check-mark in the list of 
layers. In this example, the layer is to be changed to a higher one – layer 5.

Now that the yellow box has been changed to be
on layer 5 rather than layer 3, it appears on top
of all of the other box objects that are on lower
layers.

In the same way, users may compose complex
multi-layer card designs with background
images, superimposed photos and text. They can
also ensure that barcodes and other important
information on any cards designed with
CardDesigner will not be obscured by other graphics when printed.
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TIP: There is another layer listed in the Layer pop-up menu – the Non Printable layer
The Non Printable layer is a layer that is typically used to identify features of the card that need to be taken into account when
designing a card, but which will not be printed when the design is printed. For example, the magnetic strip or a smart-chip on the
card may be shown on the Non Printable layer. 

The user may place any object on the Non-Printable layer, but once placed there the object will no longer be selectable or editable
because this layer is ‘locked’ by default. The Non-Printable layer may be ‘unlocked’ by selecting the Layers… option from the Edit
menu - this will then allow objects on this layer to be selected and edited. It is strongly recommended that the user refrains from
unlocking the Non-printable layer unless absolutely necessary as this may allow pre-defined templates to be accidentally
changed.



BBooxx ttooooll

The Box tool allows the user to place square
or rectangular box-shapes onto a card design.
Typically boxes may form a shaded area onto
which other objects such as text or barcodes
may be placed. 

All boxes have a black outline when created
and the default colour for the box within the 
outline is ‘transparent’. This allows boxes to be used as a ‘frame’ for other items on a card
design.

To place a box object onto a card design, the Box tool button on the toolbar should be selected
and then the left mouse button clicked in the position on the design where the first corner of
the box should appear. The mouse is then moved and the left button clicked (or released if
dragging) when the outline of the box is the desired size and shape. The box object will then
appear and be selected automatically in case further positioning is required.

It should be noted that the <<EEsscc>> key can be used to abort any box placement as well as most
other operations if required.

PPrrooppeerrttiieess ooff BBooxx oobbjjeeccttss
Right-clicking on a Box object and selecting ‘Properties’ will display the properties dialog for
the selected Box object.

There are three tabs on the Box Properties dialog. The
first one, GGeenneerraall, is provided to allow the colour of the
box to be changed. 

To change the box colour, the CChhaannggee...... button, located
below the Colour box, must be clicked to display the
colour-change dialog. The desired colour for the box may
then be selected as was described in the Set Colour 
section of this manual on page 64.
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The second tab is the BBoorrddeerr tab. The settings available
on the Border tab allow the thickness and the colour of
the border of the box object to be selected. The default
thickness is ‘Hairline’ and the default colour is black.

The thickness is changed by clicking on one of the preset
thicknesses provided in the list box. The colour of the 
border is changed by clicking on the Change... button
located below the Colour box. As with setting the colour of
the rest of the box, the colour-change dialog is used to
set the colour and this is described in full on page 64.

The final tab allows a SShhaaddooww to be shown for the 
selected box. This property allows the shadow to be
turned on or off via the EEnnaabblleedd checkbox. 
It also allows the shadow to be orientated vertically and
horizontally by means of the “Shadow is Above” and
“Shadow is to Left” checkboxes. If the shadow is not
‘above’ then it is set to be ‘below’ instead. Similarly, if it is
not set to the ‘left’ then it will appear on the right.

The Offset of the shadow may be set to different 
measurements. The larger the offset, the more 

pronounced the shadow of the box will be.

The colour of the shadow may also be set by clicking on the CChhaannggee...... button.

76



IImmaaggee ttooooll

The IImmaaggee tool allows the user to place an image of
the card-holder onto the card design. 

To place an image object onto a card design, the
IImmaaggee tool button on the toolbar should first be
selected. The mouse may then be used to draw the
outline of the image on the card design either
using a “click to start drawing – click to stop 
drawing” technique or a “click, then drag and
release” technique. Both methods of using the
mouse will result in a box being drawn on the card
design into which a default image will appear. This
image is simply a place-holder and will be replaced when card printing is performed using data
from an external database. The image may be positioned and resized as required as with all
other objects, however some restrictions to the shape of the image may be encountered
depending on the properties assigned to the object (see below).

Images are treated differently from standard graphic files placed on the design. They are
assumed to be photographic images that are retrieved from an ImageBase database rather
than being a fixed graphic to be used unchanged on every card. This use of database content
(text can also be drawn from those databases as will be seen later) allows a single card design
to be used to print cards for many different people.

The images placed using the Image tool can be taken automatically from the ImageBase 
database provided that the database field name to be used as the source is referred-to in the
card design. For instance, if an the database keeps its images under the title “ID_Photos”
then specifying this name in the “ImageBase32 Field” setting for the image on the card design
will ensure that the correct stored image is printed for each card produced. For simplicity, a
field name does not need to be specified if there is oonnllyy oonnee Image field in the database.
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PPrrooppeerrttiieess ooff IImmaaggee oobbjjeeccttss

Right-clicking on an Image object and selecting ‘Properties’ will display the properties dialog
for the selected Image object.

There are three tabs for the properties, the first of which
is the GGeenneerraall tab. The General tab allows the aspect ratio
of the displayed image to be set. The options are:

SSqquuaarree – both the height and the width of the image 
are equal. If the height is changed, the 
width automatically changes to match and vice-
versa.

PPoorrttrraaiitt – the image is taller than it is wide in the ratio 
of 4:3 - the same format as most passport 
photos. Changes to height cause a corresponding change in width to keep the 4:3 
ratio automatically. 

FFrreeee – the user may set the height and width of the image to any size required. Changing 
the height of the image does not affect the width at all and vice-versa.

The other property that may be set on the General tab is the IImmaaggeeBBaassee3322 FFiieelldd name. The
name used for the field containing images in an ImageBase database is entered here. Once
entered, the image from the current record open in the ImageBase database will be displayed
in the Image object automatically within the CardDesigner tab. 

The Image properties dialog has two other tabs available – the BBoorrddeerr tab and the SShhaaddooww
tab.

The properties on these
two tabs are used to set
the border colour and
thickness as well as 
setting the colour and
prominence of any
shadow that is to be
used behind the image
object.

The workings of these two tabs are identical to those of the BBooxx tool property dialog details of
which may be found on page 64.
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TTeexxtt ttooooll

The TTeexxtt tool allows the user to place fixed text and database field names onto a card design.
When selected, a dialog instantly appears allowing the user to enter the text and change how it
looks when placed on the card design. The dialog has six tabs, each with different sets of
properties that may by changed to customise the appearance of the text.

The TTeexxtt tab provides a text-entry box
into which the text to be displayed is
entered. If the Instant Refresh checkbox
is ticked, the text entered will 
automatically be displayed in the Sample
display box on the left of the dialog as it
is typed.

Three buttons are provided above the text-entry box providing the 
familiar CCuutt, CCooppyy & PPaassttee facilities that are useful when editing text.

The FFoonntt tab allows the font style and
font size to be selected from two list
boxes.

The fonts available on each PC will vary
to some extent. More fonts may be
installed if they are required – contact
your system administrator if more fonts
are required.

In the example to the left, the font style “Comic Sans MS” was chosen and the font size was set
to 23 by clicking on the desired settings in each list. 

The Sample screen automatically displays the new font in the new size when the selections are
made. In this way, the user may check each font style to find an appropriate one for the card

design.
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LLiinnkkiinngg ffiieellddss ttoo tthhee ddeessiiggnn
Fields can be linked to the design by entering the fieldname into the text box enclosed in
brackets.  For example, if you had a field called FFoorreennaammee in the database, then the design can
be linked to display the information in that field by entering the value [Forename] into the
design.

An example is shown below:

Applying specific properties to text

Within the text properties box you can apply custom attributes to help format the design layout.

Attributes that can be applied to the text include bboolldd, italics and underline.

To apply the attributes to a particular word, requires wrapping that word within tags, much like html 
formatting.  The following tags include:

The SSttyyllee tab allows the appearance of the
text to be changed further.

A mini toolbar allows the text to be set to
be BBoolldd, IIttaalliicc and//or UUnnddeerrlliinneedd. In the
example to the right, the text has been
set to be italic.
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PPrrooppeerrttyy
Bold
Italics
Underline

SSttaarrtt TTaagg
<b>
<i>
<u>

EEnndd TTaagg
</b>
</i>
</u>

EExxaammppllee
<b>text entry</b>
<i>[Forename]</i>
<u>Title:</u> 
This is not underlined

OOuuttppuutt
tteexxtt eennttrryy
Andre
Title:
This is not underlined



It is possible to set an opaque background colour (the default is that the background is 
transparent). To do this, the checkbox “Background is opaque” should be set. This then
enables the Change... button which, in turn, allows the colour for the background to be 
selected. This colour selection process is identical to that described on page 64.

The width of the characters and the gaps between them may also be set from this dialog. Each
of these settings is performed by clicking on the desired entry in the Character Width and
Character Gap list boxes.

In the example above, the Character Width has been set to 43, making the letters wider than
normal. Any changes made are shown instantly in the Sample box if it is enabled.

The AAlliiggnn tab has been provided mainly
for when longer sections of text with
multiple rows are to be added to a card
design. 

The text alignment mini toolbar allows
the text to be aligned to the left, 
centrally or to the right by clicking on

the appropriately positioned button.

There are four checkboxes provided to perform different alignment functions:

SShhrriinnkk tteexxtt ttoo ffiitt lliimmiittss This reduces the point size of the text to fit the size of the text
object that is on the card design. This is a very useful feature for
text objects that are being used to display database field contents. 
For instance, if a  [Name] field is extracted from a database, the 
text object will fit  “Alan Smith” and  “Michael Schumacher” in the 
same sized text object by shrinking the text of the latter name to a 
smaller font.

WWoorrdd WWrraapp This makes text occupy multiple lines rather than being placed all
on the one line. This is useful for when longer text strings, either
fixed or from a database, are used on a card design.

DDoonn’’tt lleett tteexxtt pprriinntt This function crops any text that would stray out of the bounds of 
OOuuttssiiddee lliimmiittss the text object that is placed on the card design.. In the

previous“shrink to fit” example with the two names, the latter would
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be truncated if this option was selected and the text object was too
small to display the full name at the requested font size.

AAuuttoommaattiiccaallllyy aalltteerr This changes the positions of the resizing bubbles and the
GGrraabb ppooiinnttss move bubble to accommodate the new size and shape of the text i

the object.

The AAnnggllee tab allows the text in the text
object to be printed at any angle on the
card. 

A mini toolbar is the main control on this
dialog. The buttons allow text to be
drawn at fixed angles or at a custom
angle. 

The buttons functions are as follows:

NNoorrmmaall oorriieennttaattiioonn – text is printed horizontally and the correct way up.

BBoottttoomm ttoo ttoopp – text is rotated 90° anti-clockwise.

UUppssiiddee ddoowwnn – text is rotated 180° anti-clockwise

TToopp ttoo bboottttoomm – text is rotated 270° anti-clockwise

CCuussttoomm oorriieennttaattiioonn – the list of angles below the toolbar is enabled and the user may
select any angular orientation for the text. The angles range from 0° to 359° all
measured anti-clockwise from the normal, horizontal text position. 

In the example above, the text has been set to an angle of 25°.
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The SShhaaddooww tab allows a coloured shad-
ow to be created for the text in the text
object. The shadow can be turned on or
off at any time by means of the EEnnaabblleedd
checkbox.
The default position of the shadow is
below and to the right of the text itself.
This orientation may be changed by 
setting the SShhaaddooww iiss AAbboovvee and SShhaaddooww
iiss ttoo LLeefftt checkboxes. 

The colour of the shadow may be selected by clicking on the CChhaannggee...... button below the Colour
box. The colour dialog can then be used to change the colour of the shadow. The operation of
the colour dialog is covered fully in the section on page 50 of this manual.

The amount that the shadow is offset from the text affects the overall effect of the shadow.
The greater the offset, the more noticeable the shadow is. The Shadow Offset list box offers a
range of different values of offset for the shadow. Clicking on the desired one selects that
value. A value of 1.50 points has been selected in the ongoing example shown above.

When the OOKK button is eventually clicked, the user is
free to place the text object in the correct position on
the card design if it is a new object. 

The final result of the example worked-through on
the previous pages is shown here. 

BBaarrccooddee ttooooll

The BBaarrccooddee tool allows a wide range of different barcode types to be printed on a card
design. 

To place a barcode object onto a card
design, the BBaarrccooddee tool button on the 
toolbar should first be clicked. 

The mouse may then be used to draw the
outline of the barcode on the card design
either using a “click to start drawing – click
to stop drawing” technique or a “click, then
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drag and release” technique. 

Both methods of using the mouse will result in a box being drawn on the card design into
which a default barcode will appear. This barcode is simply a place-holder and may be changed
by means of the barcode properties dialog. The barcode may be positioned and resized as
required as with all other objects

PPrrooppeerrttiieess ooff BBaarrccooddee oobbjjeeccttss

Right-clicking on a Barcode object and selecting ‘Properties’ will display the properties dialog
for the selected barcode. There are three tabs on the Barcode properties dialog – General,
Detail and Text.

The GGeenneerraall tab is the most impor-
tant tab as it contains the entry box
for the code as well as the selector
for the type of barcode that is to be
used.

The code number that the barcode is
to represent is entered into the
CCooddee box. 

A field name may also be used in the Code entry box so that the barcode values  may be
assigned from ImageBase database records.

Field names are always enclosed within square brackets – if the barcode was generated from
the “EmployeeNo” field, then [EmployeeNo] would be entered into the Code box.

The Barcode Type determines the encoding method and appearance of the barcode that is 
displayed on the card. It is essential that the correct format of barcode is used to match the
barcode-reading equipment to be used with the cards. 

The desired barcode type is selected by clicking on it in the Barcode Type list box.

A detailed description of each barcode type is beyond the scope of this manual. For some of
the more popular barcodes, a brief description of the barcode will appear in the yellow panel
on the right of the dialog. 
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It should be noted that certain barcode types require a
specific number of digits in order for them to be created.
If an insufficient number of digits has been entered in
the Code box, the display in the Sample box will appear as

shown on the left. When a valid number of digits has been entered, the barcode will be dis-
played.

The DDeettaaiill tab allows the orientation
of the barcode to be changed as well
as the relative widths of the bars in
the barcode.

The WWiiddee ttoo NNaarrrrooww RRaattiioo setting
alters the ratio of a Wide line to the
Narrow lines in a barcode. This has
an impact on the machine-readability
of the barcode and certain settings
will be better for certain barcode

readers than others. The manufacturer of the barcode reader may specify an appropriate
ratio or the best-performing ratio may be determined by testing the different ones out on a
printed card. To set the correct ratio, the appropriate value should be clicked in the list box.

The orientation of the barcode is selected by means of four orientation buttons:

NNoorrmmaall oorriieennttaattiioonn – barcode is printed horizontally with any text the correct way up.

BBoottttoomm ttoo ttoopp – the barcode is rotated 90° anti-clockwise.

UUppssiiddee ddoowwnn – barcode is rotated 180° anti-clockwise and so any text is inverted.

TToopp ttoo bboottttoomm – barcode is rotated 270° anti-clockwise.

The two final property settings on the Detail dialog are both checkboxes:

HHaass CChheecckk DDiiggiitt A check digit is a mechanism for checking that a barcode has been
read correctly. It adds an extra digit into the barcode which is
dependent on the code itself. It should only be used if the barcode
reader is configured to use it. 
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The use of the check digit does not affect the code that is returned 
by the barcode reader – it is used purely to make sure that the code
was interpreted correctly.

PPrriinntt tteexxtt This setting allows the code to be reproduced in textual format
beneath the barcode.  It is sometimes useful to have the code in a
human-readable format for those circumstances where a barcode
reader fails to read the code correctly. This way the proper code
may be entered into a system manually. 

The TTeexxtt tab allows the font style
and font size to be defined for any
text that is displayed beneath the
barcode. Both the FFoonntt and SSiizzee are
selected from the lists provided by
clicking on the desired settings.

A mini toolbar is also supplied to give quick access to functions that
make the text BBoolldd, IIttaalliicc or UUnnddeerrlliinneedd.

BBiittmmaapp ttooooll

The BBiittmmaapp tool allows a standard image file to be placed onto the card design. Clicking on this
tool causes the Load Picture dialog to appear which allows the desired image to be located and
selected from the PC’s disk drives. 

The LLooaadd PPiiccttuurree dialog is a standard
Windows file opening dialog and as such
will vary in appearance depending upon
which version of Windows is being used on
the PC.

In the example shown on the right, the
operating system being used is Windows
XP Professional. With all of the Windows
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operating systems from Windows 95 onwards, the main navigation controls will be similar and
located at the top of the dialog.

Once the desired file has been located and clicked on, the OOppeenn button on the dialog will select
that file and the outline of the bitmap will be shown on the card design area ready to be 
positioned. Effectively the bitmap image is in ‘Move’ mode and may be moved around the card
design using the mouse before the left mouse button is clicked to place it.

Once placed on the card design, the image may be selected, re-sized and re-positioned as with
all other objects.

Right-clicking a BBiittmmaapp object shows an extra menu item – RReessiizzee ttoo FFiillll CCaarrdd. Selecting this
menu item causes the bitmap to be changed in
size to cover the entire card design area. The
bitmap is also moved to layer 1 of the design and
this layer is then locked to prevent the 
background from being selected. Before the
image is locked however, the user may make
changes to the position and size of the bitmap to
ensure it is correctly placed on the card design.

When a new card design is saved for the
first time, the user is prompted to see if the
bitmap images used on the design should
be saved to the same directory as the card
design file.

This allows copies of all of the files necessary for editing and printing the design to be kept
together in one place.

If a bitmap is deleted or otherwise becomes unavailable to CardDesigner
(for instance if the bitmap is stored on a network drive and the network 
connection is lost) then the ‘NoImage.gif’ placeholder (shown left) will be
seen in place of the original bitmap. To restore the original bitmap, restore
access to the original file or right-click the placeholder and select
Properties to search for an alternative source file.
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TIP: Using the Load Picture dialog to place images onto the card design area is fine, but it is sometimes quicker to ‘drag & drop’
an image into the card design from Windows Explorer or an open directory. Simply click on the required image in the directory,
holding the mouse button down and drag the image across onto the card design area. There, the image may be dropped and then
selected, moved and resized as required.



BBiittmmaappss aanndd rreessoolluuttiioonn
Many card printers are able to print at 300 dpi (dots per inch) resolution (or 8 dpmm in metric).
For optimal appearance, bitmap images used on card designs should be scanned at the same
resolution. 

This would mean that a 10mm square image should ideally be “80 dots by 80 dots” resolution.
Other resolutions may be used of course, but the printed output may display some distortion
or aliasing effects where lines or jagged edges are seen on the printed image.

PPrrooppeerrttiieess ooff BBiittmmaapp oobbjjeeccttss

Right-clicking on a BBiittmmaapp object and selecting ‘Properties’ will display the properties dialog
for the selected bitmap image. 

The BBiittmmaapp PPrrooppeerrttiieess dialog allows the Aspect
Ratio of the image to be fixed or freely changeable
and also allows the location of the bitmap file to be
seen and changed if required.

The Aspect Ratio is set to PPrrooppoorrttiioonnaall by default to
keep the relative height and width of the original
bitmap constant. Setting it to FFrreeee allows the bitmap
to be stretched both horizontally or vertically.

The ‘browse’ button at the right of the Source File text box pops-up a standard
Windows File Open dialog which may be used to locate and open any compatible image

file. File formats typically used include the BMP (Windows Bitmap) format, GIF (Graphical
Interface Format) and JPEG/JPG (Joint Picture Expert Group).
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MMaaggnneettiicc EEnnccooddiinngg OOppttiioonnss

It is possible with certain plastic card printers to
perform the printing and the encoding of the
card’s magnetic stripe in a single operation. 

The MMaaggnneettiicc EEnnccooddiinngg OOppttiioonnss facility has been
provided for such printing operations. With it,
data may be written in up to three tracks on the
magnetic stripe.

Each track on a magnetic stripe may be enabled
or disabled by means of the checkboxes on the
right of each Track data entry box.

Each track has its own data entry box which may contain specific textual or numeric data or a
combination of both. It may also contain database field names for linking into an ImageBase
database. All such field entries must be enclosed within square brackets [[]].

If magnetic encoding is not required for certain print jobs, then the encoding of all tracks may
be disabled by clearing the master EEnnaabblleedd checkbox located at the bottom-left of the dialog.
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CCaarrddDDeessiiggnneerr MMeennuu SSttrruuccttuurree

Because CardDesigner is such an important part of the ImageBase program, when this option
is selected and active, the menu options change to accommodate specific options.  To aid the
user in understanding all of these options, the following section will describe each menu 
function individually. 

Main menu sections (the FFiillee, EEddiitt, VViieeww, TToooollss and HHeellpp headings) will be shown before each
sub-menu to help identify where the particular sub-menu is located. This will be shown in the
form  <<MMaaiinn mmeennuu>> ttoo <<ssuubb--mmeennuu>> in the sections below. 
One example of this notation would be:

VViieeww >> RReeffrreesshh

which would require the user to first click on the “VViieeww” menu
then on the “RReeffrreesshh” sub-menu item as shown in the picture to
the right.

TThhee FFiillee mmeennuu

The FFiillee menu contains all of the familiar file manipulation
functions associated with most Windows programs such as
creating new files, opening existing files, saving files and
printing them. 

Other features such as closing the CardDesigner tab 
changing the ‘page’ properties of the card such as its size and
colour are also included.

There follows a complete guide to each function in the file
menu.

FFiillee >> NNeeww……

The NNeeww…… menu function instructs CardDesigner to
create a completely new, blank card design to use as a
starting point for a new design. 
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If a design is already in progress and is currently
unsaved, a prompt will be issued to the user to allow
the existing design to be saved before the new, blank
design is started. This ensures that the user does not
lose any work-in-progress if the NNeeww…… function is
selected by mistake.

When the NNeeww...... function has been selected and
any existing work saved, the New Card Design
dialog will be displayed to allow the user to
select from a range of standard templates for
different styles of card.

The required card style is selected from the
‘Template’ list box and it will be applied when
the OOKK button is clicked. The new, blank card design will reflect the style chosen. Selections
available are standard blank card (the ‘None’ template), a double-sided card with a magnetic
stripe on the back, a smart card (single-sided with smart-card chip position marked) and 
double-sided with both a magnetic stripe and smart-card chip.Once the template has been 
chosen, the blank card is shown, ready for the design to be started.

FFiillee >> NNeeww DDeessiiggnn WWiinnddooww

This function creates another fully-functional card design window to appear.  It effectively
allows two or more copies of the program to run side-by-side. This is particularly useful if the
user wishes to copy 
sections of an existing card design from one card to
another. 

The CCooppyy, CCuutt and PPaassttee commands may be used to duplicate or move sections of one card
design over to the other design window.

FFiillee >> OOppeenn......

The OOppeenn...... function allows the user to select a 
previously-saved file from disk to be opened for 
modification or printing in the card design editor. 
This function may also be selected by pressing the << CCttrrll >>
and OO keys simultaneously on the keyboard. 
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When this function is selected, the OOppeenn...... dialog appears to allow selection of the previously-
saved design file.

The precise appearance of the OOppeenn......
dialog will depend upon which version of
Windows (2000 or XP) that ImageBase is
running under, but the basic 
functionality is the same for all versions
of Windows.

The navigation bar at the top of the 
dialog allows the user to locate the disk
drive and directory in which the desired

file has been stored. 

Once the file has been located, it is opened by using the mouse to select it, then clicking on the
Open button with the mouse. The design file will then be loaded into the card design editor.

FFiillee >> CClloossee

The CClloossee function is used when a card design is 
completed or the user wishes to cease work on a  design. 

This function may also be selected by pressing the <<CCttrrll>>
and FF44 keys simultaneously on the keyboard. Note that FF44
is a single ‘function’ key located at the top of most 
keyboards.

If changes were made to the current design that have not yet been saved, the user will be
prompted to save the design before the design workspace is cleared. Once the CClloossee command
has been completed, the card design workspace will be blanked with no card displayed. The
user will then need to select either FFiillee >> NNeeww or FFiillee >> OOppeenn to continue using the program
with a new or existing card design.
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FFiillee >> SSaavvee

The SSaavvee function is used when the user wishes to save
changes to a previously stored card design. 

This function may also be selected by pressing the <<CCttrrll>>
and SS keys simultaneously on the keyboard. 

The SSaavvee function is only enabled in the menu when there
are currently changes to be saved to the design. If no
changes were made and the saved file is identical to the one in the design window, then the
SSaavvee function will be ‘greyed out’ to indicate that the stored file is up-to-date.

When a SSaavvee is performed, the design file being worked on is updated to reflect the present
state of the design. At this point also, the UUnnddoo and RReeddoo buffers are cleared and any
changes that were previously applied to the design file cannot then be removed or re-applied
by these automated functions. Once the design is saved, the SSaavvee function in the menu will
become greyed-out until more changes have been made to the design.

The SSaavvee function assumes that the design has already been assigned a file name. If this is
not the case - for example in the situation where a design has been started from scratch - then
the SSaavvee AAss...... dialog will appear automatically to allow the design to be given a file name.

FFiillee >> SSaavvee AAss......
The SSaavvee AAss...... function is essentially the same as the SSaavvee
function except that it allows the user to specify a new file
name for the card design under which the design will be
stored.

This function is used when a new design is first saved or
when the user wishes to make a copy of an existing card
design under a different file name. 

When the SSaavvee AAss...... function is selected, the
Save As... dialog appears allowing the location
of the new file and the file name to be selected
and entered respectively.

The intended location of the file is selected by
means of the standard Windows navigation
toolbar at the top of the Save As... dialog. 
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Once the location has been selected, the new file name should be entered into the ‘File name’
textbox near the bottom of the dialog and the Save button clicked. This new file name should
be different to all other files in that directory unless the new file is to replace an earlier one. 

FFiillee -->> IImmppoorrtt FFrroomm
Allows you to directly overwrite an existing design by loading a pre-configured .cdl file from
disk.

Clicking the Import From option will bring up a dialog from where you can browse for the 
existing .cdl file.  When you select that file, the old design will be overwritten with the new 
contents as specified in the new file.

Once imported you will need to save your changes before they will take effect.

FFiillee -->> EExxppoorrtt TToo
Provides the same kind of functionality as the Import From mentioned above but instead of
loading the import file saves  it elsewhere.  

This provides a convenient method for transferring design files between ImageBase 
databases, or providing a method from which to extract any file to disk.
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TIP: If the file name that is entered already exists, a message box will be displayed warning of this and asking if the new file
should overwrite the one that is already stored. Selecting the YES button on the message box  replaces the old file with the new
one. Once a file is overwritten in this way the older file is irretrievable, so care must be taken whenever this message appears.

Also, if the card design has bitmap images on it and the design is being saved for the first time, a dialog will appear asking the
user if the bitmap images should be copied into the same location as the card design file. This allows all of the files associated
with a card design to be kept safely in one location on the disk drive.



FFiillee >> PPrriinntt......
The PPrriinntt function will send a card design to be printed on
any printer that is available to the PC that is running
ImageBase.  

This function may also be selected by pressing the <<CCttrrll>>
and PP keys simultaneously on the keyboard. 

Selecting Print causes the Print Card Design dialog box to
appear as shown below:

This dialog allows the number of copies of the
printed card design and the printer used to
print the copies to be selected. 

There is also the option for the printing to be
performed in “Sample Mode”. This checkbox,
when set, does not automatically increment any
serial numbers that are normally printed on

the cards. This ensures that new card serial numbers are only created for completed card
designs.

Printing may be directed to standard ink-jet or Laser printers to evaluate designs or to 
professional plastic-card printers for final card printing.

FFiillee >> SSeelleecctt PPrriinntteerr......

The SSeelleecctt PPrriinntteerr...... menu item allows the user to define
which card printer is to be used by default when 
printing cards. 

Selecting CChhoooossee PPrriinntteerr...... causes the Choose Card
Printer dialog to appear as shown below:

All of the printers that are currently installed on the PC on which ImageBase is running will be
listed in the Choose Card Printer list box. Any printer that is currently selected as the card
printer will be highlighted. 
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It should be noted that the default card printer is
not necessarily the one labelled as the ‘Default’
printer in the list – the word ‘Default’ in the list
refers to the Windows Default Printer which is 
typically a standard inkjet or laser printer.

The list of printers will, of course, depend on which
printing devices are connected to the PC and so will
not be the same as the list shown in the example
dialog on the left. 

To select which printer is to be used as the default one, the desired printer is highlighted by
clicking with the mouse before selecting the OOKK button.

Defining a default printer in this way is convenient when printing as the user can simply hit
the Print button without having to select the correct printer each time a card design is to be
printed.
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FFiillee >> PPaaggee SSeettuupp aanndd IInnffoorrmmaattiioonn......

This function is used to change the basic properties of a card design such as its size, number
of printed sides, background colour, orientation and any printing margins that may be 
applicable.

Selecting the PPaaggee SSeettuupp aanndd IInnffoorrmmaattiioonn...... menu option causes the following dialog to appear.
The dialog has four different ‘tabs’, each showing different settings that may be used to 
customise the card design:

GGeenneerraall TTaabb

The GGeenneerraall tab shows the basic size and printing
margin settings for the current card design. The card
width and height are displayed in millimetres and may
be changed directly by changing the figures in the
CCaarrdd WWiiddtthh and CCaarrdd HHeeiigghhtt display boxes.

The PPrriinntt LLeefftt OOffffsseett and PPrriinntt TToopp OOffffsseett values may
be edited in a similar fashion to offset the position of
the card on the printed media. These values allow the
printed design to be moved horizontally and/or 

vertically to align the printer output correctly on the printer’s media. For example, printing
onto a self-adhesive label rather than a plastic card may require that the offset is changed to
centre the card design on the label.

One other important feature on the General tab is the “2 sided design” checkbox. This 
checkbox determines whether both sides of the card are to be edited within the design window.
If this box is cleared, a single-sided design is selected and the “Back” tab on this dialog will be
disabled. If it is set, the card design area will show a Front and Back tab to allow editing of
both sides.

FFrroonntt TTaabb

The FFrroonntt tab allows the orientation of the card
design for the front side of the card to be set to either
Landscape or Portrait. 

LLaannddssccaappee orientation is with the longer side of the
card horizontal as is common with most credit card-
style designs.

PPoorrttrraaiitt orientation has the shortest side of the card
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horizontal. This format is often used for ID-card designs.

The FFiillll CCoolloouurr for the front side of the card may be set on this tab. The fill colour is effectively
a background colour for the card and is set to ‘transparent’ by default. Note that this is a
printed colour and not the colour of the plastic.

To change the fill colour, the CChhaannggee...... button beneath the Fill Colour box should be clicked to
display the standard Colour Selection dialog (covered in detail in the ‘Set Colour’ section on
page 49 of this manual).

Once a colour has been selected via the selection dialog, the Fill Colour box is changed to 
display the selected colour. The fill colours selected for the front and the back sides of the
card are totally independent.

BBaacckk TTaabb

The BBaacckk tab is only accessible if the “2 sided design”
checkbox is set on the GGeenneerraall tab (see previous
page). It allows the orientation of the card design to
be set to either Landscape or Portrait for the reverse
side of the card. 

LLaannddssccaappee orientation is with the longer side of the
card horizontal as is common with most credit card-
style designs.

PPoorrttrraaiitt orientation has the shortest side of the card horizontal. This format is often used for
ID-card designs.

The FFiillll CCoolloouurr for the back side of the card may be set on this tab. The fill colour is effectively
a background colour for the card and is set to ‘transparent’ by default. 

To change the fill colour, the CChhaannggee...... button beneath the Fill Colour box should be clicked to
display the standard Colour Selection dialog (covered in detail in the ‘Set Colour’ section on
page 49 of this manual).

Once a colour has been selected via the selection dialog, the Fill Colour box is changed to 
display the selected colour. The fill colours selected for the front and the back sides of the
card are totally independent.
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IInnffoo TTaabb

This tab displays information regarding the origins of
the card design. 

It shows the name and location of the current file, any
template that was used to create it as well as the date
and time that the file was originally created.

This information may be used to identify a specific
variant of a card design by means of the file name and
date/time of creation. 

FFiillee >> EExxiitt

The EExxiitt menu option is used to completely close the
design window. 

This function may also be selected by pressing the
<<AAlltt>> and FF44 keys simultaneously on the keyboard.
Note that FF44 is a single ‘function’ key located at the
top of most keyboards.

When the EExxiitt function is selected and there is a card
design in progress that has been changed, then the
user will be prompted to see if the work should be
saved before exiting. 
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FFiillee >>  <<lliisstt ooff mmoosstt rreecceennttllyy uusseedd ffiilleess>>

At the bottom of the File menu, a list of the most
recently-used files is shown. This list is often 
convenient as the user can open a particular card
design file with a single click of the mouse rather than
having to browse for the file using the FFiillee >> OOppeenn
dialog.

The list will display the last eight files used within
CardDesigner with the most recently used at the top of
the list and the rest in descending order of usage. 
The files are numbered from 1 to 8 in the list and
these numbers may be used as keyboard shortcuts to
open the files. For example, when the FFiillee menu has
been opened the ‘11’ key could be pressed to load the most recently used file instead of clicking
on it with 
the mouse.

TThhee EEddiitt mmeennuu

The EEddiitt menu contains many functions for manipulating the various
graphical and textual objects that go together to create a card design. 

Typical features of many standard Windows programs are found in this
menu such as the CCuutt, CCooppyy and PPaassttee clipboard functions as well as
more specialised functions that determine card serial numbers or 
control the multi-layering characteristics of CardDesigner.

There follows a complete guide to each function in the EEddiitt menu.

EEddiitt >> UUnnddoo <<aaccttiioonn>>

The UUnnddoo <<aaccttiioonn>> menu function allows the user to remove the
last change made to the card design. All changes right back to the
last time that a file was saved or originally loaded may be undone
one-by-one.
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This function may also be accessed from the keyboard by holding down the <<CCttrrll>> key and
pressing ZZ.

The text of the UUnnddoo menu function will change to give an indication of the last modification
that may be rescinded. For example, in the menu shown above, the last change made was an
object being resized. The menu entry automatically shows “Undo Resize” to reflect this. Every
change made to a card design since the last Save operation may be undone. The changes are
undone one-by-one in the reverse order of their implementation.

For most users, the convenience of using the UUnnddoo toolbar button will mean that this
menu option will not be the primary method of using the UUnnddoo function. The next

change to be undone may be seen by hovering the mouse cursor over the button until a
‘tooltip’ appears that shows similar information to that listed in the menu.

EEddiitt >> RReeddoo <<aaccttiioonn>>

The RReeddoo <<aaccttiioonn>> menu function allows the user to re-perform a
change that was previously removed by the UUnnddoo function. All
changes right up to the first time an UUnnddoo command was used may
be redone one-by-one provided that they are redone straight away. 

RReeddoo may also be accessed from the keyboard by holding down the <<CCttrrll>> key and pressing YY.

The text of the RReeddoo menu function will change to give an indication of the change that will be
re-done to the design if a RReeddoo is performed. For example, in the menu shown above, RReeddoo will
re-implement the movement of an object. The menu entry automatically shows “Redo Move” to
reflect this. Every UUnnddoo operation made to a card design may be re-implemented by the RReeddoo
function. The changes are re-done one-by-one in the reverse order of their previous removal.
For most users, the convenience of using the RReeddoo toolbar button will mean that this menu

option will not be the primary method of using the RReeddoo function. The next change to
be re-done may be seen by hovering the mouse cursor over the button until a ‘tooltip’

appears that shows similar information to that listed in the menu.
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NOTE: One limitation of the Redo function is that it can only redo an operation if no other operation has be carried-out on the
card design. For example, the user may redo an Undo that was only just carried out. However, if that Undo operation was carried
out and then the colour of a box was changed, the Undo could not be redone again because the previous Undo has been 
committed to the design by the performing of the new operation.



EEddiitt >> DDuupplliiccaattee

The DDuupplliiccaattee function is used to create identical copies of an
object on a card design. This feature is effectively a combination
of the CCooppyy and PPaassttee functions combined into a single command
for convenience. One other advantage that the DDuupplliiccaattee function
has is that it does not overwrite the contents of the Windows 
clipboard. 

DDuupplliiccaattee can also be performed by using the keyboard shortcut <<CCttrrll>> DD.

For the DDuupplliiccaattee function to be activated, there must be at least one object on the design that
has been selected (see page 69 for details on selecting objects). If no objects have been 
selected then the DDuupplliiccaattee function will appear greyed-out in the menu and will be disabled.

Having selected an object and then duplicated it, the card design window will appear
unchanged because the new duplicate object has been positioned in exactly the same position
as the original object and is now on top of the original and is automatically selected. To use the
new duplicated object, it should be moved to its intended position. The original object will then
be seen when the duplicate has been moved away from it.

EEddiitt >> CCuutt

The CCuutt function is used to copy a selected object (or objects) to
the Windows clipboard and then delete that object from the
design. The object(s) may then be pasted from the Windows 
clipboard to another card design window.

CCuutt may also be performed by using the standard Windows 
keyboard shortcut <<CCttrrll>> XX.

The CCuutt function will be disabled and will appear greyed-out in the menu if there is no object
currently selected on the card design (see page 69 for details on selecting objects).

EEddiitt >> CCooppyy

The CCooppyy function places a copy of a selected object onto the
Windows clipboard. The object may then be pasted from the
Windows clipboard to another card design window.

CCooppyy may also be performed by using the standard Windows 
keyboard shortcut <<CCttrrll>> CC.
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The CCooppyy function will be disabled and will appear greyed-out in the menu if there is no object
currently selected on the card design (see page 69 for details on selecting objects).

EEddiitt >> PPaassttee

If an object has previously been copied to the Windows clipboard
by using the CCuutt or CCooppyy functions, then the PPaassttee function will
be enabled. 

When used, PPaassttee places a copy of the object that is in the 
clipboard directly onto the card design.

PPaassttee may also be performed by using the standard Windows
keyboard shortcut <<CCttrrll>> VV.

EEddiitt >> DDeelleettee

The DDeelleettee function removes any previously selected object from
the current card design.  If multiple objects are selected, then all
of them will be deleted when DDeelleettee is selected. 

The keyboard shortcut for DDeelleettee is the DDeell key.

Once deleted, objects may be restored by use of the UUnnddoo feature
which is described on page 63).

EEddiitt >> SSeelleecctt AAllll

The SSeelleecctt AAllll function highlights all objects currently placed on
a card design so that they may all be cut, copied, deleted or
moved at the same time on the current side of the card design.

Select All may also be performed by using the standard Windows
keyboard shortcut of <<CCttrrll>> AA.

103



EEddiitt >> PPrreecciissee CCoonnttrrooll

The PPrreecciissee CCoonnttrrooll function allows any currently selected object to
have their size and position changed quickly.

PPrreecciissee CCoonnttrrooll is always accessible if at least one object is selected
and may be initiated either from the EEddiitt menu or by pressing the XX
key on the keyboard.

When PPrreecciissee CCoonnttrrooll is initiated, a dialog appears. This dialog has
two tabs that are used to change the object – one for position and
one for size.

TThhee PPoossiittiioonn ttaabb

The PPoossiittiioonn tab allows the user to specify the location of the current selection in several ways.
First of all, the location of the selection may be measured in Relative or Absolute 
measurements. 

RReellaattiivvee mmeeaassuurreemmeennttss are used when the object 
concerned needs to be moved from its current position
by a known measurement. This allows changes like 
moving an object 2mm to the right very easy. The 
relative changes are simply entered into the X and Y
boxes in positive or negative format. 

Since XX is horizontal movement, a negative X value
moves the object to the left, a positive value moves it to
the right. 

Similarly in the YY direction (vertical) a negative value moves the object upwards and a positive
one moves it down.

AAbbssoolluuttee mmeeaassuurreemmeennttss measure the location of the object with respect to the lop-left of the
card (at position 0mm x 0mm on the rulers). Using this method of specifying an object’s 
location is useful if the exact position that the object should have is known.

All absolute measurements should be entered as positive values otherwise the object will be
positioned either partially or completely off the card design area.
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A “QQuuiicckk PPoossiittiioonn CChhaannggeess” list is provided so that pre-set locations on the card design may be
used to align objects with a single selection. The preset alignments are:

Left edge of design
Right edge of design
Top edge of design
Bottom edge of design
Centre horizontally
Centre vertically
Centre

As each Quick Position Change item is selected, the new position that the object would take is
shown in numerical format in the XX and YY boxes with the values either relative or absolute
depending upon the current positioning setting.

TThhee SSiizzee ttaabb

The SSiizzee tab allows the user to specify the dimensions
of the current selection in several ways. First of all, as
with the location, the size of the selected object may be
changed using Relative or Absolute measurements. 

RReellaattiivvee sizing allows the size of the object to be
changed by simply adding or subtracting from the XX
(horizontal) or YY (vertical) dimensions of the object. For
instance, an entry of  -5 in the WWiiddtthh box will decrease
the width of an object by 5mm from its present value.

If the value entered attempts to set a negative value for width or height, a message will notify
the user that the value entered was not valid.

Selecting the AAbbssoolluuttee sizing method immediately displays the current dimensions of the
selected object in the Width and Height boxes. If the size that the object should be is known,
then it may be entered directly in those two boxes. Again, any negative values for width or
height are not accepted.
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A “QQuuiicckk SSiizzee CChhaannggeess” list is provided so that pre-set size changes may be applied to objects
with a single selection. The preset size changes are:

50%
150%
200%
Design Width
Design Height
Design Full Area

As each Quick Size Change item is selected, the new size that the object would have is shown in
numerical format in the XX and YY boxes with the values either relative or absolute depending
upon the current setting.

EEddiitt >> SSnnaapp ttoo GGrriidd

To aid in positioning objects on the card design, the SSnnaapp TToo GGrriidd
function has been provided. When this function is selected, all
objects placed onto the design will automatically have their centres
aligned to a 1mm pitch grid. All previously-positioned objects will
remain in their existing  alignments unless they are moved or
resized after the SSnnaapp TToo GGrriidd has been selected.

When this option has been selected, a ‘tick’ will appear next to the
menu item (as shown in the image to the right) showing that SSnnaapp
ttoo GGrriidd is active. The SSnnaapp ttoo GGrriidd button on the main toolbar will
also be shown in the ‘down’ position when SSnnaapp ttoo GGrriidd is active.

SSnnaapp ttoo GGrriidd is also selectable by pressing the FF22 function key on the keyboard. 
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TIP: Multiple objects may be selected and any increase in size will be
implemented on all of the objects in relation to their sizes. 

Also, if an object is set to be ‘proportional’, then the resize may not appear
as was expected.



EEddiitt >> SSeerriiaall NNuummbbeerr......

The SSeerriiaall NNuummbbeerr...... function allows each card to have its own
unique number based on a format that the user can select. 

The serial number that is configured does not just apply to the one
card, but defines a sequence of serial numbers that will apply to all
cards printed from the current design. 

This allows just a single card design to produce printed cards with
sequential serial numbers without having to manually change the
card design for each new number.

When selected, a dialog box appears to allow the serial number to
be fully defined:

Three entries are available to create the
base and format of the serial number
sequence as well as the increment between
each number.

Using these settings, the serial number may
be set to most commonly used styles.

NNeexxtt SSeerriiaall NNuummbbeerr This is the next value to be used in the sequence of serial 
numbers. 

IInnccrreemmeenntt This is the value which is added to each successive serial number
to produce the next in the sequence. For example, with a Next
Serial Number value of ‘1’, an increment of 1 will produce serial
numbers 1, 2, 3, etc. A value of 5 will give serial numbers  1, 6, 11,
16, etc.

PPaatttteerrnn The pattern forces the serial number to be a particular number
of digits for uniformity. For example, the pattern value 00000
would force the serial numbers to be 00001, 00002, etc. Letters
and decimal points may also be used to further customise the
format.
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To place the serial number on the card design, a text object with the value  [[sseerriiaallnnuummbbeerr]]
should be added. When printed, the cards will have sequential serial numbers.

When printing cards, it is possible to stop the serial numbers from being incremented if
required by setting the “Sample Mode” checkbox on the PPrriinntt dialog. Further details of the
print dialog may be found on page 95.

EEddiitt >> LLaayyeerrss......

The LLaayyeerrss...... function allows the properties of the different layers
of the card design to be configured. 

Each layer has three properties that are turned on or off by setting
or clearing the respective checkboxes.  Each one may be LLoocckkeedd,
VViissiibbllee and/or PPrriinnttaabbllee. 

A list of all of the available layers is provided in the dialog that
appears when the LLaayyeerrss...... function is selected. Each layer may be
individually selected in the list to display the current property 
settings for that layer. There are eleven layers in total with the
Non-Printable layer at the bottom and layer 10 at the top. 

By default, all layers except the NNoonn PPrriinnttaabbllee layer are set to be
nnoott LLoocckkeedd, VViissiibbllee and PPrriinnttaabbllee.

The NNoonn PPrriinnttaabbllee layer is set to be LLoocckkeedd, VViissiibbllee and nnoott PPrriinnttaabbllee by default.

A LLoocckkeedd layer does not allow changes to be
made on any objects that are placed on the
layer. This includes changes to size, position or
to the objects themselves. More importantly,
the objects cannot be selected when they are
on a locked layer – this is particularly useful
to prevent background objects from 
interfering with the selection of objects in the
foreground.

New objects may be assigned to a locked layer,
but the layer must be first unlocked to allow
any objects to be removed. 
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The VViissiibbllee checkbox allows entire layers of objects to be hidden from view within card d
esigner. The objects on layers that are not visible still exist and will be printed as normal 
provided that the layer is still set to be Printable.

This feature is useful for particularly detailed card designs where entire layers may be made
invisible to allow the user to see other objects on other layers more clearly.

The PPrriinnttaabbllee checkbox relates to what information will be seen when a card is printed.

All objects on a layer that is set to be pprriinnttaabbllee will be output when a card is printed.  
Non-printable layers do not appear on a printed card at all. 

Setting a layer so that it is not printable is useful if design notes or template guidelines need
to be placed on the card design, but are not wanted on the printed cards. One application of
this is the black magnetic stripe shown on the “MMaaggnneettiicc SSttrriippee –– 22 SSiiddeess” template used in the
example in the Getting Started section of this manual on page 91. 

A detailed description of Layers and their uses can be found on page 73 of this manual.

TThhee VViieeww mmeennuu
The VViieeww menu contains several functions that affect how the card
design area appears.

The VViieeww menu ma1y be activated by pressing the key combination
of <<AAlltt>> VV.

There follows a complete guide to each function in the VViieeww menu.

VViieeww >> RReeffrreesshh

The RReeffrreesshh function is provided to allow the card design area to
be re-drawn on the screen if the need arises. 

Sometimes, items displayed on the card design area may have been
modified outside of the ImageBase – for example an image or 
company logo may have been changed by an image editing program
while ImageBase was running with the card design loaded and visible on screen. 

Another common reason for refreshing the card design area is for when a new record has
been selected from the ImageBase Main Record View and the data fields displayed on the card
design need to be refreshed to display the new data.
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If that has happened, the image or logo shown on the card design will be the older, unmodified
one. The RReeffrreesshh function has been provided to ‘refresh’ the content of the card design and
display any changes made to the objects on it. Using RReeffrreesshh ensures that all displayed objects
are representative of the current versions.

This function may be performed at any time by hitting the FF55 function key on the keyboard.

VViieeww >> GGrriidd

The GGrriidd function toggles whether or not a fine, visible grid
appears in the card design area. Having a grid on the design area
is often useful when positioning and aligning objects on a card
design.

The grid may also be toggled on and off using the keyboard 
shortcut of <<CCttrrll>>GG.

Using the grid simply provides a reference for the designer – it does not affect the card
design at all and can be turned on and off at will. In addition, the grid will not appear on any
printed cards whether it is currently on or off.

To aid in positioning objects on the card design, the SSnnaapp TToo GGrriidd function has also been 
provided to force objects to align on the same grid points. (SSnnaapp TToo GGrriidd is accessible from the
EEddiitt menu and is described in full on page 68).

VViieeww >> OObbjjeecctt LLiisstt......

On a card design, there may be Several Layers of objects overlap-
ping, this function allows the user to select an object easily. 

Once selected a window will appear listings the type of placed objects
within the design, position, size and a short description. Just simply
tick or untick the objects from the list that you wish to select.
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PPrrooggrraamm MMeennuu RReeffeerreennccee__IImmaaggeeBBaassee MMeennuu SSttrruuccttuurree

To aid the user in understanding the functions of the ImageBase program, the following 
section will describe each menu option individually. 

Main menu sections (the FFiillee, VViieeww, RReeppoorrtt, AAddmmiinn, WWiinnddooww and HHeellpp headings) will be shown
before each sub-menu to help identify where the particular sub-menu is located. This will be
shown in the form  ((MMaaiinn mmeennuu)) >> ((ssuubb--mmeennuu)) in the sections below. 

One example of this notation would be:

AAddmmiinn >> DDaattaabbaassee DDeeffiinniittiioonn……

which would require the user to first click on the “AAddmmiinn” menu then on the “DDaattaabbaassee
DDeeffiinniittiioonn……” sub-menu item as shown in the picture to the right.

CCoonntteexxtt--ddeeppeennddeenntt mmeennuuss
The ImageBase program menu is ‘context dependent’. This context dependant behaviour has
been put in place to simplify the menu structure for the user by presenting only those 
functions that are currently available for use within the program at that particular time. 

In the case of ImageBase, this means primarily that the menu changes its content and 
structure dependent upon whether there is a database currently opened or not.

Certain functions, such as DDaattaabbaassee DDeeffiinniittiioonn…… for example, are only available for use when
there is no open database (this is to avoid corrupting a database that is currently being used)
and conversely, the VViieeww and RReeppoorrtt creation menus are hidden when there is no database
open because these functions require a database to operate on.Functions that are currently
unavailable will either be greyed-out or missing from the menu structure.
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TIP: Where an underlined character can be seen in the dropdown menu items, this indicates that a keyboard shortcut is avail-
able to call that item directly without using the menu. For main menu items, hold down the Alt key and hit the appropriate letter
key. For sub-menu items, press the  appropriate letter key.

Sometimes the shortcut keys are listed after the menu items as can be seen in the above image where the user may hit the F12
function key to select the Database Definition… function.



FFiillee MMeennuu
The File menu may be accessed by either clicking on the FFiillee menu header or by holding down
the AAlltt key and hitting ‘FF’.

This menu is concerned with the control of database files, data import from other databases,
printer selection, user access and image acquisition. It also shows a list of the Most Recently
Used databases that were accessed by the program.

FFiillee  >> OOppeenn DDaattaabbaassee……  
To select and open a database for use within the
ImageBase program, the user should select the File
menu then click on Open Database. 

You should already be aware of what type of 
database it is that you wish to open.  The following
dialog will appear from which you can select the
database type.  From there the database specific
open dialog will appear.

For more specific information Database Types, see
AAppppeennddiixx BB –– DDaattaabbaassee TTyyppeess on page 174.
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FFiillee >> CClloossee DDaattaabbaassee
This option is only available when there is a database already open within the program. 
When selected, the current database is closed and the Main Record View pane disappears
along with any supporting windows such as the People Picker etc.

After a couple of seconds the Welcome screen will appear from where recently opened 
databases can be accessed.

FFiillee  >> IImmppoorrtt DDaattaa……
This option is only available when there is a database already open within ImageBase.
It allows the user to add records from another data source into the currently opened
ImageBase database. 

To Import Data you must first create some Import settings so that ImageBase knows how to
import the data and convert it into a readable format.

Select the Import Data option.  The following dialog below should be displayed.  If you have
imported data before any saved settings will show in the list.  In the image below, there is one
saved Import Setting called myData.

CCrreeaattee tthhee IImmppoorrtt SSeettttiinnggss
Click on the New… button to load the Import Settings dialog.  ImageBase can import from all
database formats (as support by ImageBase only), so you must first determine which format
you wish to import from.

After selecting the data source from which you will import from, the following dialog appears. 
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Within this dialog are 3 tabs.  These tabs will be used in configuring the information required
to Import from the data source.

SSoouurrccee TTaabbllee oorr VViieeww::

This tab shows the data sources from where you can import from.  If you have imported data
before, these will appear in this list along with your newly specified import source.

You must select the name of your import source before attempting to configuring the rest of
the settings to ensure the correct information is imported.

In the case above we have selected the ImageBaseData#csv which represents a CSV Import
Source of ImageBaseData.csv (the dot has been replaced with a # for ImageBase compatibility).
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and can be ignored.



UUnniiqquuee KKeeyy::

The list of names shown above (Bus_Unit, Ext etc) indicate the columns in the source data as
being available for importing.

In this dialog, you should specify if any of the fields are unique, so that if the record exists the
data is added to that record, rather than added as a new entry (to avoid duplicate data entries
in subsequent imports)

Adds the currently selected field to the Unique Key list.

Removes the currently selected Unique Key from the list.

Does a test of the source data to ensure the Keys specified
in the Unique Key list are in fact  unique.

For instance, it may be beneficial to Import using a field that contains a company payroll number as every
instance would be unique.  This would mean that only genuinely duplicate records (ones with details on
the same person, not just with the same ID number) would be overwritten. Of course, this would only work
if the payroll number field was used in both the target and the currently open ImageBase database. 
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DDaattaa MMaappppiinngg

This tab allows you to map fields between the source data and the ImageBase database so that
any imported data is placed in the correct ImageBase fields.  

The fields stored in the ImageBase table are identified in the grey area (shown above) down
the left side of the screen.  The source data fields are available as a list next to each
ImageBase field.  You can use this list to select the data you wish to have mapped to the 
relevant ImageBase field.

In the example above, the following fields are available and mapped for this Import.

If a required field from the source data is not required to be imported, do not map that field to
an ImageBase field (as shown above). 
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IImmaaggeeBBaassee FFiieelldd MMaappppeedd ffiieellddss ffrroomm ddaattaa ssoouurrccee
Forename Forename
Surname Surname
Bus_Unit Bus_Unit
Ext Ext



Normally, the user will not wish to merge the IIDD fields between data sources because the IIDD
field is not determinable by the user and so may cause undesirable merge effects. In the case
above, the ID field within the ImageBase database is an Auto-Increment field so cannot be
mapped.  When a new record is created, this value will instead be given a new value.  

If you wanted to import the ID field from the source table, you would have to create a new field
in the database of type IInntteeggeerr to specifically map the source ID to.

In this way, each import field will be given an ImageBase field to place the data into. 

SSaavviinngg aanndd IImmppoorrtt sseettttiinnggss
Once configuration of the Import settings is complete you must save the settings before run-
ning the Import.

To do this, click the save button located down the bottom right of the screen.  When prompted
for a name to save as, assign something relevant to the source data.

If the Import settings are valid you will notice the Valid column (shown below) now contains a
Yes.  If there is a No here, then you cannot import the data until the problem is resolved.
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CCAAUUTTIIOONN!! Importing records from other databases is a one-way process and if a mistake is made by the
user, there is no easy way to separate the original records from the newly merged ones, short of manually delet-
ing the unwanted ones one-by-one. 

For this reason, it is wise to exit the program and make a full backup of all ImageBase database files before per-
forming any database imports.

NNoottee:: The entire contents of the database to be imported will be added to the currently open one using the
Unique Field as the comparison to see where the data goes. Any duplicate records will be overwritten resulting in
a fully merged database. If a Unique Field is not selected in the target database, then the records will simply be
added and none overwritten (This could lead to duplicate record entries).



RRuunnnniinngg tthhee RReeppoorrtt
To start the Import process, click the Import button shown on the bottom right of the screen.

ImageBase now attempts to query the data source and identify the validity of the content.

Once this is complete, three tabbed windows will appear that shows the correlation between
the data being imported and the current database.
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NNoottee:: No information is imported until the Update button is pressed.



TThhee TTaabbss::
NNeeww RReeccoorrddss: This identifies the imported data records that have not been matched up to
existing records in the ImageBase database.  Records appearing in this tab will be created and
added to your existing database.

EExxiissttiinngg RReeccoorrddss: Identifies records that currently exist in the database and will be overwrit-
ten by the Import.

UUnnmmaattcchheedd RReeccoorrddss: Identifies existing records in the database that do not appear in the
data to be imported and will be unaffected.

UUppddaattee::
Once you are happy with the data to be imported, click the Update button to complete the
import process and update your ImageBase database.
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FFiillee  >> IImmaaggee BBaattcchh IImmppoorrtt……
The Batch Image Import function is a feature available to allow large batches of images to be
added to database records with a minimum of time and effort. 

The Batch Image Import requires that the filenames of the images to be imported uniquely
match the contents a current ImageBase field. 

The tool scans the specified field
and where a file name matches
the contents of the field, the
image is added to that record.
The imported image can then be
moved, deleted or left as is.

In the example shown in the
image to the right, the Surname
field has been specified as the
Unique field. 

This is fine for the purposes of
giving a clear example of how the
field type and the filenames are
linked.  However in practice the
Surname field would not be a
good choice for Batch Image
Imports because Surnames are
not necessarily unique for each
person in the database.  

A much more practical field would be one where the contents are definitely unique such as a
payroll or personnel number. The images for each person should then be saved using the per-
son’s payroll or personnel number as the file name.

IImmppoorrtt LLooccaattiioonn: You can use this to browse for the directory where your images are 
located.  To browse, click on the folder icon            located next to the drop down box.

PPeeooppllee PPiicckkeerr TTaabbllee NNaammee: When you import an image you may wish to automatically
locate those records created or changed.  This may be because you wish to immediately print
cards, or simply to go through and ensure the details are correct.

By automatically adding each record to the People Picker, you can accomplish this.  
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However, if this is not a problem, you can remove this functionality by clicking on the ticks
shown in the image above.  This will ensure no people picker list is created on Image Import.
For more information on the People Picker read page 125

The name given to the People Picker list is identified
in the text box.  In this case it would be Thu 10 Nov 05
at 12:49.  If you wish to assign a more relevant name
for better reference, simply click in this box and
change the details.

UUnniiqquuee FFiieelldd:  This identifies what field in the database is used to match up the images
being imported. 

DDeessttiinnaattiioonn IImmaaggee FFiieelldd: If you have more than one Image field in the database, then
this identifies which field to insert the data into.

GGeenneerraall SSeettttiinnggss: There are a number
of options available for use when importing
data.  These options typically relate to the
Image being imported and are shown 
opposite.  

IImmppoorrttiinngg tthhee IImmaaggeess
Click the OK button located at the top right of the dialog to initiate the import process.  Because images
can be quite large and may be spread over a network, this may take a while.

FFiillee  >> SSeelleecctt PPrriinntteerr……
This selection allows the user to select the printer that will
be used to print any ID cards from ImageBase. 
The following dialog is displayed which will allow selection
of the correct printer:

Only printers that have been installed into Windows prior
to operation of ImageBase   will be listed in this dialog.
Many devices which are considered by Windows to be types
of printers, such as faxes or software utilities, may also be
listed alongside any real printers as is the case in the
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NNoottee:: :  If you select the Move images to this
location, you must specify a valid disk location
using the box below.



image above.

Alternatively to select the printer for output, click on the printer option in the bottom right of
status bar.

PPrroodduucctt PPrreevviieewwss:: The Produce Previews checkbox should be selected if a preview of the card
to be printed is required to be shown before printing occurs. This is useful when testing a new
card layout with real data from the database.

FFiillee >> SSeelleecctt TTWWAAIINN SSoouurrccee……
‘TWAIN’ is a standard for reading image data from scanning or image capture equipment. If
the PC which ImageBase is installed on has a scanner or image capture device that is TWAIN
compatible, it can be set as the default TWAIN source allowing ImageBase to capture images
directly from it.

Selecting this function results in the following dialog. Note that the dialog contents will likely
vary depending upon what items of equipment are available on the ImageBase PC:

In the above instance, a standard Epson scanner is installed and two different TWAIN 
interfaces are available for using it. To select a specific source, simply click on the desired one
and click on the SSeelleecctt button.

If no suitable TWAIN sources are available on the ImageBase PC, the SSoouurrcceess list-box will be
empty.

FFiillee >>SSeett PPaasssswwoorrdd ffoorr ((uusseerrnnaammee))……
This function is linked to the UUsseerr AAccccoouunnttss…… section of the program which is accessible via the
AAddmmiinn menu. In UUsseerr AAccccoouunnttss…… it is possible to assign user names and passwords for those
users to ensure that only authorised personnel have access to the data within the database.

If a user has logged-in to the ImageBase program, they may change their password using the
SSeett PPaasssswwoorrdd ffoorr <<uusseerrnnaammee>>…… operation. When it is selected, the following dialog is shown:
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In this example, the user ‘rob’ is asked to type a password into the left-hand box and press the
‘enter’ key. Because the password is obscured for security reasons, the user is requested to
re-type the password into the right-hand box to v23erify that the password was typed correctly
the first time. 

It should be noted that passwords are ‘case dependant’. This means that upper-case letters
are considered to be different to lower-case ones.  The password “theword” is therefore nnoott
the same as ‘TheWord’.

If the two new passwords match, then a message will pop-up confirming that the password has
been changed. If the passwords do not match, then the option will be given to retry entering
them or to cancel the operation, leaving the password unchanged. 

FFiillee >> SSeett ((uusseerrnnaammee)) aass tthhee DDeeffaauulltt UUsseerr
When this menu option is selected, the user who is currently logged into the ImageBase soft-
ware is set to be the default user. The following confirmation pops-up after selection showing
the username that was selected to be the default. In this case the user logged-in was ‘rob’:

Now, whenever the ImageBase software is started up, the username ‘rob’ will automatically
appear in the password request box to save the user having to type the username in. They
then are just required to type in their password.

If no password (or a blank password) is set up for the default user, the ImageBase program
will automatically bypass the password request box and go straight into the program. This is,
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of course, only suitable for situations where the data in the ImageBase database does not
need to be protected from unauthorised access.

FFiillee  >> SSeett ((DDaattaabbaassee)) aass tthhee ddeeffaauulltt ddaattaabbaassee..
Using this option allows the application to automatically load a desired database when it is
started.

This can help when ImageBase is used to only access one database, bypassing the need to
select your database each time ImageBase is started.

If no database is loaded the menu option reverts to ‘Set no Database as default’ allowing the
default to be turned off.

FFiillee  >> EExxiitt  ((AAlltt ++ FF44))
This option closes the ImageBase software immediately. No data will be lost when exiting as all
changes made to the database within ImageBase are saved automatically during the operation
of the program.

FFiillee >> ((MMRRUU lliisstt ooff ddaattaabbaasseess))
Located at the bottom of the FFiillee menu, the Most Recently Used file list (or MMRRUU list) is a useful
shortcut that displays a list of the last databases that were accessed by ImageBase. 

Selecting one of these Most recently
used databases opens it without having
to use the OOppeenn DDaattaabbaassee…… dialog to
load the database manually. If the entry
is greyed-out, this is because the 
database can no longer be found at
that location.
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VViieeww MMeennuu

The View menu may be accessed by either clicking on the VViieeww
menu header or by holding down the AAlltt key and hitting ‘VV’.

This menu provides access to:

People Picker
Scan and Slice
Batch Image Enhance
Print Station
Card Designer
Archived Records
Notes

VViieeww >> PPeeooppllee PPiicckkeerr

The PPeeooppllee PPiicckkeerr is a very useful utility within ImageBase that allows the user to create a separate list
of records from those within the currently open database.  This list can then be used to print cards or
create printed reports to a standard paper printer.

FFeeaattuurreess ooff tthhee PPeeooppllee PPiicckkeerr

-The People Picker record 
list may be ‘pruned’ by selecting one of
the records and clicking the RReemmoovvee
button

-The People Picker list can be
cleared by clicking on the RReemmoovvee AAllll
button.

-The current list of entries in
the People Picker may be saved to disk
by clicking on the SSaavvee…… button.  The
dialog shown below appears when
SSaavvee…… is pressed.

-You can add all the records
in the people picker to the Batch
Enhance queue giving the ability to
quickly go through each image and
adjust quality as required.
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-To save the list, simply enter a file name into the New Name box (or select an existing one to
overwrite the file) and click on the OOKK button.  In the image above, the current People Picker
list will be saved as ‘Print Later’.

-Any saved ‘pick lists’ may be retrieved by selecting the LLooaadd…… button.  This will display a 
dialog showing a list of all the pick lists that were saved previously.  Simply select a file name 
from the list and click on the OOKK to load that list into the People Picker.

-The MMaannaaggee…… button allows the user to rename or delete any saved ‘pick lists’ that are 
shown in the dialog.

To delete a saved list, click once on the name to be deleted, then hit the DDeelleettee button.

To rename a particular saved list, click on the desired name to highlight it, then click on the
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RReennaammee button.  The dialog shown in the image below will then appear allowing the user to
enter a new name.  Clicking OOKK will then implement the change.

At the bottom of the People Picker are the CCaarrdd LLaayyoouutt selector and the PPrriinntt CCaarrddss and PPrriinntt RReeppoorrtt
buttons.

The Card Layout allows the style of ID card to be selected for the current list of records in the People
Picker.  When the Print Cards button is then clicked, ID cards of that style will be produced from the
records.

The PPrriinntt RReeppoorrtt…… button causes the Print Report
Options dialog to appear.  This dialog allows the user to
specify the title, orientation of the report (portrait or
landscape), whether it has page numbers and also the
Card Design to be used.

The BBaacckkggrroouunndd tab allows the user to select the 
background design used for the report and the margin
widths.

VViieeww >> SSccaann aanndd SSlliiccee
The Scan and Slice utility provides the ability to take a People Picker list and a large scanned image 
containing multiple images. This allows you to place photographs on the bed of a scanner; make one scan
and then chop up the resulting image.

For more information read the section Workflow on Page 51.
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VViieeww >> BBaattcchh IImmaaggee EEnnhhaannccee
Adjusting image quality may be am important factor when using the ImageBase software.  To adjust 
multiple images quickly and efficiently the Batch Image Enhance tool is available.

For more information read the section Workflow on Page 53.

VViieeww >> PPrriinntt SSttaattiioonn
When images have been made ready for printing the print station can manage the printing of cards.

For more information read the section Workflow on Page 53.

VViieeww >> AArrcchhiivveedd RReeccoorrddss
Archived records provide the ability to temporarily delete records from the system with the ability for
retrieval at a later date if necessary.  

Clicking on this option will return a record list containing all the currently archived records.  A new
Record View will appear with the title AArrcchhiivveedd RReeccoorrddss as shown below.

Because the records shown in this view are archived, most options will be disabled when the Archive view
is active.  
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Options available in this mode include:

DDee--AAccttiivvaattee:: Replaces the EEddiitt RReeccoorrdd button. Clicking on this will re-instate the archived 
record back into the Main Record View available for printing and editing.

RReeffrreesshh:: Exists as per the Main Record View.  Clicking this button will reload the Archived 
record list.

PPeeooppllee PPiicckkeerr:: Loads the People Picker view.  For more information read the PPeeooppllee PPiicckkeerr
section on page 125

VViieeww >> NNootteess

The Notes utility allows general text notes to be associated with a database.  Simply open the Notes 
window by selecting it from the menu and type freely within it.

This facility can be used for any purpose that the user desires.  For example, notes may be made about
major modifications to the database content, or they may simply be reminders for things to be done with
the database etc.
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RReeppoorrtt MMeennuu

RReeppoorrtt >> CCaarrdd PPrriinntt LLooggss

The CCaarrdd PPrriinntt LLooggss menu option has a sub-menu with two ways to view card print logs. The
logs are historical listings of records
that have had cards printed for them. 

In this way, the date and time of issue
and type of card issued to each 
person in the database can be found
and checked.

The CCoommpplleettee LLoogg function shows a list of all records that have had cards printed for this 
database:

The titles at the top of each column (Submitted, Design, Record Info and Record ID) may be
clicked to re-format the report by arranging the records in that column in numerical or 
alphabetical (for a text entry) order.  This allows the user to view which people had cards 
printed most recently or simply to group the record information so that each person’s card
printing records are shown sequentially. For example, in the image above, the Record Info 
column shows that a total of three cards have been issued to Cathy Parker.
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AAddddiinngg CCuussttoomm CCoolluummnnss
Most ImageBase database fields containing text, can be added to the print log.  This is done
via the Database Definition, and is configured in the fields settings under “Include in Print
Log”.  For more information read the DDaattaabbaassee DDeeffiinniittiioonn section on page 130

SSeettttiinngg DDaattee RRaannggeess
Selecting the date range allows for the card print log to be further narrowed, providing a 
better display of card print activity for any one period.

DDeetteerrmmiinniinngg hhooww mmaannyy pprriinnttss hhaavvee ooccccuurrrreedd
Rather than counting the entire print log by hand, you retrieve this information by clicking the
CCoouunntt button located at the bottom right of the screen.  However, if the results have been 
filtered, the count only takes into account the filtered records.

CCooppyyiinngg tthhee ddaattaa ffoorr pprriinnttiinngg
Rather than print directly from the card print log, you can copy the data to a clipboard then
create a document from this data.

To do this follow these steps:

1) Click the copy button
2) Create a new text document and name it accordingly ie. myData.txt
3) Paste the data into the text document.
4) Rename the text document with the file extension .html instead of .txt

When you open this up, the card print log data should be nicely formatted and available for
printing via any web browser.

SSppeeeeddiinngg uupp tthhee qquueerryyiinngg
Because there can at times be thousands of recorded card prints, it may not always be 
efficient to query back the entire log, when you only want a small subset of data.  You can limit
the amount of records returned at any one time by changing the Records drop down combo.
The default number of records returned is 100.

RReeppoorrtt >> CCaarrdd PPrriinntt LLoogg >> CCuurrrreenntt RReeccoorrdd
The Current Record function in the Card Print Logs sub-menu displays the card print log for
the record currently displayed in the Current Record Pane. This saves having to scroll through
a very large log file to find the person whom the user wishes to check upon.
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RReeppoorrtt >> CCaarrdd EExxppiirryy
The Card Expiry reports are only available when there is 1 Card Expiry field within the database.  The
standard reports only work with the first Card Expiry field within the database so if there are more, a
custom Query would need to be built (see Query Builder on page 133).

> AAllrreeaaddyy EExxppiirreedd:: Returns all records where the expiry date is less than or equal to the current
date.
> EExxppiirree tthhiiss MMoonntthh:: Returns all records that will be expiring in the current month.

> EExxppiirree....:: This option provides the ability to set the start and end ranges for an expiry period.  To do
this, click on the start date in the left date picker (as shown below) and the end date in the right date
picker).  Then click ok to run the query.

In this example the expired records that would be returned would include:

-All records with an Expiry Date between 7th July 2005 incl and 1st October 2005 incl.

RReeppoorrtt >> RReeccoorrddss WWiitthh NNoo IImmaaggee
This function searches the database to find which records have not yet been issued with an
image. This is a useful facility when adding images into the database. It allows the user to see
clearly which people need to have their images added without having to search record-by-
record through the entire database. 

The resulting list of records is presented to the user within a new window similar to the Main
Record View, but with just the records without images listed in it. The full range of features of
the Main Record View are available for use on this sub-set of the database. 
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To add images to these records, the user should right-click on the blank image box..  Then
select the method by which to obtain the image, either by scanning, loading from file, or 
capturing via camera.

RReeppoorrtt >> QQuueerryy BBuuiillddeerr
The query builder is a powerful tool that allows complex searches of the database to be 
performed. It uses logical comparisons on multiple fields in order to find particular groups of
records that are of interest.
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When the Query Builder tool is selected, the dialog shown above appears. This will show all of
the fields in the current database listed in the FFiieellddss box on the left of the dialog. 

DDeeffiinniinngg wwhhaatt ffiieellddss aarree rreettuurrnneedd iinn tthhee qquueerryy
The query that is to be constructed will search through one or several fields within the 
database using search criteria and return a list of record matches. It is possible to specify the
fields that are to be returned from the query – for instance, just the Surnames of people could
be returned or the user may wish to see both Surname and Company Payroll number in the
results. 

To do this, simply click on the black box in the Fields list to insert a tick.  In the example above,
the Id field is the only field at present to be returned in the query.

Adds all fields to be returned in the query.

SSppeecciiffyyiinngg tthhee oorrddeerr ffiieellddss aarree rreettuurrnneedd iinn

Each of the three drop-down boxes for the FFiirrsstt, SSeeccoonndd and TThhiirrdd SSoorrtt FFiieellddss contains a list of
all of the fields present within the database. If the user requires the results to be sorted,
select the required field in one or more of the drop down boxes as desired.

You can change the ordering by clicking on the Order button located to the right of each
dropdown box.  Normally by default, results are listed in ascending numeric or alphabetic
order (1,2,3… or a,b,c…).  

An example of using the sort fields in a real-life situation would be to select the FFiirrsstt SSoorrtt
FFiieelldd as SSuurrnnaammee and the SSeeccoonndd SSoorrtt FFiieelldd as FFoorreennaammee. This would result in a list of records
being presented in the following way with the SSuurrnnaammee being the main ordering field and the
FFoorreennaammee being the secondary:
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The SSuurrnnaammeess are listed The Smiths are listed in alphabetical
in alphabetical order                                          order of their FFoorreennaammeess
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SSuurrnnaammee FFoorreennaammee

Rabin Alex
Roberts Steve
Slade Bill
Smith Ann
Smith George
Smith Steven
Smith Zachary
Thomson David
Truman Howard



DDeetteerrmmiinniinngg tthhee sseeaarrcchh ccrriitteerriiaa
The heart of the Query Builder is the CCrriitteerriiaa section..

You can add up to four search criteria within a query.  Each criteria entry consists of the FFiieelldd
that is to be tested, the OOppeerraattiioonn and the VVaalluuee that the field contents are to be tested
against.

AAddddiinngg ccrriitteerriiaa
This can be done by clicking the add button.  You will then be shown 3 empty boxes, from which

you can select the criteria information.

DDeelleettiinngg ccrriitteerriiaa
Click the associated delete button next to the criteria you wish to delete.

CCoonnffiigguurriinngg ccrriitteerriiaa

FFiieelldd bbooxxeess
Clicking on one of the FFiieelldd boxes causes a drop-down list of all the available database fields
to be displayed. The desired field should be selected from that list.

OOppeerraattiioonn bbooxxeess
Clicking on one of the OOppeerraattiioonn boxes allows the user to select from a set of conditional
operators that can be used to filter results from the database. The operations and 
descriptions of each one’s function is listed below:

EEqquuaallss
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field exactly match the value in the Value box, then the
Included fields for that record are added to the results listing. 

An example would be:
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This would result in all people with the surname of Smith being listed with no other
surnames included in the results (unless one of the other clauses was being used as
well).

DDooeess nnoott EEqquuaall
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field are nnoott eexxaaccttllyy tthhee ssaammee as the value in the Value box,
then the Included fields for that record are added to the results listing. 

An example would be:

This would result in all people with surnames ootthheerr tthhaann Smith being included in 
the results.

IIss GGrreeaatteerr TThhaann
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field are nnuummeerriiccaallllyy,, aallpphhaabbeettiiccaallllyy oorr cchhrroonnoollooggiiccaallllyy
ggrreeaatteerr tthhaann the value in the Value box, then the Included fields for that record are added to
the results listing. 

An example would be:

This would result in all people with surnames hhiigghheerr uupp tthhee aallpphhaabbeett tthhaann Smith
being included in the results. For instance, the surnames “Stevens” and “Tripp”
would be included in the results, but “Jones” and “Simpson” would not.
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IIss GGrreeaatteerr TThhaann oorr EEqquuaall TToo
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field are nnuummeerriiccaallllyy,, aallpphhaabbeettiiccaallllyy oorr cchhrroonnoollooggiiccaallllyy
ggrreeaatteerr tthhaann oorr eexxaaccttllyy eeqquuaall ttoo the value in the Value box, then the Included fields for that
record are added to the results listing. 

An example would be:

This would result in all people with surnames hhiigghheerr uupp tthhee aallpphhaabbeett tthhaann Smith 
aanndd eexxaaccttllyy eeqquuaall ttoo Smith being included in the results. For instance, the 
surnames “Smith”, “Stevens” and “Tripp” would be included in the results, but
“Jones” and “Simpson” would not.

IIss LLeessss TThhaann
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field are nnuummeerriiccaallllyy,, aallpphhaabbeettiiccaallllyy oorr cchhrroonnoollooggiiccaallllyy lleessss
tthhaann the value in the Value box, then the Included fields for that record are added to the
results listing. 

An example would be:

This would result in all people with surnames lloowweerr ddoowwnn tthhee aallpphhaabbeett tthhaann Smith
being included in the results. For instance, the surnames “Jones” and “Simpson”
would be included in the results, but “Stevens” and “Tripp” would not.

IIss LLeessss TThhaann oorr EEqquuaall TToo
This tests the contents of the selected field against contents of the Value box which is 
alongside it. If the contents of the field are nnuummeerriiccaallllyy,, aallpphhaabbeettiiccaallllyy oorr cchhrroonnoollooggiiccaallllyy lleessss
tthhaann oorr eexxaaccttllyy eeqquuaall ttoo the value in the Value box, then the Included fields for that record are
added to the results listing. 
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An example would be:

This would result in all people with surnames lloowweerr ddoowwnn tthhee aallpphhaabbeett tthhaann Smith
aanndd eexxaaccttllyy eeqquuaall ttoo Smith being included in the results. For instance, the surnames
“Smith”, “Jones” and “Simpson” would be included in the results, but “Stevens” and
“Tripp” would not.

CCoonnttaaiinnss
This tests the contents of the selected field against contents of the Value box which is 
alongside it. 
The CCoonnttaaiinnss operator is unlike the other operators in that it is used in conjunction with 
values that feature ‘wwiillddccaarrddss’.

Wildcards are powerful tools in the query builder. They offer a way for the user to specify
blocks of names or values without having to specify the entire name within the Value box.

There will be different wildcard options available dependant on the type of underlying 
database you are using.  This setting should only be used if you are knowledgeable of the
underlying database query facilities.

An example would be:

This would result with all surnames that start with the letters ‘Jo’ are followed by 
any number of characters, then the character ‘s’ and then any number of 
characters. So it would pick up names like Johnson , Jones, Jonsor, but not 
Jonathon, John etc

IIss EEmmppttyy // IIss NNoott EEmmppttyy
This query is typically used in conjunction with data fields where you wish to enquire whether
the field contains any data or not.  A typical use is with Image fields, where you wish to return
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only those records that contain an Image (although this value can be used in any field where
you wish to check if it contains any data).

An example would be:

This query will return all records that do not contain an image.

This query would return all records that do contain an image.

SSttaarrttss wwiiddtthh // EEnnddss wwiitthh

This does exactly as it says, querying for data that starts or ends with the values specified in
the Value field box.  The value specified is not case sensitive so entering a ‘S’ and ‘s’ will return
the same results.  You can enter as many characters as you wish to indicate into the search.  So
entering JJoo would return values such as Jones , Jon, but not James etc

An example of this would be:

This query would return all Surnames that start with the values ‘st’.

This query would return all Surnames that end with the values ‘son’.
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CCllaauussee iinn VVaalluuee

This option provides advanced querying abilities where the provided Operations do not cover.
By selecting this you can enter in any query expression as the where clause of the query.

This option should only be used by advanced users who are aware of the facilities available
within the underlying database schema and so be able to make use of the options it gives you.

Using this field ignores any fieldname specified in the Field name text box.

An example would be where you wished to set query range for some data.

The Value specified in this case is

DDeepptt lliikkee ‘‘CC%%’’ oorr DDeepptt lliikkee ‘‘MM%%’’

By specifying this, the query will return all Departments contained within the 
database that start with either a C or a M.

SSoommee hheellppffuull hhiinnttss::
1) When including more than one field name as criteria the system appends them together as
the Boolean ‘And’ clause.  This means that each condition specified needs to be true in order
for a particular record to be returned.

2) You can specify free form text within the Value fields by placing the information within curly
braces {some data}.  This can help where you wish to include some custom clauses within the
configured Operation.

For example:
If you wanted to search for surnames that started with M or started with N you 
would do something like.
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SSaavviinngg yyoouurr qquueerriieess
To save your query, first give it a title, as indicated in the Title field in the top left of the
screen.  This title will be something relevant to what information the Query is returning.

The final stage in building a query is to save it by clicking
the SSaavvee…… button.  Once saved, the query that was created
will be available for use within ImageBase and will be listed
along with any other saved queries at the foot of the RReeppoorrtt
menu as shown in the image to the right.

In the example to the right two custom-named queries are
shown:

1) Find Surnames > B
2) Find Surnames G through S

When choosing a query from the Report menu a new record list will be produced. If the CTRL
key is held down as the query is selected then the query results will be loaded into the People
Picker and not a new record window. 

The LLooaadd…… button allows the user to load previously saved queries for duplication or modification and
the MMaannaaggee…… button allows the user to delete unwanted ones or rename them. The functionality of the
dialogs for saving, loading, deleting and renaming query files is the same as that of the file management
for the PPeeooppllee PPiicckkeerr detailed on pages 125.

RRuunnnniinngg wwiitthhoouutt SSaavviinngg

To run a query without saving it for future use, click the UUssee rather than the
Save bbuuttttoonn..

TTeessttiinngg tthhee qquueerryy
If you expect your query to return a large number of results, or if you just want to verify some of the data
it returns to ensure it is working as expected, click the Test button.
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The example above shows the results of a query after the Test button has been pressed.  If you are
happy with the results shown, you can then proceed to run the query or save it for future use.

DDeetteerrmmiinniinngg hhooww mmaannyy rreeccoorrddss wwiillll bbee rreettuurrnneedd
Click the Count button located at the bottom of the screen to determine how many records will be
returned by the current query.

RReeppoorrtt >> PPrriinntt RReeccoorrdd LLiisstt
This option provides the ability to print records to your standard paper printer.  Clicking on Print Record
list will bring up the a screen that looks like the following 

This screen gives the ability to customize what information you wish printing along with some standard
printout options.
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SSeelleeccttiinngg tthhee ffiieellddss ttoo pprriinntt
To include or remove fields from the print output, click the square box next to the field name in the
FFiieellddss:: box. 

Tick indicates the field is selected in the print output.  No tick means the field will
be ignored.

When you select a field you will also notice that it is included in the Sample output below.  You can resize
fields to customize how much room they take up on the paper by clicking on the bar that is located
between the field names and holding the mouse down.  Then by dragging it left and right you can change
the field width.

AAppppeeaarraannccee
OOrriieennttaattiioonn: Available layouts for printing are indicated as Portrait and Landscape only.  The select-
ed option is indicated by appearing indented.

PPaaggee NNuummbbeerrss: Indicates if page numbers are to be included in the print output.  Page numbers
appear at the bottom of the printed output, and are centred.

PPrriinntt TTiittllee: Will print the title given to the report on the print output.  The print title appears at the
top of the printed output, and is aligned to the left of the document.

WWoorrdd WWrraapp CCeellllss: Because some fields may take up more room than the specified print width, this
option provides the ability to nicely wrap the information onto the next line.  If this option is not selected
and the text to be printed is too large for the column it will be truncated to fit within the column 
boundaries.

RRaannggee
PPrriinntt CCuurrrreenntt RReeccoorrdd GGrriidd((....)): This option will print only those records that are visible in the
currently active Record View.  This enables you to run queries for information and then print off that
query result set only.

PPrriinntt EEnnttiirree DDaattaabbaassee: Prints every record in the database.

SSaavviinngg LLaayyoouuttss ffoorr ffuuttuurree uussee
Report layouts and settings can be saved for future use by using the Templates option.  To save a report
click on the TTeemmppllaattee…… button and click save.  This will ensure all settings relating to this report is saved
for future use.
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LLooaaddiinngg SSaavveedd TTeemmppllaatteess
Click on the TTeemmppllaattee…… button and click Load.  Once the Templates dialog comes up select the Template
you wish to use and click Open.

AAddmmiinn MMeennuu

The Admin menu may be accessed by either
clicking on the AAddmmiinn menu header or by
holding down the AAlltt key and hitting ‘aa’.

The Admin menu allows the user to access
tools for editing ImageBase databases,
administering users, setting the overall
ImageBase program options and running administration queries provided by Digital ID.

AAddmmiinn >> DDaattaabbaassee DDeeffiinniittiioonn FF1122
This option provides the starting point for configuring and setting up an ImageBase database.  

NNeeww DDaattaabbaassee WWiizzaarrdd
ImageBase provides a wizard that allows you to quick start your database setup.

Provided within this wizard are a number of predefined database configurations.  If you wish to start
from a blank configuration select the Blank Database option.  Selecting the this option will take you to
the Save database as shown on page 74.
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There are a number of standard Templates available through the Database Wizard.  All go through the
same process for setting up the database, but provide different data options that can be used (excluding
Blank Database).  The following steps will go through a standard setup and describe the various wizard
dialogs using the SSttaaffff TTeemmppllaattee as an example.

Click the next button.

SStteepp 11 -- FFiieelldd SSeelleeccttiioonn

Fields help define what information you wish to store in the database.  In the example above
all fields with a tick mark next to their name will be included in the database.  To add additional
fields not provided in the above RReeccoommmmeennddeedd and OOppttiioonnaall fields list, you will have to do this
manually after the Wizard completes.  (Steps for this can be shown via the DDaattaabbaassee DDeeffiinniittiioonn
on page 151)

Fields specified from the Image above to be added to your database include:

Id
Forename
Surname
Department
Image
Payroll number
Job Title
Telephone

146



Click the next button.

SStteepp 22 -- IInnddeexxiinngg

Indexing provides the ability to select which fields will be available to be used for searching
records with.  You will notice above that some of the fields to add (as specified earlier in FFiieelldd
SSeelleeccttiioonn) are not available in the Indexed Fields list e.g. Image.  This is because an Image is
not a relevant field for searching, as this feature would typically only be for text information.

In the image above the selected fields that ImageBase will use to search on include:

ID
Surname
Payroll Number

Click the next button.

SStteepp 33 -- FFiieelldd OOrrddeerr
This step determines the order with which the fields to be setup are displayed in the Main Record View
pane of ImageBase.  Use the Down and Up arrows located towards the bottom of the Order list to arrange
the field order to your liking.
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Click the next button.

SStteepp 44 -- SSaammppllee CCaarrdd DDeessiiggnn

Card Designs are part of the core functionality of ImageBase.  You can produce a sample design to work
from by ensuring the tick is located next to the Produce me a sample card design text.  

In the example above, a card design will be created that looks exactly like the sample above (barring the
photo).  When printing cards, the fields indicated above will be replaced by the information in your data-
base (Forename will be the actual persons name of the record being printed, and the Image will be the
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records specific image).

You can change the design and/or create new ones at a later date through CCaarrdd DDeessiiggnneerr.  See page 45

Click the next button.

SStteepp 55 -- OOvveerrvviieeww

The final screen in the Database Wizard provides an overview of the options selected.  If you are not 
satisfied at this point, use the Back button to traverse through the Wizard sections and make any 
adjustments required.

Click the Finish button.

SSaavviinngg yyoouurr ddaattaabbaassee

Before you can start adding records and printing cards
you must save the database.  

There are a number of supported database formats
available, as shown by the list in the image opposite.
Select an option from the list and click the OK button.

* For more information on particular database formats
see Appendix B on page 174.

Depending on the option you select, a dialog will appear
prompting you for the save information.
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For example, selecting the Microsoft Access Database option brings up a browse dialog that prompts you
for a save location on disk.

Selecting the MySQL option however will bring up a MySQL dialog requiring specific connection details.

CCrreeaattee PPrrooggrreessss
When creating or saving changes made to the Database definition, the Create progress dialog will appear
showing the steps used.  This will disappear once the necessary changes/additions have been completed.

DDaattaabbaassee DDeeffiinniittiioonn
The database definition dialog is the primary location for configuring the setup of an ImageBase 
database.

The main screen is divided into 4 sections identified by tab options at the top of the screen.  These 
sections are identified as:

FFiieellddss: Identifies any fields and their configuration options currently stored in the database.

CCaarrddss: Attaches card designs to the databases allowing for ease of use in printing.

EExxtteerrnnaall CCoonnnneeccttiioonnss: Determines any connection to a database that has not been created
by the ImageBase application.
SSeettttiinnggss: General settings applicable to the database setup and configuration.

The icons located above the tabs provide features for creating/editing/saving and accessing the current
ImageBase database.

NNeeww DDaattaabbaassee:: Starts a new blank database.

OOppeenn EExxiissttiinngg DDaattaabbaassee:: Provides features for opening an existing Database Definition.

SSaavvee DDaattaabbaassee:: Saves any changes made to the current Database Definition.

OOppeenn DDaattaabbaassee:: This option will change to the Main Record View for the current database 
being edited.
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FFiieellddss::
Your database will be no good to you until you have created all the fields required to contain record
information. A field is a ‘place’ in the database where data can be stored.  Typically, fields hold different
‘types’ of information such as text, numbers or even images.

AAddddiinngg aa nneeww ffiieelldd
To add a new field to the database click on the Add button which is identified by the icon.
A new field will appear at the end of the field list with the type defaulted to TTeexxtt and a ssiizzee==8800.  You will
also notice the information in the bottom window pane has changed.  Each field has user configurable
options and are explained in AAppppeennddiixx DD -- DDaattaabbaassee FFiieelldd ccoonnffiigguurraattiioonn ooppttiioonnss.

Edit the field by typing in the field name.  In the image below, the field name entered is ‘Surname’.

Once entered click on the ID field.  This will remove focus from your newly created field, locking it into
place.  You can see this by the cursor being removed from the newly created field (note the field is not
saved at this point).
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NNOOTTEE : Fields defined in the database are
located here.

NNOOTTEE : that available options can vary between field types.  If the option is not available for a particular
selected type it will not appear in the bottom window pane. 



Select the field type by clicking in the type column as shown below.  A description of the various field
types can be found in Appendix C – Database field types.

DDeelleettiinngg aa ffiieelldd

You can delete a field by selecting that field and clicking the delete button.  Only fields that are not
Indexed already can be deleted.  If you wish to delete an indexed field, first mark it as not indexed, save
the changes and then attempt to delete it.

LLiimmiittiinngg ffiieellddss ttoo cceerrttaaiinn ddaattaa
For some types of fields, it is desirable to pre-define a set of entries that are often used within that field.
For instance, a DDeeppaarrttmmeenntt field is likely to have a fixed set of entries that are used over and over again.
These fields might represent the current list of departments within the company.

To define these values, select a field that has the VVaalluueess configuration option available (for a list of
these fields see AAppppeennddiixx DD on page 156).  In the configuration options there will be an item called
VVaalluueess.  Click on the [[NNoonnee]] next to this field.  This will display a           button towards the far right of the
field.

Clicking the  button loads the Field Values dialog from which you can add entries by clicking on the add
button and then typing in the appropriate value.
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NNOOTTEE : Select the type by clicking on the type
field and selecting a dropdown item.



For example if you enter these 5 values:

Personnel
Sales
Marketing
Corporate Management
Security

The 5 values will be available for selection when
entering in record information.

When the list of departments is complete, click the OK button to return to the DDaattaabbaassee DDeeffiinniittiioonn dialog.

You will notice that the [None] value previously existing in the Values field has now changed.  It should
reflect the number of items in the Field list.  In this case it will be showing as [[55 iinn lliisstt]].

SSeettttiinngg uupp tthhee sseeaarrcchh ffiieellddss
One of the most useful functions of a database is the ability to search through the entire set of records
to find specific record details.  Imagebase does this by providing the ability to select fields as Indexed.
You can do this by altering the IInnddeexxeedd option located in the field configuration pane.  An example of this
is shown in the Image below.
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NNOOTTEE : To have the list of field values sorted
alphabetically select the check box at the bottom
of the dialog.



Although most fields have this option available, it is not always practical to assign this feature.   Each
time a field is indexed, database performance is affected.  Although this may not be apparent for small
databases, it may be noticeable in larger databases.

CCaarrdd DDeessiiggnnss
Associating card designs is one of the most important aspects of the ImageBase software.  By doing this,
you can then easily choose that card design to be printed for a selected record.

To add card designs or design from scratch, click on the CCaarrddss tab. 

This will change the Database Definition view to that shown below.  From here you will see three sections.
Before we start adding cards to the database a brief description of the sections should be covered first.

Viewable from the Cards tab should be three identifiable sections (as shown by the Image below):

Cards Stored on Disk
Card Designs in database
Cards Available to print
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TThhee CCaarrdd TTaabb

CCaarrdd DDeessiiggnnss

CCaarrddss ssttoorreedd oonn

CCaarrddss aavvaaiillaabbllee ttoo



CCaarrddss SSttoorreedd oonn DDiisskk
If you have card designs located on disk, you can use this section to browse for them.  This is done by
clicking on the folder icon located to the right of the textbox.

From there designs can be dragged into the CCaarrdd DDeessiiggnnss vviieeww if you wish to store them in the database
permanently or they can be dragged directly into the Cards Available for print if you wish to leave their
contents on disk. 

In the example to the right, you can see
three cards of type .cdl stored in the
c:\ProgramFiles\ImageBase32\
Demonstration Data\ folder.

CCaarrdd DDeessiiggnnss
If you have card designs already stored in the database, these will appear in this section.  From here you
can choose to Add , Edit or Delete stored designs.  This is done by clicking the buttons located below the
CCaarrdd DDeessiiggnnss heading..

From the example above you will see the database has
one card design stored, namely Hospital Front.cdl.

CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt
Because printing cards is an integral part of ImageBase it is important that the card designs used to
print are easily accessible from within the application. 

If Cards are not attached to the database, then every time a card is to be printed, you would need to
browse for that card design, either on disk, or by selecting from a list in the database.  However, by
attaching these designs, printing cards can become as easy as a one click operation.

You can have as many card designs as you wish attached to the database.  However, too many designs
may become confusing, so a good card design is just as important as the data it conveys.
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NNOOTTEE : Because it is easier to backup one database, store card designs in the database rather than on disk.

New Card design using Card Designer

Delete an existing stored card design

Edit an existing design using Card 



AAddddiinngg aa ccaarrdd ddeessiiggnn ttoo tthhee ddaattaabbaassee
First we need to browse for the existing card design.  To
do this click on the folder icon located to the right of the
textbox in the CCaarrddss SSttoorreedd oonn DDiisskk section.  

This will display a browse dialog like the one shown
opposite.  

Using the browser, browse to the destination folder
where the existing card design files reside.  Once 
located, click ok.  The CCaarrddss SSttoorreedd oonn DDiisskk list should
now be populated with all the .cdl files located in this
folder.

To convert a card design from being stored on disk to being stored in the database is as simple as 
dragging the design you wish to the CCaarrdd DDeessiiggnnss section.

This card design is now stored in two locations.  Within the ImageBase database and also on the file 
system.  It is important to note that changes made to the Card design located in the Demonstration Data
folder will not alter that stored in the database and vice versa.

You would now need to add this design to ensure the printing process knows about it.

Using the same drag and drop method used above, select the .cdl file from the CCaarrdd DDeessiiggnnss section and
move it to the CCaarrddss AAvvaaiillaabbllee ttoo PPrriinntt section.  This will add a new entry into the list, with the Design
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NNOOTTEE : Select the Your Company.cdl file from the Cards
Stored on Disk section and holding the mouse button down
move it into the Cards stored in the database list.



Name set to the file name of the card design.
At this point a ‘Description’ and ‘Field Value’ can be specified for this card design template.

DDeessccrriippttiioonn:: Is used to identify this particular design within the ImageBase application.  For ease of use
purposes keep this as short as possible to describe the intended use of the card design.

FFiieelldd VVaalluuee:: Is a four character code which provides a way of referencing this card template in the
atabase.  It is used in conjunction with the CCaarrdd DDeessiiggnnaattiioonn type field and can allow records to be 
automatically associated to a card design.  This can help where you have a large number of designs and
do not with to select a design every time you print a card.

When a card is selected you will notice it is previewed in the bottom left of the Cards tab.  A number of
options are available for each card design.  Typically you will not need to change these options and they
can be left alone.

CCaarrdd PPrrooppeerrttiieess
Each card design has a unique set of property values that define how the card acts in the system.
Dependant on if the design is stored in the database or on disk, some different property values will
become available. 

The list of all property values are described below:

SSttoorreedd iinn DDaattaabbaassee:: Shows where the card design is stored.

NNaammee:: The name given to the card design when accessed via ImageBase

ffiillee nnaammee:: The name of the file if it is stored on disk.

DDeessccrriippttiioonn:: The description that appears on the ImageBase print selection options.
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NNOOTTEE : Click here to add a description.

NNOOTTEE : Card Properties.



FFiieelldd VVaalluuee:: Any field value setting configured (works in conjunction with the Card Designation Field
Type).
EEnnccooddee:: Determines if this card can encode if there is any information present for this operation.

SSiiddeess:: Determines which side is attempted to be printed

CCooppiieess:: Number of default copies to print, each time a design is printed.

EEnnffoorrccee DDrriivveerr:: The specific Print Driver to be used for the card design.  Setting this will override any
Card Printer set when printing from the People Picker.
AAddmmiinn OOnnllyy:: Determines if only the logged in user with Administrative rights can print this card or not.

VVaalliiddiittyy EExxpprreessssiioonn:: An expression that must be true before the card can be printed.  Could be 
something like the Forename of a design must not be empty.

EExxtteerrnnaall CCoonnnneeccttiioonnss
External connections provide the ability to connect to a non ImageBase database and query the 
information provided.  It is used in conjunction with the DDaattaa SSoouurrccee and DDaattaa SSttaatteemmeenntt field options to
provide read only access to any external database format supported by ImageBase.

The process for setting up an external connection is the same as creating a new ImageBase database in
that you are prompted for the database details when making the connection.  There are four icons used
to create an external connection.

NNeeww EExxtteerrnnaall CCoonnnneeccttiioonn:: Brings up the Open Database option that will prompt you to enter
the connection details for the particular database if required.

DDeelleettee EExxtteerrnnaall CCoonnnneeccttiioonn:: Removes the connection from ImageBase.

TTeesstt EExxtteerrnnaall CCoonnnneeccttiioonn:: Verifies the validity of the connection details.  

RReemmaakkee EExxtteerrnnaall CCoonnnneeccttiioonn:: Rather than deleting and then creating a new external 
connection of the same name, you can simply remake the connection by selecting this option.
This will then bring up an Open Database dialog where you can select the new details.

SSeettttiinnggss
This tab provides a number of general settings for the ImageBase database.  These are described below.
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OOnn DDiisskk LLooccaattiioonn:: If record Images are stored on disk, this informs ImageBase of the root location to
find the images.
CCaarrdd DDeessiiggnnss: Card designs can be stored in the Database or on Disk.

LLooccaall RReeccoorrddss: The amount of records to show in the Record List when in ImageBase at any one time.
Setting this to a high number i.e. 10000 can cause the application to run a bit slower.  If performance is a
problem, lower this value to try and improve it.
RReeqquuiirree PPrriinntt RReeaassoonnss: When printing cards, it is possible to force the user to enter in a reason for
the print.  This can be good for audit tracking of the history of card prints.  For information on how to
add Print Reasons, see AAddmmiinn >> PPrriinntt RReeaassoonnss below.
RReeqquuiirree AArrcchhiivvee RReeaassoonnss:  Requires the user to enter in a reason for archiving a particular record.

AAddmmiinn >> EEddiitt PPrriinntt RReeaassoonnss……
If the RReeqquuiirree PPrriinntt RReeaassoonnss option is set to
Yes, then the reasons available for selection
by the user will need to be configured appro-
priately.

Click on the AAddmmiinn -->> EEddiitt PPrriinntt RReeaassoonnss……
option from the menu.  This will bring up the
print reasons dialog.

The dialog opposite shows three currently
entered print reasons.

Namely:
LOST CARD
NewReason
No Reason Given

AAddddiinngg aa pprriinntt rreeaassoonn
To add a new Print Reason, click on the green plus located at the right of the screen.  This will insert a
new value into the Print Reasons list and default its name to NNeewwRReeaassoonn. 

You can then edit its name by typing directly into the Reason edit box.  This will also change the reason in
the list and re-order it as you type.

EEddiittiinngg aa pprriinntt rreeaassoonn
Select the print reason you wish to edit by clicking on the item in the list.  Then simply start typing in the
Reason text box located towards the right of the dialog.

DDeelleettiinngg pprriinntt rreeaassoonnss::
Select the print reason from the list and click the red cross button.
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OOppttiioonnss
AA ccoommmmeenntt mmuusstt bbee eenntteerreedd:: By selecting this option, then whenever that particular print reason is
selected from the list during a print, a user comment has to be entered in order to continue.
PPrriinntt rreeaassoonn iiss vviissiibbllee:: You can hide a print reason without deleting it.

SSaavviinngg CChhaannggeess
To save the changes immediately to the database click the Ok button.  This automatically saves any
changes made to the Print Reasons.  If you click Cancel, all changes made will be lost and you will need to
re-enter the details.

AAddmmiinn >> TThhiiss DDaattaabbaassee >> OOppeenn iinn DDaattaabbaassee DDeeffiinneerr
Selecting this option will load the currently active database definition.  This will allow you to make 
configuration changes as required.  For more information on the Database Definer read the section on
DDaattaabbaassee DDeeffiinniittiioonn on page 150

AAddmmiinn >> TThhiiss DDaattaabbaassee >> UUsseerr AAccccoouunnttss……
The AAddmmiinn>> TThhiiss DDaattaabbaassee >> UUsseerr AAccccoouunnttss command invokes the dialog that allows the Supervisor to
create or delete user accounts and define varying degrees of access to the ImageBase program’s 
functionality. 

At the ‘power user’ end of the scale, accounts may be set up for other supervisors who will be able to
access all features of ImageBase, whereas at the other end of the scale, accounts may be created for
users who may only browse the database and not access any other features or change the information
within the database.
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Each user account is displayed in the UUsseerrss list on the left of the dialog. After a new installation of
ImageBase, only the Supervisor account will be listed. 

Clicking on a particular user causes the AAcccceessss RRiigghhttss and PPaasssswwoorrdd settings (though not the password
itself) to be shown in the panels to the right of the UUsseerrss list.

CCrreeaattiinngg aanndd ddeelleettiinngg uusseerr aaccccoouunnttss

Two buttons are provided which allow the current supervisor to add
or delete user accounts. Clicking on the AAdddd UUsseerr button causes the
supervisor to be prompted for a new and unique user name for the
new account:

After the unique user name has been entered and
the OOKK button clicked, the new user name will appear
in the UUsseerrss list. Clicking on this new user will 
display its access rights. By default, all new user
accounts have no rights set and are set to AAccccoouunntt
DDiissaabblleedd.

User accounts may be deleted by selecting the
account name from the UUsseerrss list by clicking on it
and clicking on the DDeelleettee UUsseerr button. A prompt will then appear asking for confirmation of the deletion.
SSeettttiinngg tthhee uusseerr’’ss aacccceessss rriigghhttss

Access rights may be assigned to individual users by selecting or de-selecting the checkboxes
in the AAcccceessss RRiigghhttss panel.  Rights are additive, not restrictive.

The different access rights give the selected user the following capabilities:

The user has full supervisor privileges allowing them to create, delete and modify user
accounts. The user may not have been given access rights to
change data or print cards, but they will have the capability to
create a new account that could do so and so Supervisor rights
should be carefully controlled.

This option allows the account holder to modify records in the
database.
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WWaarrnniinngg : If the Supervisor account is deleted, has its Supervisor access rights removed or the password is
forgotten, there will be no way to get back into the User Accounts menu. The only ways of recovering that 
situation would be to restore a previously backed-up version of the Users.mdb file in the ImageBase directory or
to install the program again from scratch.



With this selected, the user may add new records to the 
database. Being given AAdddd RReeccoorrddss rights also allows the user
to import data from other databases into the current one.

This option allows the account holder to remove records from
the database.

This option allows the account holder to print new ID cards from
the records within the database. 

With the Grab Images right assigned, a user may add images to records in the database from a
camera, scanner or file source. The user is also assigned the
ability to perform IImmaaggee BBaattcchh IImmppoorrttss into the database.

Edit Card Designs enables the user of the account to launch
CCaarrdd DDeessiiggnneerr from the ImageBase VViieeww menu. 

This checkbox allows the supervisor to disable a particular
user’s account without losing the settings for that account or 
deleting it.

For convenience, three buttons have been provided on the Access Rights panel to
allow the supervisor to set all checkboxes (FFuullll), clear all checkboxes (NNoonnee) or set
the access rights checkboxes to a pattern which is typical for a standard trusted
user (UUsseerr).
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NNOOTTEE : Supervisors should be aware that any modification in a user’s access rights will not become active until
the next time that particular user logs in to the ImageBase    program



PPaasssswwoorrdd sseettttiinnggss

For each user account, the supervisor may specify 
requirements regarding password usage. 

The specific settings will be a matter of policy for the 
supervisor and will be dependant upon the level of security
deemed necessary for the environment in which the
ImageBase software is being used.

If the RReeqquuiirreedd checkbox is left empty, the user has the
choice of whether or not to use a password. With this not set,
the user can simply choose to enter a blank (zero-length)
password if they do not wish to type a password in for each
login. Setting this checkbox forces the user to use a pass-
word.

The supervisor may set the password’s minimum length to ensure that suitably secure ones
are entered. 

The facility to force the user to change the password after a period of time helps to minimise
the risk of passwords that have been compromised being used illicitly beyond that period.

To set the initial password for the user account being set up, the supervisor may click the SSeett
PPaasssswwoorrdd button. This causes the  CChhaannggee PPaasssswwoorrdd ffoorr UUsseerr:: <<uusseerrnnaammee>> dialog to appear:

In this example, the supervisor is setting the password for a user account named ‘rob’.  A 
password is typed into the left-hand box and the ‘enter’ key is pressed. Because the password
is obscured for security reasons, the supervisor must then re-type the password into the
right-hand box to verify that the password was typed correctly the first time. 

If the two passwords match, then a message will pop-up confirming that the password has
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been changed. If the passwords do not match, then the option will be given to retry entering
them or to cancel the operation, leaving the password empty (if it is a new account) or set to
the previous value (for existing accounts).

Once a user has logged-in to the ImageBase program with their new account, they may change
their password from the one set by the supervisor to one of their own by using the SSeett
PPaasssswwoorrdd ffoorr <<uusseerrnnaammee>>…… operation from the FFiillee menu. 

The supervisor may see the date that the password was last changed for each user account by
checking the date displayed below the SSeett PPaasssswwoorrdd button. 

AAddmmiinn >> TThhiiss DDaattaabbaassee >> AAppppllyy PPaacckkaaggee……
This facility provides the ability for Digital ID staff to run database administration tasks without direct
access to the computer ImageBase is running on or d to the underlying database.

Digital ID staff will email an encrypted text string which is required to be pasted into the main box of the
Apply Package dialog.  Once inserted, click the OK button to run the commands shown.

To ensure security is maintained only encrypted commands sent by Digital ID staff can be inserted and
run in this utility.

AAddmmiinn >> OOppttiioonnss
This menu selection allows the user to specify general settings and options within the ImageBase
program.
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The Options dialog can have up to six tabs (as shown above) which are selectable by clicking on them.
These tabs each have a set of options which relate to the various customizable features of ImageBase.
The tabs are described below.

GGeenneerraall TTaabb
Provides access to the following settings:

AAllllooww rreeccoorrddss ttoo bbee eeddiitteedd iinn rreeccoorrdd LLiisstt: This provides the ability for the user to edit records by
directly manipulating their data via the record list.  This is a shortcut to clicking the update button of the
Main Record View.

AAllllooww RReeccoorrdd--EEddiitt bbyy sseelleeccttiinngg ffiieelldd:: Allows you to automatically put a record in the Main Record
View pane into Edit mode by clicking on the field information.

SShhooww IIDD ffiieellddss: ImageBase uses internal ID’s to keep track of records and ensure they are unique.
Often these will have no benefit to the user and this option can be left de-selected.
HHiiddee RReeccoorrdd LLiisstt:: Hides the record list from being displayed.  Quick searches can still be done to find
specific records.
GGrraabb wwhheenn RReeccoorrdd AAddddeedd:: Goes through the Image Grab process as soon as a new record is added
to the database.
IImmaaggeeBBaassee3322 vv11 ccoommppaattiibbiilliittyy:: Limits the databases that can be opened to Microsoft Access only
e.g. .mdb files.
SShhooww wweellccoommee aatt SSttaarrttuupp:: Displays the welcome screen when the software first loads.  This enables
the user to quick select databases to open without the need for browsing when there is no default 
database selected.

PPrriinnttiinngg TTaabb
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The printing tab provides configuration access to the Card Printer module.

SSeettttiinngg tthhee CCaarrdd PPrriinntteerr: To determine the printer to use for printing cards, select the appropriate
name in the list as shown above.  In this instance, the selected card printer happens to be DDeeffaauulltt
((\\\\DDPPSSDDAATTAA\\OOKKII CC77335500((PPCCLL)))). However, if you wished to have the EEllttrroonn PP331100 CCaarrdd PPrriinntteerr as the output
printer, you would select this option by left clicking on it in the list.

PPrroodduucctt PPrreevviieewwss:: When printing an individual card, this option determines if a preview of it will be
shown before printing occurs. This is a good method of previewing how the card will look and ensuring it
is acceptable before actually sending it to the printer for printing.

EEnnffoorrccee CCaarrdd DDeessiiggnnaattiioonn FFiieellddss:: If there is a Card Designation Field configured in the database
this option ensures it is applied to all printing for this particular card.  If no value is set for this field, the
first card design in the list is printed.

LLooccaattiioonnss TTaabb

BBaattcchh IImmaaggee DDiirreeccttoorryy:: The last known directory that images were imported from using the Batch
Image tool.

CCaarrdd DDiirreeccttoorryy:: The location of the card designs if they are stored on disk.

VViissiittoorr PPaassss DDaattaabbaassee:: Location of the VisitorPass database.

BBaacckkuupp DDiirreeccttoorryy:: Required for Digital ID administrative purposes.
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FFoonnttss//EEttcc TTaabb

Provides options for changing the look and feel of the Main Record View pane only.

DDaattaabbaasseess

DDeeffaauulltt DDaattaabbaassee:: You can set what database ImageBase will use to open automatically by clicking
on the browse icon located to the right of the ext box.  Setting this value will allow the database to open
immediately upon running ImageBase.

WWeebb BBuurreeaauu DDaattaabbaassee:: Used for specific administrative purposes and can be ignored.
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CCaappttuurree PPrrooppeerrttiieess ((<<ffiieelldd nnaammee>>))

The ability to configure Camera capture devices is only available when there is at least one Image field
present in the database.

Using this utility allows ImageBase to set which capture device it will use to capture an image for the
selected field.  If you have multiple Image fields configured, you can change the device for each one by
clicking on the Image Fields list (shown above), and selecting the required field.

SSeelleeccttiinngg tthhee DDeevviiccee
To select a Canon camera as the desired capture device for this image field select the UUssee CCaannoonn CCaammeerraa
option.  

To select an alternative device, select the UUssee SSttaannddaarrdd WWiinnddoowwss DDeevviiccee and select that device in the list.
In the image above, if this option was required, the available devices for selection would be:

Creative PC-CAM 880 (VFW)
Microsoft WDM Image Capture (Win32)

TTeesstt
You can test your settings by clicking the Test button.  This will attempt to connect to any capture devices
that you have selected from where you can take a picture to test its functionality.
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WWiinnddooww mmeennuu

The window menu allows the user to
arrange windows within the ImageBase
main program in different ways.

WWiinnddooww >> CCaassccaaddee

This function arranges the windows within the ImageBase program in a cascading fashion that
allows easy access to all windows.
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WWiinnddooww >> AArrrraannggee IIccoonnss

When multiple windows have been minimised to icons, they can be formed into an orderly
‘stack’ in the lower left hand corner of the ImageBase window by using this command.

WWiinnddooww >> ((LLiisstt ooff vviieewwss))

A list of the currently active windows within ImageBase is provided at the
foot of the Window menu. This allows a particular window to be selected
and brought to the front so that it may be used.

HHeellpp mmeennuu

The Help menu may be accessed by pressing <Alt> ‘h’ from the keyboard or by selecting the
Help menu option.
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HHeellpp >> HHooww ttoo RReeggiisstteerr

Registration information can be obtained from Digital ID using the following contact 
information:

Telephone: +44 (0) 161 480 4462
Email: support@digitalid.co.uk
Website: http://www.digitalid.co.uk

HHeellpp >> RReeggiisstteerr

The registered name and Authorisation code
should be located on the CD case provided with the
ImageBase package.

Enter the details as indicated on the package,
ignoring the Auxillary Code field, and press the Ok
button.

You must then exit ImageBase and restart to
enable a fully functional system.

HHeellpp >> DDiiggiittaalliidd oonn tthhee WWeebb

The Digital ID website is www.digitalid.co.uk.
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HHeellpp >> OOnnlliinnee UUppddaatteess

If you have a valid internet connection, the
Online Updates utility provides access to
downloading and installing the latest 
software versions.

To check the internet for the latest software
versions click the Start button.  If a new 
version is available you will be prompted
whether you wish to download and install it.

Once downloaded, all open ImageBase 
applications will be closed, and the install
process will commence.

When the updates are installed, ImageBase
will automatically start back up.

DDiissaabbllee AAuuttoommaattiicc UUppddaatteess: If this option is not selected, ImageBase will automatically check
the Internet for updates every time the application loads.  To disable this, select this option but clicking
in the small square box next to Disable Automatic Updates.

HHeellpp >> AAbboouutt IImmaaggeeBBaassee……

The AAbboouutt box contains program version
and copyright information for the
ImageBase program. 

It also has a button labelled SSyysstteemm IInnffoo
which causes the Microsoft™ Windows™
System Information program to be run. 
This program can be useful when trying
to troubleshoot installation or system
problems. 

To exit the AAbboouutt box, the OOKK button
should be clicked.
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AAppppeennddiixx AA -- MMaaggnneettiicc EEnnccooddiinngg

TTrraacckk FFoorrmmaattss

ImageBase provides the ability to encode cards using IAT encoding.  The format and text that can be
encoded onto each track is defined below.

IIAATTAA,, AABBAA,, aanndd TTTTSS cchhaarraacctteerr sseettss

The IAT encoding format selection for card printers encodes IATA data on track 1, ABA data on track 2,
and TTS data on track 3. This meets the requirements of the ISO standard. 

IIAATTAA ((IInntteerrnnaattiioonnaall AAiirr TTrraannssppoorrtt AAssssoocciiaattiioonn)) 

The maximum field length for IATA format is 76 characters. IATA allows spaces, upper case alphabetic
characters, numeric characters, and the following special characters: 

! # $ % ‘ ( ) * + , - . / ; : < @ > = ^ ] \ [ “ & _ 

AABBAA ((AAmmeerriiccaann BBaannkkeerrss AAssssoocciiaattiioonn)) 

The maximum field length for ABA format is 37 characters. ABA allows numeric characters and the
following special characters: 

: ; < = > 

TTTTSS ((TThhrriifftt TThhiirrdd SSttaannddaarrdd)) 

The maximum field length for TTS format is 104 characters. TTS allows numeric characters and the 
following special characters: 

: ; < = > 
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AAppppeennddiixx BB -- DDaattaabbaassee TTyyppeess

MMiiccrroossoofftt SSQQLL SSeerrvveerr
Typically this database will reside in a remote location and require special user accounts and privileges to
gain access.  This will be required to be setup by the Technical department managing the SQL server
databases.

For further information on Microsoft SQL Server refer to the Microsoft home page.

CCoonnnneeccttiioonn DDeettaaiillss::

SSeerrvveerr: Determines the location of the machine that
the MS SQL server is running on.  Typically this is a
machine located on your network accessible from your
machine.

The machine specified can be the Hostname or the IP
address.

UUssee yyoouurr WWiinnddoowwss ……:: Use this option if the
Windows logon account has been granted privileges to
logon to the SQL database with the ability to Create and
Edit tables.

LLoogg oonnttoo SSQQLL SSeerrvveerr……..:: Use this to define a
specific SQL logon and password with appropriate 
privileges.

DDaattaabbaassee nnaammee:: Once a connection is established using the Test button, this list contains the
known databases available for access.

TTeesstt:: Click this button to check the connection settings to the SQL server.  If everything is ok, the list of
known databases will be returned in the Database name combo box.

OOkk:: Select a database in the Database name list and click the OK button to logon.

UUsseerr llooggiinn aaccccoouunnttss: Users should have a minimum of db_datawriter, db_datareader and db_ddl
admin privileges.  They will be required to create/edit and read the database being created.

MMiiccrroossoofftt AAcccceessss
Microsoft access databases can be stored on your local machine or remotely across the network.  This is
the typical and most effective means to create a small and quick database as it does not require any
external security measures in getting it setup (other than directory read/write access).
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Clicking on the Microsoft Access database option, brings up the windows browse dialog.  Use this to
select/create the Microsoft access database (.mdb) file as required.

MMyySSQQLL
A variation of the MS SQL database, this database requires similar security information to that required
by MS SQL.  

ImageBase requires ODBC drivers for MySQL to be pre-installed on the local machine in order for the
system to communicate effectively with this database.  These can be obtained from the MySQL website if
not already installed at www.mysql.com.

CCoonnnneeccttiioonn DDeettaaiillss::

SSeerrvveerr: Determines the location of the machine that MySQL is running on.  Typically this is a machine
located on your network somewhere

PPoorrtt: The port number used to connect to MySQL.
Typically this setting does not require changing, but if
so please consult your Technical Department for the
relevant information.

UUsseerrnnaammee aanndd ppaasssswwoorrdd: The security
information setup by your IT department to obtain
access to the MySQL database.

DDaattaabbaassee nnaammee:: Once a connection is 
established using the Test button, this list contains
the known databases available for connecting to.

TTeesstt:: Click this button to check the connection settings to the MySQL server.  If everything is ok, the list
of known databases will be returned in the Database name combo box.

OOkk:: Select a database in the Database name list and click the OK button to logon.

CCSSVV ((CCoommmmaa SSeeppaarraatteedd VVaalluueess))
ImageBase cannot create databases of this type but it can read the information within them and hence
use that information to print cards.  

This can be an effective means to have card printing information provided by an external party but the
printing done locally, whilst not saving any of the printed information to a central database.

Clicking on the Comma Separated Values (CSV) option, brings up the windows browse dialog.  Use this to
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select the target file (.csv).

It’s important to note here that Image locations must be on the File System due to there being no facility
for this in a CSV file.

OOrraaccllee
For more information on Oracle databases read www.oracle.com.
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AAppppeennddiixx CC -- DDaattaabbaassee FFiieelldd TTyyppeess

AAuuttooNNuummbbeerr--IIddeennttiittyy
This field specifies a read only numerical field that contains incremented values starting from 1.  On
record insertion, a unique numerical value will be created automatically (the system wide ‘Id’ field is an
example of an AutoNumber-Identity field).

BBiinnaarryy DDaattaa
Can contains information that is formatted as binary data rather than standard text.

BBuurreeaauu LLoogg
Contains history information pertaining to card prints for each record.

BByyttee
Contains an 1 byte value.

CCaallccuullaatteedd
Contains a formula to calculate the required value for the field.

CCaarrdd DDeessiiggnnaattiioonn
This field holds the four character code specified as the Descriptor in the Add Card Template dialog (page
51).  When the user presses ‘print’ in the record view ImageBase will try to match the value of this field
with a card layout descriptor to select the correct card to print. 

CCaarrdd PPrriinntt CCoouunntt
This is a numerical field that contains a count of how many cards have been printed for each record. It
can be used for various purposes. One is to keep track of those people who keep losing their cards,
another is to tell who has never had a card printed.

CCaarrdd PPrriinntt DDaattee
A record of the last date and time that a card was printed for the record is kept in this field.

CCuurrrreennccyy
Contains numerical values limited to currency format.  This enforces decimal places to a maximum of 2.

DDaattee//TTiimmee
This field type can hold a date and time for more precise logs of events within a record.
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DDoouubbllee
A large integer field.

EExxppiirryy DDaattee

Is a Date field that provides access to creating Expiry reports as well as accessing pre-configured
reports.  The pre-configured reports can be navigated to via the RReeppoorrtt -->> CCaarrdd EExxppiirryy menu.

FFllooaatt
A large integer field that can contain decimal digits.

GGUUIIDD
To ensure compatibility with SQL Guid field

IImmaaggee
This field type can hold an image in bitmap (.bmp), JPEG (.jpg), GIF (.gif), or TIF (.tif) formats.

IImmaaggee GGrraabb DDaattee
When an image is captured for a record, this field is automatically updated with the current local date.

IImmaaggee oonn DDiisskk
A calculated field which can determine where the image is stored on the disk.  Provides the ability to
store images on disk rather than in the database.  Captured images are also stored in this location as
determined by the calculated field.

IInntteeggeerr
This field type can store integer(non-fractional) numbers only.

LLaasstt mmooddiiffiieedd
This field type automatically stores the date and time that a record was last modified. No input is
required from the user to maintain the contents of this field.

MMeemmoo
This is a free-form text entry field that can be used to enter miscellaneous notes or descriptions for
records. 
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RReeccoorrdd CCrreeaattiioonn DDaattee
This field automatically stores the date on which the record was initially created. No input is required
from the user to maintain the contents of this field.

RReeppoorrtt TTiittllee
This field displays the title of the last report that the particular record was included in. This includes the
results of queries and People Picker lists. The title is added automatically by ImageBase if this field is
used and can be used to check who was included in particular reports.

SSmmaallll IInntteeggeerr
A smaller representation of the integer field.  Useful for where you know the field will not contain large
numerical values in order to keep the database size down and help searching efficiency.

TTeexxtt
A standard text field which can store up to 255 characters.

TTiimmee
Contains text value formatted into 24hr time as hh:mm.

TToo PPrriinntt FFllaagg
This field type contains a marker which identifies records which have already had a card printed for
them.

UUnnssuuppppoorrtteedd TTyyppee
This is a field type that ImageBase does not understand and is primarily used when data has been
imported from a non-ImageBase source. In theory no field should get this type, but it has been included
just in case it is needed.

YYeess//NNoo
This field type allows a simple ‘Yes’ or ‘No’ selection to be entered by the user into a record. It is useful to
use this rather than entering ‘Yes’ or ‘No’ into a text field as it takes up less space in the database. It
also ensures that only those two responses are allowed.
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AAppppeennddiixx DD –– DDaattaabbaassee ffiieelldd ccoonnffiigguurraattiioonn OOppttiioonnss

The following is a list of all field configuration options.  The field options appear in the bottom window
pane of the Database Definition field dialog.  

Some options are only applicable to certain field types and are identified as such.

TThhee ffoolllloowwiinngg ccoonnffiigguurraattiioonn ooppttiioonnss aappppllyy ttoo aallll FFiieelldd TTyyppeess ddeeffiinneedd iinn
tthhee ddaattaabbaassee::

NNaammee:: Identifies the name of the field in the database

CCaann bbee DDeelleetteedd:: Identifies if the field information can be removed.

RReeaadd OOnnllyy:: Setting this to yes means that when adding or editing a record, this field cannot be

changed.

VVaalliiddiittyy:: Provides the ability to ensure data entered adheres to particular company policies.  For 
example if someones payroll number must be at least 8 digits for it to be entered you could put 
something like.

Len(Payroll Number) = 8

DDaattaa SSoouurrccee:: If obtaining data from an external database rather than ImageBase, this determines the
external connection source.  External connections are created in the External Connections tab of the
Database Definition.
DDaattaa SSttaatteemmeenntt:: this allows you to determine where the field information is to be obtained when
using the External connection Data source.  This is accomplished by doing a select statement of the 
relevant field required.

TThhee ffoolllloowwiinngg aarree aaddddiittiioonnaall ccoonnffiigguurraattiioonn ooppttiioonnss ttoo ssppeecciiffiicc ffiieelldd ttyyppeess
oonnllyy::

RReeqquuiirreedd:: Determines if a field is required to have information entered into it before the record can be
added to the database.

Applies To: All numbers except Auto-Number, Calculated and Image

RReeqquuiirreedd ttoo PPrriinntt:: Determines if information is required in this field before it can be printed.

Applies To: All fields except Calculated.

SSiizzee:: The number of characters available to be entered in the field
Applies To: Text
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LLeetttteerr CCaassee:: Will convert the characters entered into the field to the specified case.
Applies To: Bureau Log , Memo, Text

DDeeffaauulltt:: Provides the ability to determine a default value when the record is first created.  This is 
helpful in setting custom dates for example.  An example of setting a default expiry date for 3 years in
the future would be:

DateSerial(Year(Now()) + 3, Month(Now()), Day(Now()))

* A complete list of available functions can be found in AAppppeennddiixx EE –– EExxpprreessssiioonnss.

Applies To: Bureau Log , Card Designation , Date/Time, Image On Disk, Integer, Memo,
Report Title, Text, Expiry Date

IInnddeexxeedd:: Determines if the field is searchable from within ImageBase
Applies To: Byte , Card print Count , Card Print Date, Currency,  Date/Time, Double, Float, Guid ,

Image Grab Date, Last Modified, Record Creation Date, Report Title, Small Integer, Text, Time, To Print
Flag, Yes/No, Expiry Date

VVaalluueess:: Fields can be converted to drop down lists by adding items to the Values.  Adding values 
immediately allows users to select field data from a drop down list, rather than having to type it in 
themselves (if they don’t want to).  Values can be configured by a Question box located towards the right
hand side of the field when selected.

Applies To: AutoNumber-Identity, Byte , Integer, Small Integer, Text

RReessttrriicctt TToo VVaalluueess:: Set this to yes if only the data in the Values list can be selected as an entry for
this field.

Applies To: Byte, Card Designation, Integer, Text

IInncclluuddee IInn PPrriinntt LLoogg:: If set to yes, this field is included into the print log as an extra column header,
and any print log entries will have the field data included into this column.

Applies To: AutoNumber-Identity, Bureau Log , Byte , Calculated, Card Print Count , Card Print
Date , Currency ,  Date/Time, Double, Float, Guid , Image Grab Date, Integer, Last Modified, Memo, Record
Creation Date, Report Title, Small Integer, Text, Time, To Print Flag, Yes/No, Expiry Date

SSoorrtt:: This outputs the data by alpha numeric ascending i.e. A – Z.
Applies To: Card Designation

AAssppeecctt RRaattiioo:: Can determine the size of the Image as seen by the user and stored on disk.
Applies To: Image

181



AAppppeennddiixx EE  -- EExxpprreessssiioonnss

The text object along with the barcode object and the magnetic encoder information make use of text
expressions. This allows text to be fixed, variable, or a mixture of the two. Fixed text is simply typed into a
text expression box. Variable text is entered between square brackets (i.e. ‘[[]]’). Variable text is calculated
when the card is printed. 

All fields from a database can be used plus SSeerriiaallNNuummbbeerr which is incremented every time a card is 
printed. 

Proper arithmetic expressions may be used such as  bbrraacckkeettss.. ++,, --,, ** // and these all follow the normal
mathematical rules. ‘++’’ may be used to join strings of characters together, but ‘&&’ is preferred as it is the
concatenation operator.

Unary minus operator is also allowed. All string constants should be enclosed within double quotation
marks, for example: ““ssttrriinngg”” To use a double quote inside a string, precede the double quote with a
backslash. For example, “string\”value” represents the text ssttrriinngg””vvaalluuee.

FFiieellddNNaammee
The contents of the field ‘FFiieellddNNaammee’ are substituted for the name of the field. It is this mechanism which
is used to print record information onto a card. All field names or expressions using functions must be
enclosed by square brackets [] or they will not be evaluated.

DDaatteeTTiimmee((““ffoorrmmaatt””))
This will insert the date and time the card is printed in the format required. The value of ‘format’ denotes
how the date and time will appear. The value of ‘format’ mmuusstt be included within double quotation marks
for it to work. It can take on any of the following values:

FFoorrmmaatt VVaalluuee RReessuulltt
Long Date Display the date in a long format (month spelled out)
Medium Date Display the date in a medium format (month abbreviated)
Short date Display the date in a short format (month as number)
Long Time Display the time in a long format (includes seconds)
Medium Time Display the time in a medium format (12-hour time with am/pm)
Short Time 24 hour format

In addition the following characters can be combined to form a custom time or date.
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CChhaarraacctteerr RReessuulltt
d day of the month
dd 2 digit day of the month
ddd abbreviated day of week
dddd day of week in full
w day of week as a number (1=Sunday)
ww week of the year
m month as a number
mm 2 digit month
mmm abbreviated month
mmmm month in full
q quarter of year
y day of the year
yy 2 digit year
yyyy 4 digit year
h hour
hh 2 digit hour
n minute
nn 2 digit minute
s second
ss 2 digit second
AM/PM display AM or PM in uppercase
am/pm display am or pm in lowercase
: display ‘:’
/ display ‘/’
<space> display ‘ ’

FFoorrmmaatt((ffiieellddnnaammee,, ““ffoorrmmaatt””))
This is similar to DateTime() except that it takes a database field value and allows a greater range of 
formatting operations. All format values must be included within double quotation marks in order for
them to be used. In addition to all the formats allowed for DateTime(), Format also allows the following
formats:

VVaalluuee RReessuulltt
Currency formats the value to the current Windows currency settings
Fixed display at least one digit to the left and two digits to the right of the decimal 

separator.
Standard display number with thousands separator, at least one digit to the left and 

two digits to the right of the decimal separator.
Percent display number multiplied by 100 with a percent sign (%) appended to the 

right; always display two digits to the right of the decimal separator.
Scientific use standard scientific notation.
Yes/No display No if number is 0; otherwise, display Yes.
True/False display False if number is 0; otherwise, display True.
On/Off display Off if number is 0; otherwise, display On.
0 (zero) display a digit or a zero. If the value has a digit in the position where the 0 

appears in the format string, display it; otherwise, display a zero in that position.
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# display a digit or nothing. If the value has a digit in the position where the # 
appears in the format string, display it; otherwise, display nothing in that 
position.

. decimal placeholder
% the expression is multiplied by 100. The percent character (%) is inserted 

in the position where it appears in the format string.
@ display a character or a space.
& display a character or nothing.
< display all characters in lowercase format.
> display all characters in uppercase format.
! force left to right fill of placeholders 

One useful example is:  FFoorrmmaatt((nnooww(())++336655,, ““yyyyyyyy””)) to print the next year on a card.

LLeeffttSSttrriinngg((ffiieellddnnaammee,,nnuummbbeerr))
This will display the first ‘nnuummbbeerr’ characters in the field ‘ffiieellddnnaammee’.

For example, with the Name field containing the name “FredBloggs”,  
LLeeffttSSttrriinngg((NNaammee,, 44)) will display FFrreedd.

RRiigghhttSSttrriinngg((ffiieellddnnaammee,,nnuummbbeerr))
This will display the last ‘nnuummbbeerr’ characters in the field ‘ffiieellddnnaammee’.

For example, with the Name field containing the name “FredBloggs”,  
RRiigghhttSSttrriinngg((NNaammee,, 66)) will display BBllooggggss.

MMiiddSSttrriinngg((ffiieellddnnaammee,,ppoossiittiioonn,,nnuummbbeerr))
This will display up to ‘nnuummbbeerr’ characters from position ‘ppoossiittiioonn’ in the field ‘ffiieellddnnaammee’.

For example, with the Name field containing the name “FredBloggs”,  
MMiiddSSttrriinngg((NNaammee,, 44,, 55)) will display ddBBlloogg.

The ‘number’ value may be omitted to return the rest of the string. For example:
MMiiddSSttrriinngg((NNaammee,, 44)) will display ddBBllooggggss.

UUppppeerrSSttrriinngg((ffiieellddnnaammee))
This changes the contents of the specified field to be all in uuppppeerrccaassee characters. The upper-cased 
contents are only displayed or printed - the actual field contents are not changed.

LLoowweerrSSttrriinngg((ffiieellddnnaammee))
This changes the contents of the specified field to be all in lloowweerrccaassee characters. The lower-cased 
contents are only displayed or printed - the actual field contents are not changed.
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NNooww(())
This is a function that returns the current date and time when used. 
For example, a text object set to have NNooww(()) as the text will produce similar results to the following 
output when the text object is seen on the card design:

2200//0044//22000022  2222::4455::5599 (Ultimately, this format depends on the PC’s Country locale settings)

Of course, the date and time will be different, but the format will be the same. NNooww(()) may be used with the
FFoorrmmaatt(()) or LLeefftt//RRiigghhtt//MMiiddSSttrriinngg(()) expressions to extract parts of the date or time.

The NNooww(()) field name does not need to be defined in the Sample Data list as it is a built-in function of
CardDesigner.

SSppaacceeOOuutt((ffiieellddnnaammee,,nnuummbbeerr))
This is an unusual function in that it splits the field into a series of strings separated by spaces. The
spacing is set by the value of ‘number’ although each digit of the number is taken as a number itself. 

For example if the field ‘Barcode’ had the value 1234567890 then:
SSppaacceeOOuutt((BBaarrccooddee,,33442211)) would produce 112233 44556677 8899 00

This can be very useful when formatting serial numbers or barcode numbers.
Some more examples of text entries are:

FFoorrmmaatt RReessuulltt
Name: [Name] Name: Smith B.
[Surname],[Name] Bloggs, Fred
Today is [DateTime(“dddd”)] Today is Monday
The time is [DateTime(“h:mm AM/PM)”] The time is 11:23 AM
Hello [Name] today is 
[DateTime(“Medium date”)]. Hello Fred today is 30 May 2002.
[Format([Number],000000) 0001354
[LeftString([Surname],3)] Blo
[MidString([Surname],3,2) og

MMaaxx((aa,,bb,,........))
Returns the maximum value in the argument list.
For example, MMaaxx((11,,55,,88,,1122,,44,,99)) returns the value 1122.

MMiinn((aa,,bb,,........))
Returns the minimum value in the argument list.
For example, MMiinn((11,,55,,88,,1122,,44,,99)) returns the value 11.
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LLeenn((ssttrriinngg))
Returns the number of characters in the ssttrriinngg. 
For example LLeenn((““BBiillll””)) returns the value 44.

TTrriimm((ssttrriinngg))
This removes any spaces from the beginning or end of the ssttrriinngg.

HHeexx((vvaalluuee))
Converts a numeric value to hexadecimal format.
For example, HHeexx((112244)) returns 77CC.

IInntt((vvaalluuee))
Converts the vvaalluuee to an integer value.
For example, IInntt((1122..44)) returns the value 1122.

LLeeffttFFiillll((vvaalluuee,, lleennggtthh,, ssttrriinngg))
This takes a vvaalluuee and pads it out to the lleennggtthh specified using the ssttrriinngg value added to the
left of the value.
For example, LLeeffttFFiillll((1122,,55,,””00””)) returns 0000001122.

RRiigghhttFFiillll((vvaalluuee,, lleennggtthh,, ssttrriinngg))
This takes a vvaalluuee and pads it out to the lleennggtthh specified using the ssttrriinngg value added to the right of the
value.
For example, RRiigghhttFFiillll((1122,,55,,””00””)) returns 1122000000.

ZZeerrooSSppaaccee((ssttrriinngg,,nnuummbbeerr))
Pads the ssttrriinngg with zeros until it is ‘nnuummbbeerr’’ characters long.
For example, ZZeerrooSSppaaccee((1122,,55)) returns the value 0000001122.

FFiirrssttNNaammee((ff))
Returns the first name of a person in a VisitorPass32 database.
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SSuurrNNaammee((ff))
Returns the last name of a person in a VisitorPass32 database.

FFuullllNNaammee((ff))
Returns the first and last names of a person in a VisitorPass32 database.
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AAppppeennddiixx FF –– SSuuppppoorrtteedd BBaarrccooddee ttyyppeess

Here is a list of supported barcodes used within CardDesigner. Many of them are very specific
– descriptions are given where available for the more popular ones.

IIDD BBaarrccooddee NNaammee DDeessccrriippttiioonn iiff aavvaaiillaabbllee
0 EAN13” “Numeric-only 13-digit code used in Europe for retail article numbering. There 

are variants with an extra 2 or 5 digits (EAN13+2 and EAN13+5). ISBN and ISSN 
are EAN13 variants”

1 EAN-8” “EAN-8 is a simpler 8-digit form of the more common EAN13 code”
2 EAN13+2” “Variant of EAN13. Has an extra 2 digits after the main EAN13 code”
3 EAN13+5” “Variant of EAN13. Has an extra 5 digits after the main EAN13 code”
4 UPC-A”
5 UPC-E”
6 ITF-14”
7 ITF-6”
8 Code 39” “Commonly used alphanumeric code. Was the first code to be able to represent 

letters”
9 Code 128”
10 EAN-128”
11 2 of 5” “Fairly uncommonly used numeric only barcode type. I-2 of 5 is much more com

mon.”
12 I-2 of 5” “A commonly used numeric only barcode type. This code encodes digit-pairs to 

produce an efficient code. Encoding as digit pairs implies that it can only produce
even length barcodes”

13 3 of 9”
14 Code B”
15 Code 11”
16 Codabar” “Codabar is a numeric code that allows 6 additional characters ($ : / . + -). This is a

fairly common barcode type”
17 MSI”
18 Ext Code 39”
19 UPCA+2”
20 UPCA+5”
21 EAN8+2”
22 EAN8+5”
23 UPCE+2”
24 UPCE+5”
25 Telepen numeric”
26 Telepen ASCII”
28 PostNet A”
29 PostNet C-5”
30 PostNet C-9”
31 FIM A”
32 FIM B”
33 FIM C”
34 RM4SCC”
35 4-State”
36 Code 93”
37 Ex Code 93”
38 ISBN”
39 Matrix 2/5”
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40 Plessey”
41 Australia Post”
42 Swiss Post”
43 Deutsche Post”
44 DUN-14”
45 Planet Origin”
46 Planet Destination”
47 SISAC”
48 ISSN”
49 ISMN”

189



IInnddeexx

About ImageBase, 172
AAbbssoolluuttee mmeeaassuurreemmeennttss, 104
AAbbssoolluuttee sizing, 104
aacccceessss rriigghhttss, 161
AAlliiggnn tab, 65
AAlliiggnn ttoo bboottttoomm--mmoosstt eeddggee, 66
AAlliiggnn ttoo cceennttrree ooff oobbjjeecctt, 66
AAlliiggnn ttoo hhoorriizzoonnttaall cceennttrree ooff ccaarrdd, 66
AAlliiggnn ttoo hhoorriizzoonnttaall cceennttrree ooff oobbjjeecctt, 66
AAlliiggnn ttoo lleefftt--mmoosstt eeddggee, 66
AAlliiggnn ttoo rriigghhtt--mmoosstt eeddggee, 66
AAlliiggnn ttoo ttoopp--mmoosstt eeddggee, 66
AAlliiggnn ttoo vveerrttiiccaall cceennttrree ooff ccaarrdd, 66
AAlliiggnn ttoo vveerrttiiccaall cceennttrree ooff oobbjjeecctt, 66
Alignment Tools, 66
AAnnggllee tab, 82
Appendix A  - Expressions, 173
Appendix B, 174
Arrange Icons, 159
BBaacckk TTaabb, 98
Barcode tool, 84
Barcode types supported by CardDesigner, 188
BBiittmmaapp PPrrooppeerrttiieess, 88
Bitmap tool, 86
Bitmaps

placeholder, 87
Resize to Fill Card, 87

Bitmaps and resolution, 87
Box tool, 75
bbrriigghhttnneessss, 42
bubbles, 70
Card Print Logs, 130
Cascade, 169
Change Password for <username>, 123
Close Database, 113
Colour Selection, 65

The CMY tab, 65
The Named tab, 65
The Pallette tab, 65
The RGB tab, 65

CCoommpplleettee LLoogg, 130
Configuring cameras and scanners, 44
Context-dependent menus, 111
ccoonnttrraasstt, 42
Copy, 63
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Copying objects, 63
correcting colour tints, 43
CCrreeaattiinngg aanndd ddeelleettiinngg uusseerr aaccccoouunnttss, 161
Current Record Pane, 33
ccuurrrreennttllyy sseelleecctteedd ffiieelldd, 34
cursor styles, 70
Cut, 63
Database Field Types, 177

Card Designation, 177
Card Print Count, 177
Card Print Date, 177
Date/Time, 177
Image, 178
Integer, 178
Last Modified, 178
Memo, 178
Record Creation Date, 179
Report Title, 179
Text, 179
To Print Flag, 179
Unsupported Type, 179
Yes/No, 179

date displaying on card, 182
DateTime, 182
DateTime(), 182
default card printer, 95
Delete, 63
DDeettaaiill tab, 85
Edit > Copy, 102
Edit > Cut, 102
Edit > Delete, 103
Edit > Duplicate, 102
Edit > Layers..., 108
Edit > Paste, 103
Edit > Precise Control, 104
Edit > Redo (action), 103
Edit > Select All, 103
Edit > Serial Number..., 107
Edit > Snap to Grid, 106
Edit > Undo <action>, 103
Edit menu, 100
Editing buttons,  62
Exit, 124
expressions, 182
FFiieelldd CCoonntteennttss, 113
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FieldName, 182
File > (list of most recently used files), 100
File > Choose Printer..., 95
File > Close, 92
File > Exit, 99
File > New Design Window, 91
File > New…, 90
File > Open..., 91
File > Page Setup and Information..., 97
File > Print..., 94
File > Save, 93
File > Save As..., 93
File Menu, 112
FFoonntt tab, 79
Format(), 183
FFrroonntt TTaabb, 97
Gamma Correction, 55
GGeenneerraall TTaabb, 97
GGrriidd, 110
Help menu, 110, 170
Image Batch Import, 113
Image Box, 41

Blank Image, 41
Capture Properties, 41
Copy to Clipboard, 41
Enhance Image, 41
Paste from Clipboard, 41

Image tool, 77
IImmaaggeeBBaassee3322 FFiieelldd, 78
Images

free, 78
portrait, 78
square, 78

Import Data, 113
Importing records, 117
IInnccrreemmeenntt, 107
IInnffoo TTaabb, 99
Layers, 73
LeftString(), RightString(), MidString(), 184
Lock/unlock record list button, 34
LLoocckkeedd llaayyeerrss, 108
Locking an object, 73
Magnetic Encoding Options, 89
Main Record View, 32
Main Toolbar, 59
Menu Structure, 90, 112
Most Recently Used file list, 124
Moving Objects, 70

Moving objects using the keyboard, 71
MMRRVV, 32
New Design, 59
NNeexxtt SSeerriiaall NNuummbbeerr, 107
Non-TWAIN sources, 42
Notes, 68
Now(), 185
Open Database, 112
Open Design File, 60
orientation of barcodes, 85
PPaasssswwoorrdd sseettttiinnggss, 163
Paste, 63
PPaatttteerrnn, 107
Pick Colour, 63
PPoossiittiioonn ttaabb, 104
Precision placement, 103
PPrriinnttaabbllee llaayyeerrss, 108
Program Window, 58
Properties, 72
Properties of Barcode objects, 83
Properties of Box objects, 69
Properties of Image objects, 72
Query Builder, 133

Clauses Tab, 140
Field boxes, 140
Op – ‘<’, 140
Op – ‘<=’, 140
Op – ‘<>’, 140
Op – ‘=’, 140
Op – ‘>’, 140
Op – ‘>=’, 140
Op boxes, 140

QQuuiicckk PPoossiittiioonn CChhaannggeess, 105
QQuuiicckk SSiizzee CChhaannggeess, 105
QuickSearch Tool, 34
Record List Pane, 33
Records With No Image, 132
Redo, 63
Refresh, 68, 109
RReellaattiivvee mmeeaassuurreemmeennttss, 104
RReellaattiivvee sizing, 105
Re-sizing, 71
SSaammppllee DDaattaa, 
Sample Field List, 115
SSaavvee AAss, 61
Save Design File, 61
Select Mode, 69
Select Printer, 121
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Select TWAIN Source, 122
Selecting objects, 69
Set <username> as the Default User, 116
Set Colour, 64
SShhaaddooww tab, 83
SSiizzee ttaabb, 105
Snap To Grid, 68
SpaceOut(), 185
square brackets, 183
SSttyyllee tab, 80
TTeexxtt tab, 79
Text tool, 79
The Design Toolbar, 69
The View menu, 109
time

displaying on card, 1782
Toolbar, 34, 59, 69

Add Record, 34
Add to People Picker, 39
Delete Record, 35
Edit Record, 35
Grab Image, 35
Misc Options, 38
Notes for Database, 38
Print Card, 37
Refresh Record List, 39
Scan Image, 37
Show People Picker, 40

Tools menu, 114
TWAIN Sources, 42
Undo, 63
UpperString(), LowerString(), 185
user accounts, 161
View > Grid, 110
View > Refresh, 110
View > Sample Data..., 110
VViissiibbllee llaayyeerrss, 108
Wildcards, 137
Window menu, 169
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